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Thank you for purchasing Network Video Recorder VK-64 v1.3 (hereafter referred to as
“VK-64”), a network video recording and monitoring system. VK-64 is a network video
recording and monitoring system and consists of the Storage Server and Viewer. Please
read this manual prior to operation to ensure you will be able to use the Viewer and
Storage Server effectively. This manual also explains how to use the Network Video
Recorder VK-16 v1.3 and Viewer-Only use. See P. 18 for the difference between the VK-
64 and VK-16. See P. 153 for the functions not available in the Viewer Only mode.
*VK-16 has the same functionality as VK-64 outlined in this manual, unless explicitly indicated
otherwise.

Request to Customers
(1) Canon owns the copyright of this manual. The unauthorized transfer of all or any part of the

contents of this Manual is forbidden.
(2) The content of this manual is subject to change without notice.
(3) All possible measures have been taken to ensure that the content of this manual is accurate. If

you happen to notice errors, omissions or other faults, please contact your vendor. 
(4) Irrespective of items (2) and (3) above, Canon cannot bear responsibility for any effects that

result from operation.
(5) When description of this manual uses the Control Panel, it conforms to operations with Window

XP Classic style.

Request to Customers (Indemnity)
Software defect may cause an error in recording and damage or loss of recorded data. Canon
cannot bear responsibility for any effects that result from operation. You should agree with it before
using the product.

Introduction

Trademarks
z Canon and the Canon logo are registered trademarks of Canon Inc.
z Microsoft Windows is a trademark of Microsoft Corporation in the United States and other countries.
zWindows is legally recognized as Microsoft Windows Operating System.
z QuickTime is a trademark of Apple Computer Inc.
z Apache is a trademark of the Apache Software Foundation.
z Pentium is a trademark of Intel Corporation.
z All other company or product names used in this manual are trademarks or registered trademarks of

their respective holders.

Copyright Information
Please note that copyright laws prohibit the customer from using recorded videos and still pictures for any
purpose other than personal requirements, without permission from the copyright holder.

Support Information
For various types of information relating to support, including updated product software (patch installer),
User’s Manual, operating environment, etc., please refer to our WebView Product web page:
canon.com/webview

Icons Used in this Manual

Indicates important information that must be observed or actions that
are prohibited during an operation. These notes must be read to prevent
possible faults or errors during operation. These notes must be read to
prevent possible faults or errors during operation.

Note

Indicates supplementary information or a reference to an operation.
Users are advised to read these memos. 

Tip

Storage Server includes software developed by the Apache Software Foundation (www.apache.org). Apache software is protected by the copyright

law (Copyright(c) 2000-2003 Apache Software Foundation). For the license terms associated with this software, please refer to the file

APACHE_LICENSE in the folder LICENSE, within the installation directory.
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This manual is written for the System Administrator deploying the VK-64/VK-16 system. 

It explains the functions of VK-64/VK-16 and introduces more appropriate system
deployment methods. Use this manual as a reference when making a backup of data or
troubleshooting a problem.
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About Documents

VK-64/VK-16 comes with three manuals including this document.

z Setting Manual
Read this manual when setting the Storage Server.

z Viewer Manual
Read this manual when using the VK Viewer functions.

z Administrator’s Manual (this document - pdf file)
This manual is intended for the System Administrator for deploying and operating this

software. 

Be sure to read this manual to ensure proper system deployment.
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Before Starting Operations with VK-64/VK-16 <Important>

It is recommended that you perform tests under actual conditions before starting
operations.

z Recording and display of live videos may not be provided as
configured because many factors (such as network
environment and PC performance) affect the actual
performance of VK-64, VK-16. 

z When the load on your computer CPU and hard disk is high, the
specified frame rate may not be available, or the video
recording may be interrupted or the Viewer operation may take
longer. Also, when available disk space is low, the disk load
may increase and the video recording may be interrupted due
to deletion of the recorded video file.

z Using anti-virus and firewall software may affect Storage Server
and Viewer operations.

z When using a proxy server (→P. 51, P. 73)
If you use a proxy server, recording frame rate may not be
achieved as specified or live video monitoring may be
interrupted. Also, communication between the Storage Server
and Viewer may occasionally be disconnected.

z If you are using Windows XP SP2 or Windows Server 2003, you
need to change Windows settings. Make sure to change the
settings. Refer to “Notes on Operating Environment” (→P. 24).

z When recording to a NAS server, it is recommended to separate
the communication networks for the camera and NAS.

z Audio function of the VB-C300/VB-C50i/VB-C50iR/VB-C50FSi
can also be used.
• The VK Viewer supports audio transmission and reception.
• Audio recording is not available.•
• The audio and video may be out of sync.
• The audio stream may be interrupted according to the

performance of your PC and the network environment.
• The audio feature is not available via a proxy server.
• If you use a PC on which anti-virus software is installed, the

audio stream may be delayed or the audio stream may be
temporarily interrupted.

Note
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This chapter provides preliminary information you should know before using the VK-64/VK-
16 and explains the operating environment and basic concept you need to understand to
design your system.

● Preparation Flow

The following explains the flow from setting up the VK-64/VK-16 to starting the operation.

● System Operation Overview

Explains the system operating environment including the number of Camera Servers
available for the Storage Server, product types, and the number of licenses for each
product. 

● Communication Mechanism of VK-64/VK-16

Explains the communication mechanism of the VK-64/VK-16, using a typical system
configuration.

● Operating Environment

Explains the operating environment of the VK-64/VK-16 and points to notice concerning
the OS environment.

● System Design Concept

Explains the concept and points to notice when designing the system.
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The following explains the flow from setting up the VK-64/VK-16 to starting the operation.

The first step is to set up your Camera Servers. Refer
to your Camera Server manuals for connection details.

Preparation Flow

16

Install the Storage Server and Viewer2
The Storage Server and Viewer can be installed on one PC.
Alternatively, the Viewer can be installed on other computers
on the network that will access recorded video from the Storage
Server.

Configure the Storage Server via the Storage
Server Configuration utility to set server
settings, event notification and configure user
privileges.

VC-C50i

VB150
VB-C50FSi

Camera Servers (➝ P. 22)

VB-C50i
VB-C300

Set up the Camera Servers1
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Monitor live video and play
back recorded events in the
Viewer application. From the
Viewer you can customize the
Viewing Area and save
Layouts.

Configure Recording Settings3

Create and save Viewer Layouts4

Register Camera Servers and Storage
Servers and set up recording schedules.

Recorded video from
Storage Server

Live video from
Camera Servers
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● VK-64/VK-16 is a software to view and record video images distributed from the
VB150/VB101 or a network camera VB-C300/VB-C300/VB-C50FSi/VB-C50Fi/VB-
C10/VB-C10R (hereafter referred to as “camera server”). VK-64/VK-16 supports up
to 64 camera servers via an IP network (e.g., LAN). Although VK-16 has the same
basic functionalities as VK-64, it can support up to 16 camera servers.

● VK-64 is a software program which consists of the Storage Server and Viewer. The
Storage Server can record videos and events (sensor input and motion detection)
data from multiple camera servers. The Viewer can display videos from multiple
camera servers in real time and play back videos recorded on the Storage Server. 

● The Viewer can be used by itself without connecting to the Storage Server (Some
functions such as video recording, sensor events, and motion detection, Capture
Still Frame are not available).

● Video resolution can be as high as 640 x 480 pixels, 30 fps for NTSC and 25 fps for
PAL (depending on Camera Servers installed). 

● The following table shows each product and license number:

Product Name Storage Server Viewer

Network Video Recorder VK-64 v1.3 1 licenses 1 licenses

Network Video Recorder VK-16 v1.3 1 licenses 1 licenses

Network Video Recorder VK-64 v1.3 Viewer - 1 licenses

Network Video Recorder VK-64 v1.3  5 Viewers - 5 licenses

* The Storage Server for VK-16 can register up to 16 camera servers. VK-16 and VK-64 uses the same Viewers.
* Licenses to the VK-64 v1.2/VK-16 v1.2 can be used for v1.3.

Storage Server Viewer

VK-64 Up to 64 cameras can be registered

VK-16
CommonUp to 16 cameras can be registered

Functionality is the same as for VK-64
except for the above camera limitation.
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Communication Mechanism of VK-64/VK-16
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The following explains the communication mechanism of the VK-64/VK-16, using a typical
system configuration.

Typical System Configuration
VK-64/VK-16 provides video viewing and recording from Camera Servers via an IP
network such as a LAN. Since VK-64/VK-16 makes use of IP networks, installations of
cameras can be performed easily. In addition, it is possible to flexibly install new cameras
and change installation locations of cameras.

VC-C50i VC-C50iR VB150/VB101

VB-C300

VB-C50iR

Play
ba

ck

Play
ba

ck

Playback

Monitor

View live and recorded video
Viewer
Operator Capabilities:
z Viewing Live Video  z Viewing Events  z Viewing recorded video

VB-C50FSi/VB-C50Fi

VB-C50i
Liv

e

Liv
e

Live

Live

Monitor
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■ Application Types and Functions

Application Function

Storage Server Stores recorded information for later retrieval.

Viewer
Lets users view recorded information, monitor live video
and acknowledge/search events. Lets Administrators
configure recording and viewing settings.

Playback

Record

Record Monitor

Record video to the Storage Server #1
Storage Server
Administrator Capabilities:
z Configuring Storage Server  z Configuring Event Notification 
z Configuring Users

View live and recorded video
Viewer
Administrator Capabilities:
z Configure recording settings  z Configure event alerts
z Viewing Live Video  z Viewing Events  z Viewing recorded video
z Configuring Camera Servers  z Configuring Storage Server

Record video to the
Storage Server #2
Storage Server

Receives and 
records video.
Play back
recorded video to
Viewers.

Playback
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Supported Camera Servers
The table below lists the Camera Servers that are supported by VK-64/VK-16.

This information is correct as of January 2007. For the latest information, please
refer to our WebView Product web page:canon.com/webview

Firmware Upgrade
The latest information concerning firmware can be found on the following Canon Web site:
canon.com/webview

Camera Server Firmware Versions

VB-C300 Ver. 1.0

VB-C50FSi Ver. 1.0 Rev. 68 or later

VB-C50FSi Ver. 1.0 Rev. 68 or later

Ver. 1.0 Rev. 26 or later

VB150 Ver. 1.1 Rev. 39 or later

VB101 Ver. 3.0 Rev. 69 or later

VB-C50iRVB-C50i

VB-C10RVB-C10

Ver. 1.1 Rev. 33 or later
Ver. 1.2 Rev. 76 or later

z If using a VB101, you can make use of a single camera
connected with VK-64/VK-16 at a time.

z If using a VB150 with multiple cameras, there are restrictions
on frame rate.

z If using the Simultaneous mode with the VB150, upgrade the
firmware to Version 1.1 Rev.39 or later.

Note
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System Environment
This information is correct as of January 2007. For the latest information, please
refer to our WebView Product web page: canon.com/webview

Viewer

Storage Server

Minimum

CPU Pentium 4  2.2GHz or greater

Windows 2000 Server (with SP4)
Windows 2000 Professional (with SP4)

Operating System Windows XP Professional (with SP2)
Windows Server 2003 Standard Edition (with SP1)
Windows Server 2003 R2 Standard Edition

Memory
1GB RAM or greater
For more than 48 Camera Servers, 1.5GB or greater required.

Hard Disk 20GB HDD or greater, SCSI or IDE, NTFS formatted

The requirements for Storage Server will vary according to the environment you will use (number of
Camera Servers, setting of recording frame rate etc.). It is also dependent on pre-event recording
settings. Please contact dealers that handle Canon products for further information. If using Windows
XP Professional SP2 or Windows Server 2003, follow the procedures as described in “Notes on
Operating Environment” (➝ P. 24).

If using Windows XP Professional SP2 or Windows Server 2003, follow the procedures as described
in “Note on Operating Environment” for changing your Windows settings (➝ P. 24).

Minimum

CPU Pentium 4  2.2GHz or greater

Windows 2000 Server (with SP4)
Windows 2000 Professional (with SP4)

Operating System Windows XP Professional (with SP2)
Windows Server 2003 Standard Edition (with SP1)
Windows Server 2003 R2 Standard Edition

Memory 1GB or wider

Hard Disk 2GB or wider

1024 x 768 or higher resolution

Display
Color display of 16 bits or more
A high performance video card is desirable. With PCI video cards, 
display performance may be reduced.

Sound Audio playback support is necessary for event notification alert sounds (➝ P. 160).
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Note on Windows XP SP2
If your Storage Server is not installed on the same PC as your Viewer, you will need to
change your Windows firewall settings for the Storage Server on the PC with Windows
XP SP2.

* The following setting is not required if you are installing the Storage Server and Viewer
on one PC.

After installation of the Storage Server:

1. From the Windows Start menu, launch the Control Panel.

2. In Control Panel, select Windows Firewall. If Windows Firewall is not shown, select
Security Center and then select Windows Firewall.

3. In the Windows Firewall dialog, select the Exception tab and then click Add Port....

4. In the Add a Port dialog, enter a name for the Storage Server, e.g., “VK-64/VK-16
Storage Server”. Enter the Port number as “80”. Make sure the TCP protocol is
selected and click OK.

5. In the Windows Firewall dialog, your Storage Server is now listed. Make sure it is
enabled (checked). Click OK to close the dialog.

Settings are now complete.

If more than ten Camera Servers out of all registered ones cannot be connected to
Storage Servers, recording operations may take longer.
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Note on Windows Server 2003
The default security level of Windows Server 2003 Standard Edition (SP1) and Windows
Server 2003 R2 Standard Edition for the Internet or intranet sites in Internet Explorer is
“High”.

As a result, windows such as the settings window do not function normally unless you first
register the site in the contents block dialog box that appears when you access the
camera’s top page. Register the site to ensure normal functioning.

1. When you access the Camera Server top
page etc. in Internet Explorer, the dialog box
shown at right appears.

2. Click Add. The dialog box for adding Trusted
sites then appears.

3. Check the IP address of your camera server displayed in the Add this Web site to the
zone box and then click Add to register the camera as a trusted site.

For more information on registering trusted sites, click Learn more about Internet
Explorer’s Enhanced Security Configuration... in the dialog box in step 1 and refer
to the summary provided.

Settings are now complete.
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System Configuration

● When Viewing and Recording with one PC

Load on PC may increase depending on the number of camera servers and recording
schedule. Consider your system configuration according to “Server Sizing Concept”
(➝ P. 29).

● When Viewing and Recording with one Storage Server and
Multiple Viewers

VB-C300

Record video to the Storage Server
Storage Server

View live and recorded video
Viewer

Viewer

Storage 
Server

Viewer

Recording Video to
the Storage Server
Storage Server

Viewing Live and Recorded Video
Viewer

Viewing Live and Recorded Video
Viewer

Receiving and
Recording Video

Receiving Video and
Controlling Camera

z Having many Viewers accessing the same Camera Servers
and Storage Servers will affect system performance.

z Installation of both Storage Server and Viewer on a single PC
may cause a heavy load on your PC depending on the number
of camera servers or recording schedule. If you use VK-64/VK-
16 with many Camera Servers, install each application on
separate PCs. Viewing with a low capacity PC may take longer,
the specified frame rate may not be achieved, recording frame
rate may be lower, or recording may be interrupted.

Note
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● When using multiple Storage Servers and Viewers

One or more Storage Servers can be used on a network and Viewer applications can be
configured to play video from more than one Storage Server. For each Viewer, a Master
Storage Server (➝ P. 28) needs to be defined for saving information such as zones and
locations of cameras, as well as saving Viewer layouts created by the user.

Viewer

Storage
Server

Storage
Server

Viewer

Storage 
Server

Record video to the
Storage Server #1
Master Storage
Server

Receiving and 
Recording Video

Receive video and
control camera

Play back 
recorded video

View live and recorded events
Viewer

Record video to the
Storage Server #3
Storage Server

View playback video from Storage Server 1

Plays back 
recorded video

Receive and
Record video

Record video to the 
Storage Server #2
Storage Server

More than one Storage Server can
be added to a network. Viewers can
receive playback video from more
than one Storage Server.

View playback video from
Storage Server #2 and #3

Viewer

z You can operate VK-64/VK-16 with up to ten Storage Servers
using any combination of VK-64 Storage Server and VK-16
Storage Server. Up to 192 Camera Servers can be operated.

z Up to ten Viewers can connect to the Storage Servers at the
same time.

z If the Storage Server and/or Viewer are installed on multiple
PCs, you’ll need to purchase the necessary licenses
separately (➝P. 18).

Note
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When using multiple Storage Servers
If multiple Storage Servers are being used, you should decide which one is the Master
Storage Server. A typical multiple Storage Server arrangement could be.

Viewer

Master Storage Server

Storage Server #2

Storage Server #3

Play Video to Viewer

Play Video to Viewer

Play Video to Viewer

Load Camera Server information
Load Zones and Locations
Load Viewer Layouts

Save Camera Server information
Save Zones and Locations
Save Viewer Layouts

When using Viewer alone
The Viewer can be used by itself without connecting to the Storage Server. Although there
are some restrictions on functions such as recording and Event Search, Viewer-Only mode
allows to view live videos (➝ P. 151).

About the Master Storage Server
A Master Storage Server is the Storage Server which a Viewer will connect to in the first
place. Information about Camera Servers, Locations and Zones and Viewer Layouts are
stored on the Master Storage Server. The Viewer extracts the information from the Master
Storage Server.

z It is recommended that all Viewers within a system use the
same Storage Server as a Master Storage Server. This ensures
that all Viewers use the same Zones, Locations and Viewer
Layouts.

z For correct operation, the time setting of all PCs within a
system (including Storage Servers and Viewers) must be
correct. We recommend that you use NTP function to set the
time for Storage Server automatically.

z Adjusting the time of Storage Server during recording may
cause problems to the recording video.

Note

When multiple Storage Servers are operated, if the Storage
Servers other than the Master Storage Server are stopped, it
takes time to display the Configuration and Preferences screen
(approximately up to 30 seconds).

Note
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Server Sizing Concept
Determine your server configuration (components and the number of units) depending on
1) required hard disk capacity and 2) video data quantity per second.

1) Required hard disk capacity: Consider the required hard disk capacity depending
with regard to continuous recording with fixed frame
rate, resolution, and quantity. For reference, you should
use multiple servers if the required hard disk capacity is
1.5 TB to 2 TB per server.

2) Video data quantity per second: If the video data quantity per second per server
exceeds values shown below, you should use multiple
servers or review the recording conditions.

Approximate Video Data Quantity for 1 Second
The recording performance of the VK-64/VK-16 v1.3 is as follows.

z For dedicated Storage Server: Maximum amount of recorded data per server = 5.5
MB/sec or less

(VGA: 110 fps, QVGA: 360 fps)

z For Storage and Playback Server: Maximum amount of recorded data per server = 3
MB/sec or less

(VGA: 60 fps, QVGA: 200 fps)

Required Hard Disk Capacity
The VK-64/VK-16 receives each image from a Camera Server as a JPEG image. The size
of the images varies depending on the configuration of the Camera Server (the settings for
Quality and Resolution) and the complexity of the actual image.

Every installation of VK-64/VK-16 is different (due to different
usage requirements and different hardware specifications) and
the figures provided in this section are an indication only.Note

The write performance may be lower than mentioned above
depending on the RAID card used.

Note
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● Determining Hard Disk Capacity

Determine the hard disk capacity as follows.

Determine the required number of Camera Servers and video resolution.

Determine the quality of each Camera Server.
Higher quality causes larger data per frame.

Determine the frame rate for recording video (i.e., the number of frames per
second).
For general security purposes, 1 to 2 fps is common. Higher frame rate requires
more hard disk space.

Determine the recording period per day and duration to retain data.

After determining the conditions above, calculate the required hard disk capacity
according to the video data size per screen (in KB). Refer to “Example of Frame
Sizes with VB-C300” and “Example of Frame Sizes with VB-C50i” (➝ P. 31).

Example:

- Recording continuously at 2 fps, 

- Using 16 Camera Servers (VB-C50i) for recording,

- With each camera set to Medium Size for video capture and Quality set to 50, and

- Frame size* per single frame is approximately 15 KB.
Although actual data size depends on objects shot by each Camera Server, this
calculation assumes the typical size shown above.

For the above configuration, if the 16 Camera Servers are being recorded  continuously at
2 frames per second all day, every day, the disk requirements would be approximately
40GB per day (15KB x 2fps x 16 cameras x 60 seconds x 60 minutes x 24 hours =
41472000KB per day).

However, when determining hard disk sizes it is important to take into account that there
needs to be some room (10 to 20%).

* For the above figures please note that the bandwidth is calculated as 1000Kbps =
1Mbps, and the disk size as 1024KB = 1MB.

5

4

3

2

1
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Resolution
Quality

Small (160x120) Medium (320x240) High (640x480) 

30 3.8 11.1 36.4 

40 4.4 13.3 43.4 

50 5.0 15.1 49.2 

70 6.6 20.3 67.0 

80 8.1 25.4 85.5 

90 11.8 37.3 128.0

(values are in KB)

Example of frame sizes with VB-C50i*
This is true for the VB-C50i and VB-C50FSi.

The following tables give some typical frame sizes (in kilobytes) for various quality and
resolution values from a VB-C300 and VB-C50i. However it is important to note that,
depending on the complexity of the image, the frame sizes may vary substantially from
those listed in the tables. For example, images of an empty corridor would typically be
smaller than these values and images of a very intricate pattern such as a crowded
shopping mall would typically be larger than these.

Resolution
Quality

Small (160x120) Medium (320x240) High (640x480)

1 4.0 12.5 36.0

2 4.6 14.8 42.4

3 5.2 16.8 47.5

4 6.8 22.3 62.9

5 18.9 65.5 206.0

(values are in KB)

Example of frame sizes with VB-C300*

* The data size mentioned above is an indication only, which will vary in accordance with
the subject being captured. Please be sure to confirm under the actual installation
conditions before starting operations. Select Video Information from the View menu of
the Viewer (supplied with the Camera Server) to check the data quantity per frame.

Please note that data size may increase enormously when video
quality is set to 100 with the VB-C50i.

Note
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Sensor Event Recording and Motion Detection Recording
Concept

● Notes on Sensor Event Recording and Motion Detection Recording

z When an event such as sensor input or motion detection occurs, it will be stored in the
Storage Server as an operation record.

z As the number of stored operation records increased, the operation and search speed at
event detection may be affected.

● Notes on Motion Detection Recording

z The Motion Detection function detects motion which occurs where no motion is usually
occurring.

Do not use this function where the motion detection operates too frequently, e.g., where
many people pass.

Refer to “Operation Guideline for Sensor Event Recording” (➝ P.
210) and “Optimization of Motion Detection Recording (Index)”
(➝ P. 211) for details.Tip
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Storage Server Performance

<Case 1>
Camera Servers: 24 VB-C50i
Resolution: High (640 x 480)
Quality: 50
Frame Rate: 10 fps

[Recording]
Example of Storage Server PC specifications
CPU: Pentium 4  3GHz
Memory: 1GB
HDD: Please refer to “Disk Space
Management <Important>” (➝ P. 58)
(Sample specifications for 3-day storage:
about 1.1 TB for each Storage Server)

Three Storage Servers with the above PC
specifications
(one master device, two slave devices)

[Live View, Recorded Video Playback]
Example of Viewer PC specifications
CPU: Pentium 4  3.8GHz
Memory: 1GB
Video graphics board: NVIDIA Quadro FX
1400

<Case 2>
Camera Servers: 48 VB-C50i
Resolution: Medium (320 x 240)
Quality: 50
Frame Rate: 1 fps

[Recording]
Example of Storage Server PC specifications
CPU: Pentium 4  3GHz
Memory: 1GB
HDD: Please refer to “Disk Space
Management <Important>” (➝ P. 58)
(Sample specifications for 14-day storage:
about 900 GB)

One Storage Server with the above PC
specifications

[Live View, Recorded Video Playback]
Example of Viewer PC specifications
CPU: Pentium 4  3.0GHz
Memory: 1GB
Video Graphics Board: On-chip board

For the latest information on performance, please refer to our
WebView Product web page: canon.com/webview

z These are samples from a specific configuration. As many
factors can influence the actual performance possible
(including networking equipment, disk write speed, complexity
of camera image, etc), the actual performance of VK-64/VK-16
recording in a specific installation will vary. Please be sure to
confirm under the actual installation conditions before starting
operations.

z If there are many Camera Servers registered, it is
recommended that you use two or more PCs or configure to
use the Layout Sequences feature.

Note
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● Notes on Storage Server Deployment

It is recommended to use the Storage Server exclusively for the VK-64/VK-16.

Be sure to avoid the following forms of deployment.

z Using the Storage Server with a Web Server

You cannot use the Storage Server on a PC where Web server software such as
Windows standard IIS (Internet Information Server) or Apache is already installed.

Since the Storage Server uses the HTTP protocol to communicate with the Camera
Server, it will not operate if other Web applications exist on the same platform.

The HTTP port number used by the VK-64/VK-16 is fixed to “80”.

z Using the Storage Server with a Database Server (e.g., SQL Server, Oracle)

If the hard disk is heavily loaded (e.g., executing a distributed database application
which transfers several-hundred GB of data between databases), recording may be
interrupted. Conversely, the database server may be affected by the VK-64/VK-16 when
it tries to a demanding task.

z Using the Storage Server with a File Server

Accesses to the hard disk may be too frequent and recording may be interrupted. Also,
the disk capacity for the VK-64/VK-16 may run short.

Notes on Viewer Sizing
Consider the following when selecting the PC where the Viewer should be installed.

z Live viewing and recording performance of the VK-64/VK-16 largely depends on the
CPU and graphics board performance of the PC. The CPU performance affects image
capturing and video data generation, while the graphics board performance affects
image drawing.
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Use the following example for reference when selecting the PC where the Viewer should
be installed.

Use the Windows XP Professional SP2 for the operating system.

1) CPU: Pentium4 3.0GHz, memory: 1GB, graphics board: Quadro FX540
When using the VB-C50i with Resolution=340 x 240 and Quality=50:
Total frame rate: Max. 220 fps

2) CPU: Pentium4 3.6GHz, memory: 1GB, graphics board: Quadro FX1400
When using the VB-C50i with Resolution=340 x 240 and Quality=50:
Total frame rate: Max. 260 fps

3) CPU: Pentium4 3.8GHz, memory:  1GB, graphics board: Quadro FX1400
When using the VB-C50i with Resolution=340 x 240 and Quality=50:
Total frame rate: Max. 280 fps

Network Bandwidth Concept
You must consider the network bandwidth when recording video or viewing live video from
the network camera.

The network bandwidths must be calculated separately for recording and live viewing.

Example:
With one recording server (QVGA, 1 fps) and two live viewing servers (QVGA, 5 fps):

z Bandwidth for recording
15 (KB/frame) x 1 (frame/sec) x 8 (bits) = 120 Kbps

z Bandwidth for live viewing (per server)
15 (KB/frame) x 5 (frame/sec) x 8 (bits) = 600 Kbps

Therefore, required network bandwidth is calculated as follows:
120 Kbps x 1 + 600 Kbps x 2 = 1320 Kbps = Approx. 1.3 Mbps

Note that the line speed unit is bps (bits per second).

z The total frame rate is calculated as: Number of Camera
Servers in the Viewer window x Frame rate. That is, with 10
Camera Servers and 10 fps frame rate, the total frame rate is
100 fps.

z Note that the total frame rate varies depending on the
combination of the PC and graphics board. It is also affected
by other applications (e.g., anti-virus application) running on
the same PC.

Tip
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This chapter explains how to install VK-64/VK-16.

When you install VK-64/VK-16, icons for two applications composing VK-64/VK-16 will be
created on the desktop.

Setting up the Camera Servers1

Install the Storage Server and Viewer2

Before beginning installation, read Chapter 1 and “Preparation
and Precautions” (➝ P. 41) carefully.

Note

z Refer to Chapter 3 for how to use the Storage Server.
z Refer to Chapter 4 for how to use the VK Viewer.Tip
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Starting up the Installer

Insert the Network Video Recorder
installation disc into your CD drive. The
Welcome screen appears. Click Next to
continue.

If the installer does not automatically load,
open the CD directory in Explorer and
browse to locate Setup.exe. Double-click
to begin installation.

1

The Software License Agreement screen
appears. Read the agreement carefully.
Click the radio button, I accept the terms
in the license agreement and then click
Next to continue.

2

Enter your License Key(s) and click Next.
Your License Key is indicated on the
“About License Key” included in the
package.

3

2

In
stallatio

n

z Types and number of licenses you can install vary according
to the product you have purchased. If additional Storage
Server and Viewer installations are required, you will need to
purchase the necessary software (➝ P. 18).

z The hard disk where the software will be installed must be
formatted in the NTFS (➝ P. 41).

Note

If you are installing the Storage Server alone, enter the License
Key for the Storage Server only. If you are installing the Viewer
alone, enter the License Key for the Viewer only.Tip
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Installation Procedures

Depending on your License Key, you will be
presented with one or both of the following
applications shown below:

z Viewer

z Storage Server

It is recommended to keep the install to:
path as is. Click Change... to choose
another installation path if necessary.

4

Click Next to continue. See “Tip” below for the Help and Space buttons.

When you click Next, installation will proceed and a progress bar will be displayed.

When the InstallShield Wizard Completed
screen displays, click Finish.

Installation is now finished.

5

z Click Help to obtain details on the type of installation. The type
is indicated by the icon next to the application to be installed.

z Click Space to view the amount of disk space required in order
to install VK-64/VK-16. A list of drives is shown.

In either dialog, click OK to return to the installation steps.

Tip

z In future, if you need to check your product type, refer to the
About box of the Storage Server or Viewer (➝ P. 46).

z If the Storage Server is installed, it will be automatically
started after installation.

Note
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Upgrading from Version 1.0, 1.1, and 1.2
If you upgrade the Viewer from an older version, all the settings are taken over to the new
version and video data recorded with older version can be played back with Version 1.3. It
is important to verify your settings after installation.

For the details, see “Upgrading VK-64/VK-16” (➝ P. 231).

Preparation and Precaution

● Use NTFS-formatted hard disk

The hard disk where the software will be installed and video data will be stored must be
formatted in the NTFS.

You can convert the hard disk into the NTFS format using the following command at the
command prompt.

“convert (Name of the drive):/fs:ntfs”

Example: To convert Drive C into the NTFS format: 

convert c:/fs:ntfs

z The Viewer v1.3 can connect to the Storage Server v1.2.
However, you cannot use the recording functions added in
v1.3 (e.g., preset tour).

z If the Storage Servers v1.2 and v1.3 coexist, either Storage
Server can be specified as the Master Storage Server.

z The Viewer v1.3 cannot connect to the Storage Server v1.0 or
v1.1.

z The Viewer v1.0, v1.1, or v1.2 cannot connect to the Storage
Server v1.3.

z The VB-C300 cannot be registered on an v1.0, v1.1, or v1.2
Storage Server.

z When upgrading from any versions before 1.1.2.27, you need
to set motion detection (➝ P. 119) again. You can check your
version information from the About box (➝ P. 46) of the
Storage Server and the Viewer.

z The VB-C300 cannot be registered on the Storage Server v1.0,
v1.1, or v1.2.

Note

Select All Programs, Accessories, and Command Prompt from
the Start menu to display the command prompt. If you press the
Enter key following the command shown above, a series of
questions appears, then conversion starts. Reboot the PC after
the process completes conversion. You will not lose any data on
the hard disk by conversion.

Tip
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● Stop other applications

You must stop other applications including anti-virus program before starting installation.
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The Storage Server can record videos and events (sensor input and motion detection) data
from multiple camera servers.

This chapter explains how to set the installed Storage Server.

Use the Storage Server Configuration dialog to set the Storage Server.

In the Storage Server Configuration dialog, you can configure settings for disk
management, event management, event notification, and user management.

● Settings Tab

In the Settings tab, specify the Storage Server name, Proxy Server, and recording
options.

● Event Tab

You can set the Storage Server to send an e-mail to the user when an event
has occurred.

In the Event tab, specify the priority for each event type.

● Event Notification Tab

In the Event Notification tab, configure the settings for sending an e-mail
when an event has occurred.

● User Management Tab

In the User Management tab, add users and assign privileges to them.
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Storage Server Configuration Dialog

Start-Up Method

Screen Configuration
The Storage Server Configuration dialog has the following four tabs.

z Settings Tab

z Events Tab

z Event Notification Tab

z User Management Tab

To configure the Storage Server, you must log into Windows with
the Windows Administrator privilege.

Note

Double-click the Storage Server Configuration desktop icon.

Alternatively, from the Windows Start menu select: All Programs >
WebView Livescope > Network Video Recorder VK Series v1.3 >
Storage Server Configuration.

If the Authentication is required when starting this tool is checked
(➝ P. 49), the Login dialog opens. 

Enter your user name and password, and click Login.
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● Settings Tab

The Storage Server Configuration dialog, Settings tab allows you to configure.

z Storage Server Name  z Proxy Server  z Recording options

Enter a name for your Storage Server.

Click the title bar icon and select About Storage
Server Configuration or right-click the title bar to
display the About Storage Server Configuration
box.

Set maximum disk space used for each device.
Also, add or remove network drives.

Enter a proxy address for connecting to Camera
Servers.

Storage Server status indicator. Start Storage
Server and Stop Storage Server start and stop the
Storage Server.

Use an account other than the Local System
account to log onto the Storage Server to enable
connection to the network drive (you cannot use the
network drive on Windows 2000).

Click Apply to save changes when you modify
settings from each tab.

Set Maximum retained history, Maximum file
size/duration and Low Disk Space Warning Level.

The VK-64/VK-16 can save video data on the network drive.
However, you cannot use the network drive on Windows 2000.

Tip
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3

● Events Tab

You can set the Storage Server to send an e-mail to the user when an event has occurred.

The Storage Server Configuration dialog, Events tab allows you to configure:

E-mails are sent according to the priorities set in the Events tab.

Select a suitable event priority from
the drop-down menu for each event
type listed.

z Events associated with “Storage Server started/stopped”,
“User log in”, and “Network drive assignment error” do not
appear in a Viewer’s Timeline (➝ P. 192), Live Events Log (➝
P. 199), or Event Search Dialog (➝ P. 201). 

z The priority of an event created by a manual recording using
Record Now (➝ P. 196) will always be Priority 1. It cannot be
changed from this dialog.

Tip
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● Event Notification Tab

The Storage Server Configuration dialog, Event Notification tab allows you to
configure.

E-mails are sent according to the priorities set in the Events tab.

Example event notification e-mail

An event of priority 3 occurred on 12/05/2006 at 15:15:17 +1000.

Parking Lot 1: Sensor on

Enable e-mail notification and select
a priority. Events of that priority and
above will lead to notification e-
mails.
Enter the e-mail subject line, for
example, “Immediate Action
Required”. Enter the address of the
recipient and enter your from
address.

Enter a Host Name or IP address
and Port Number of mail server for
outgoing mail.

Enable authentication (POP-before-
SMTP) for connection and enter
User Name, Password and POP
Server details.
If this is enabled, the Storage
Server will attempt to perform a
POP login before sending e-mail
that may be required for some
SMTP servers.

You can only register one e-mail address in the To Address field.
If you want to send the e-mail to multiple addresses, use a group
address.Tip
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● User Management Tab

The Storage Server Configuration dialog, User Management tab allows you to set up
users and their privileges.

User Management tab allows you to configure the following privileges:

z Administrator
z Not Administrator (Operator)

Administrators have access to the Viewer including Camera Server setup, recording
schedules and Viewer setup.

Users who have Operator Status cannot configure, register and change Camera Servers,
or configure and change recording schedules.

By default, a user called “admin” is created. The password is “NVR”. It is strongly
recommended that this is changed after installation.

It is necessary to set up users on all Storage Servers. A particular user should be set up to
have the same password on each Storage Server.

Check to enable user to have
Administrator privileges (full access
to configuration functions).

Use Add to add users to this field.
There is no limit to the number of
users you can add.

Click Apply to save changes.

If the Authentication is required
when starting this tool. box is
checked, the Login dialog opens. 
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The Storage Server Configuration dialog, Settings tab allows you to configure.

z Storage Server name
z Proxy Server
z Settings for storing recorded video
z Start and stop of Storage Server
z Logon Account for Storage Server

Displaying Settings Tab
Double-click the Storage Server Configuration desktop icon.

The Storage Server Configuration dialog opens and the Settings tab is displayed.

How to configure the Settings Tab

● Changing the Storage Server name

Enter a new name in Storage Server
Name to change the Storage Server
name (You can use up to 20 characters).

It is recommended to use an easy-to-understand name if you are
using multiple Storage Servers.

Tip
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3

● Enter the Storage Server Proxy Address

If the Storage Server needs to access
Camera Servers outside the LAN, you
may need to configure proxy settings.

* See “When using a proxy server” (➝ P. 11).

In the Storage Server Proxy
f ield, t ick the Enable the
following proxy server box.

Enter the Proxy server address
and Port.

For more information on proxy server usage, see your Camera Server administrator.

2

1

● Enter Recorded Video Settings

Maximum retained history -
Check the Maximum retained
history option and enter a value
from 1 to 999 and then select
Days or Weeks from the drop-
down menu.

Maximum file size/duration - Check the Maximum file size/duration option, enter
a value (e.g., “100” or “24”), and select MB or Hours. You can enter 32 - 1024 for
MB and 1 - 24 for Hours. This will establish the maximum size used for each file of
recorded video. If you do not enter a value, 1024 MB or 24 hours is used for the
Maximum file size/duration value.

Low disk space warning level - Enter a percent value.

When the remaining space falls below the specified value, the event will be
displayed and a notification will be e-mailed (➝ P. 62, 64).

Reduce recording frame rate when disk is under high load - When disk is highly
loaded, recording frame rate is temporarily reduced to prevent the recording from
stopped. Refer to Chapter 6 for details.

4

3

2
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When Reduce recording frame rate when disk is under high load
is checked, you will receive an event notification such as
Effective “Recording rate (<recording rate before change> ➝
<recording rate after change> %)”.
Ex. “Recording rate (100.0 ➝ 90.0 %)”

Tip
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● Select Disk Drive Settings

Drive - Select the disk drive to
configure, from the drop-down
menu.

Maximum disk space used -
Check the box and enter a value
in Megabytes (MB) or Gigabytes
(GB), for example, “50”.

This establishes the maximum
disk space used for all video
files on the specified drive.

Add network Drive - Add a disk drive on the network used as the network drive.
The added network drive is shown on the Drive drop-down menu. 

Delete network Drive - Delete an added network drive.4

3

2

1

When the free disk space has fallen below the value specified in
the Low Disk Space Warning Level field, an event occurs and an
event notification mail is sent. Also, if the used disk space
exceeds the value specified in the Maximum disk space used
field, recorded video will not be saved until the required free disk
space is secured. Refer to P. 58 for the disk space management.

Note

● Adding Removing a Network Drive

By adding a network drive, you can save recorded video data on a network drive such as
NAS (Network Attached Storage) in addition to the internal HDD.

If you add a network drive in the Storage Server Configuration window, the drive will be
added to the list of the pull-down menu of the Add/Edit Camera Server dialog (➝ P. 87,
94).

When using the Storage Server with the local system account,
the Add Network Drive and Delete Network Drive buttons are
disabled.Tip



To add a network drive...

Click Add Network Drive.

The Add Network Drive dialog appears.
Select a drive to add as a network drive
and enter a path assigned to the drive.

You can also enter a path automatically
by selecting a folder.

When selecting a folder with Browse... 

Click Browse..., select a folder where you
want to save recorded video data in the
Browse for Folder dialog. Click OK to enter
the path of the selected folder in the path
field.

Enter the user name and password to access the network drive in the respective
fields, and click OK.

Be sure to use different user name and password from the logon user name and
password for the local system account.

If addition is successful, the added drive appears on the drive selection pull-down
menu.

3

2

1
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Setting the Settings Tab

z About Network Drive
VK-64/VK-16 can record videos on a drive on the network. The
drive type is shown at the head of the Drive drop-down menu
as “Internal disk: local, Network drive: network”.

z About Video Recording
If disk space is not enough to cover the specified value
configured with Maximum disk space used, the retained
duration of recorded video may be shorter than the specified
period or the recording may be temporarily stopped. Please be
sure to perform sufficient tests before starting operations.

z For details about disk space on the Storage Server, refer to
“Disk Space Management” (➝ P. 58).

z Windows does not allow a user who has logged in with a local
system account (used for normal service management) to add
a network drive. The Add network drive and Delete network
drive items are disabled while you are logging into Windows
with a local system account. To set the network drive, click
Stop Storage Server to stop the Storage Server, and click the
Logon Settings and switch to an account which is allowed to
use the network drive (i.e., account with Windows’
Administrator and Logon As Service privileges). Refer to P. 57
for the Logon As Service privilege.

z You cannot use a UNC path or removable disk when adding a
network drive.

z If you add or delete a network drive, the Storage Server
program will reboot.

z Multiple Storage Servers cannot use the same network drive
simultaneously.

z Single network drive cannot allocate to multiple drivers.
z Internal information (thumbnails, location, zone, and recording

schedules) related to a network drive will not be lost even if
the network drive is deleted. Therefore, if you add the same
network drive later, you can restore the status before deletion.

z If the selected network drive cannot be accessed because the
network is disconnected, the selected drive is powered off, or
you entered a wrong path, the following error message will
appear.

“Network path cannot be found.”
z While the network drive is not operating (e.g., due to network

disconnection), video will not be recorded until the drive
recovers.

Note

To remove a network drive...

Select a network drive and click OK to delete
the selected drive from the Storage Server.
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Setting the Settings Tab

● Start or Stop the Storage Server Program

Click Stop Storage Server to stop the
Storage Server.

Click Start Storage Server to start the
Storage Server.

● Change the Logon Settings

If you need to log onto the
Storage Server with another
account when using a network
drive, click Stop Storage Server.
After the Storage Server stops,
click Logon Settings. 
The Log on as dialog appears.

If you are logging onto the
Storage Server with a Local
System account, select Local
System Account. If you are
logging onto the Storage Server
with another account, enter the
account in Account and
password in Password.

Click OK.

Click Start Storage Server to start the Storage Server with the specified account.
4

3

2

1

If you need to stop the Storage Server Program, first inform all
users connected to the storage server.

Note
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Message

● When you have changed items affecting recording settings:

When you click Apply or End, the following message will appear.

“Item affecting recording setting has been changed.
To see how setting is affected, use Recording Setting Summary Display in the Recording
Schedules window of the Viewer.”

● When you have changed the Maximum retained history setting:

When you click Apply or End, the following message will appear.

“Changing the maximum retained history may delete recorded video. Are you sure to
continue?”

● When you have added or deleted a network drive:

When you click Apply or End, the following message will appear.

“Drive configuration has been changed and Storage Server must be restarted. Are you
sure to restart Storage Server?”
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Logon As Service Privilege
When you want to add the Logon As Service privilege to an existing Windows account so
that you may be able to configure network drive settings, perform the following steps
before configuring the logon settings.

Select Control Panel, Performance and Maintenance, Administration Tool, and
Local Security Policy from the Windows’ Start menu.
The Local Security Settings dialog appears.

Select Local Policy and User Privilege
Assignment from the tree to the left.

Double-click Logon as Service from
the list to the right.
The Logon as Service Properties
dialog opens.

Click Add User or Group.
The Select User or Group dialog
opens.

Enter the Windows account in the
Enter object name to select field.
Enter or change the object name,
location, and details as required.

Click OK.
The Logon as Service Properties
dialog reappears.

Click OK.
The Local Security Settings dialog reappears.

Close the Local Security Settings dialog.
8

7

6

5

4

3
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Setting the Settings Tab
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Disk Space Management <Important>

Disk Space Management Level
The Storage Server monitors the remaining disk space and takes a measure according to
the current level.

1) Low Disk Space Warning Level

2) Threshold Level

3) Limit Level

Administrator can set the Low disk space warning level 1) using the Low Disk Space
Warning Level field in the Settings tab.

The Storage Server calculates the values for Threshold Level 2) and Limit Level 3)
according to various conditions and settings.

Counteraction at Each Level
The Storage Server performs the following when the disk space reaches each level.

● In case of Low Disk Space Warning Level

The Storage Server generates an event when the disk space available for recording (i.e.,
free space from the Maximum disk space used value) has fallen down to a certain level.

If the Maximum disk space used field is blank, the entire drive capacity of the drive
specified in the Drive field is considered to be the maximum disk space used.

[Maximum disk  
space used]

Warning Level

Event Notification
<Drive>
Low disk : warning

This allows early intervention by an administrator to avoid
problems due to running out of disk space (for example,
removing unnecessary recording schedules).Tip

The event notification e-mail is transmitted when the priority
specified for the Low Disk Space Warning Level option in the Event
tab of the Storage Server Configuration dialog is equal to or higher
than the priority specified in the Event Notification tab. Refer to P.
62 and P. 64 for how to set the Events and Event Notification tabs.

Note
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Disk Space Management <Important>

● In case of Threshold Level calculation level

The Storage Server continues recording video; however, it starts deleting the video files
from the oldest ones, and generates an event.

● In case of Limit Level

The Storage Server stops recording video when the free disk space goes down to this
level, and generates an event.

When the free disk space increases above this level by deleting old video files, the Storage
Server resume recording video and generates an event.

Threshold Level

Delete from 
the oldest file Event Notification

Low disc <Drive>
deletion : start

[Maximum disk  
space used]

Limit Level

Stop Recording
[Maximum disk  
space used]

Delete from  
the oldest file Event Notification

Low disc <Drive>
rec. : stop

âfëúÉtÉ@ÉCÉãÇÕÅAÅuï€ë∂ä˙ä‘Åvì‡ÇÃÉtÉ@ÉCÉãÇ≈Ç†Ç¡ÇƒÇ‡çÌè
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Tip

Old video files may be deleted even if these are within the
“Maximum retained history” value.
However if the oldest file is currently used in the Viewer (for
example for playback of recorded video), it would not be deleted
and the next oldest file will be deleted instead. Deletion will
continue until the free space rises above this threshold again.
Refer to Chapter 7 for saving files.

Tip
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Disk Space Management <Important>

Low Disk Space Warning Level Calculation Method
The Low Disk Space Warning Level occurs when the Storage Server satisfies the condition
1) or 2) below.

1) When the Storage Server disk space used exceeds the following value:

M x (100 - A)/100

M: Value for Maximum disk space used

A: Value for Low disk space warning level

Example: When the value for Maximum disk space used is 100 GB and the value for
Low disk space warning level is 10%, the Storage Server reaches the Low disk
space warning level when the remaining free disk space becomes 10 GB or less.

2) When free disk space falls below the following value:

Disk capacity x A/100

A: Value for Low disk space warning level

Example: When the value for disk capacity is 80 GB and the value for Low disk space
warning level is 10%, the Storage Server reaches the Low Disk Space Warning Level
when the remaining free disk space becomes 8 GB or less.

Threshold Level Calculation Method
The Low Disk Space Warning Level occurs when the Storage Server satisfies the condition
1) or 2) below.

1) When the Storage Server disk space used exceeds the following value:

a.  Maximum disk space used is 384 MB or more, 

Maximum disk space used - 96MB

b.  Maximum disk space used is 384 MB or less, 

Maximum disk space used x 3/4

2) When free disk space falls below the following value:

(Number of Camera Servers + 1) x 32MB + 96MB

If other applications are also using the same hard disk, you need
to review the condition 2). Even if the Storage Server uses a
small quantity of disk space, it may reach the Low Disk Space
Warning Level because other applications has consumed disk
space.

Tip
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Disk Space Management <Important>

Limit Level Calculation Method
The Limit Level occurs when the Storage Server satisfies the condition  1) or 2) below.

1) When the Storage Server disk space used exceeds the following value:

Maximum disk space used

2) A When free disk space falls below the following value:

(Number of Camera Servers + 1) x 32MB

Calculation Example for Each Level

The following is a table of values for each level calculated based on the above examples.

Disk Drive Disk Capacity Free Disk Space Max. Disk Space Used Camera Server No.

C Drive 100GB 50GB 40GB 19 units

D Drive 200GB 200GB 200GB 19 units

Disk Drive Low Disk Warning Level Threshold Level Limit Level

C Drive
1) 40GB x (100-10) / 100=36GB
2) 100GB x 10 / 100=10GB

1) 40GB-96MB=39.904GB
2) (19+1) x 32MB+96MB=736MB

1) 40GB
2) (19+1) x 32MB=640MB

D Drive
1) 200GB x (100-10) / 100=180GB
2) 200GB x 10 / 100=20GB

1) 200GB-96MB=199.904GB
2) (19+1) x 32MB+96MB=736MB

1) 200GB
2) (19+1) x 32MB=640MB

z “Threshold Level” can be used as a protective level so that the
“Limit Level” is not achieved.  It is recommended that you take
measures when “Low Disk Space Warning Level” event
notification is generated, such as deleting unnecessary video
files.

z Storing video data above the Threshold Level increases load
over the Storage Server and may cause recording interruption.
It is strongly recommended to use the Storage Server below
the Threshold Level.

z Refer to “Operation Guideline for Recording and Viewing” (➝
P. 208) for details of operation.

z For each of the levels, the system can be configured to
provide e-mail notifications when one of these levels is
reached (➝ P. 64). 

z The requirements of “Threshold Level” may be achieved
before the requirements of “Low Disk Space Warning Level”
are satisfied, depending on circumstances. For example, large
numbers of cameras with limited disk capacity may bring a
larger value for “(Numbers of camera +1) x 32 MB + 96 MB”,
compared with the value of “Disk capacity x Low disk space
warning level/100”.

Note
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Setting the Events Tab

The Storage Server Configuration dialog, Events tab allows you to specify event
priorities.

If you have configured the event notification e-mail settings, e-mails are sent according to
the priorities set in the Events tab.

How to Display the Events Tab
Double-click the Storage Server Configuration desktop icon.

The Storage Server Configuration dialog opens and the Settings tab is displayed.

Click the Events tab to open it.
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Setting the Events Tab

How to Set the Events Tab

● Set the Event Priority

Select the priority for the event from the Priority drop-down menu.

Åú
ÉJÉXÉ^ÉÄÉgÉäÉKÅ[ÇÕÅAäOïîÉvÉçÉOÉâÉÄÇ©ÇÁèäíËÇÃñΩófl
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Tip

Item Setting
Recording engine started 1. Highest, 2. High, 3. Medium, 4. Low, 5. Lowest

Remote trigger 1. Highest, 2. High, 3. Medium, 4. Low, 5. Lowest

Recording 1. Highest, 2. High, 3. Medium, 4. Low, 5. Lowest

Data file set 1. Highest, 2. High, 3. Medium, 4. Low, 5. Lowest

User log in 1. Highest, 2. High, 3. Medium, 4. Low, 5. Lowest

Low disk space warning 1. Highest, 2. High, 3. Medium, 4. Low, 5. Lowest

Low disk space deletion 1. Highest, 2. High, 3. Medium, 4. Low, 5. Lowest

Low disk space rec. suspended 1. Highest, 2. High, 3. Medium, 4. Low, 5. Lowest

Camera Server Connection error 1. Highest, 2. High, 3. Medium, 4. Low, 5. Lowest

Change recording frame rate 1. Highest, 2. High, 3. Medium, 4. Low, 5. Lowest

Filed to map a network drive 1. Highest, 2. High, 3. Medium, 4. Low, 5. Lowest

Values shown in bold are the defaults.

z Remote Trigger function starts recording by passing a certain
command from an external program to the VK-64/VK-16. Ask
our sales person for the details.

z If the priority is not specified for manual recording and custom
recording using the Remote Trigger function, the priority
specified here will be used.

Tip

z Events associated with “Recording”, “User log in”, and “Filed
to map a network drive” do not appear in a Viewer’s Timeline
(➝ P. 192), Live Events Log (➝ P. 199),  or Event Search Dialog
(➝ P. 201).

z To detect such a event, set the e-mail notification using the
Event Notification tab (➝ P. 64).

Note
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Setting the Event Notification Tab

The Storage Server Configuration dialog, Event Notification tab allows you to
configure.

Configure the e-mail notification settings according to the priorities set in the Events tab.

How to Display the Event Notification Tab
Double-click the Storage Server Configuration desktop icon.

The Storage Server Configuration dialog opens and the Settings tab is displayed.

Click the Event Notification tab to open it.

How to Set the Event Notification Tab

● Set the Event Notification Priority

Check the Send E-mail when event occurs option and select the priority level
for sending e-mails from the Priority drop-down menu. Events of that priority and
above will lead to notification e-mails.

Enter a subject in the E-mail subject
l ine (e.g., “Immediate Action
Required”), recipient’s address in the
To Address: l ine, and sender’s
address in the From Address: line.

2

1
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Setting the Event Notification Tab

Enter the host name or IP address
of the SMTP server in SMTP Server
and port number in Port.

If you wan to use “POP-before-
SMTP” for user authentication,
check the Use POP-before-SMTP
option, and enter the user name
used for authentication in User
Name and password in Password.
Also, enter the host name or IP
address of the POP server in POP
Server and port number in Port.

4

3

Example event notification e-mail

An event of priority 3 occurred on 12/05/2006 at 15:15:17 +1000.

Parking Lot 1: Sensor on

You can enter each of the subject, recipient’s address, and
sender’s address in up to 100 characters.

Note

Enter the host name in up to 255 characters.
Note

z Enter the user name in up to 100 characters.
z Enter the password in up to 20 characters.
z Enter the host name in up to 255 characters.

Note

You can only register one e-mail address in the To Address field.
If you want to send the e-mail to multiple addresses, use a group
address.Tip

If this is enabled, the Storage Server will attempt to perform a
POP login before sending e-mail that may be required for some
SMTP servers.Tip
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Setting the User Management Tab

The Storage Server Configuration dialog, User Management tab allows you to set up
users and their privileges.

How to Display the User Management Tab
Double-click the Storage Server Configuration desktop icon.

The Storage Server Configuration dialog opens and the Settings tab is displayed.

Click the User Management tab to open it.

Administrator and Operator Status User
Administrators have access to the Viewer including Camera Server setup, recording
schedules and Viewer setup. 

Operator Status Users can only access the Viewer windows (➝ P. 162) created by
Administrator. Also, they only have access to live video and recorded video on Storage
Servers they have permission to access.

z Users who have Operator Status cannot configure, register
and change Camera Servers, or configure and change
recording schedules.

z By default, a user called “admin” is created. The password is
“NVR”. It is strongly recommended to change the user name
and password after installation.

z It is necessary to set up users on all Storage Servers. A
particular user should be set up to have the same password
on each Storage Server.

Note
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Setting the User Management Tab

How to Set the User Management Tab

● Add a User

Click Add on the User Management tab.
The Add User dialog appears.

Enter the user’s User Name (up to 20 characters, including alphanumeric letters
and underscore “_”).

Enter the user’s User Name (up to 20 characters, including alphanumeric letters
and underscore “_”). The Confirm Password field will become active. Re-enter
the new password.

Click OK.
The dialog closes and the new user is displayed in the User List.

Changing User to Administrator

Check the Administrator option of a user in the User List to enable the user to
have the Administrator privileges. Do not check the option if you do not want to
enable the user to have the Administrator privileges.

Click Apply to save changes.

● Change User Password

Click to select a user to change the password in the User List.

Click Edit below the user list to bring up the Edit User dialog.

Enter the user’s User Name (up to 20 characters, including alphanumeric letters
and underscore “_”). The Confirm Password field will become active. Re-enter
the new password.

Click OK.

The new password is saved.
4

3

2

1

2

1

4

3

2

1

The VK-64/VK-16 Administrator status is independent of the
Windows Administrator status.

Note
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Setting the User Management Tab

Delete a User

Click to select a user to delete in the User List.

Click Remove.
The user is deleted.

Request User Authentication at Tool Startup

Check the Authentication is required
when starting this tool i f  user
authentication is required when launching
the tool. If this option is checked, the
Login dialog appears before the Storage
Server Configuration dialog opens.

2

1
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This chapter explains how to store Camera Servers necessary for creating recording
schedules on the Storage Server, as well as the procedure to create recoding schedules.

To store the Camera Servers and create recording schedules, launch the VK Viewer and
use the Camera Summary window and Recording Schedules window under the
Configuration and Preferences screen.



Launching the VK Viewer and Displaying the Configuration and Preferences Screen
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localhost
Connects to Storage Server
and starts the Viewer. Select
this option to use the local
PC where Viewer is installed
as the Master Storage
Server.

Launching Procedure

The connect option menu (Start-up Screen) for Storage Server is displayed.
Select Master Storage Server option and click Connect.

Start-up Screen

Use IP address
Connects to Storage Server
and starts the Viewer by
specifying its IP address.
Select this option when the
Storage Server and the
Viewer are installed on
separate PCs.

Not use Storage Server
Select this option to use the
Viewer only without connecting
to a Storage Server.

If you want to add a Storage Server to the connect option menu,
login the desired Storage Server by specifying its IP address and
click Add Storage Server in the Viewer Settings window (➝ P.
157).

Note

z If multiple Storage Servers are being used, you should decide
which one is the Master Storage Server.

z If the Storage Servers v1.2 and v1.3 coexist, either Storage
Server can be specified as the Master Storage Server.

z The Viewer v1.0, v1.1, or v1.2 cannot connect to the Storage
Server v1.3.

z If you want to connect to the Storage Server directly without
displaying Start-up Screen, uncheck When starting Master
Storage Server is selected in the Viewer Settings window 
(➝ P. 157).

Tip

Double-click the VK Viewer desktop icon.

Alternatively, from the Windows Start menu select: All Programs >

WebView Livescope > Network Video Recorder VK Series v1.3 > 

VK Viewer.
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Launching by Connecting to the Localhost
If you want to use the local PC where Viewer is installed as the Master Storage Server,
select localhost to start the Viewer.

Select localhost from the
drop-down menu.

Click Connect.

Enter your User Name and
Password, and click Login.3

2

1

z The default user name and password are as follows:
User name: admin
Password: NVR

It is strongly recommended to change the user name and
password after installation.

z The Viewer can be launched directly without displaying Start-
up Screen and Login dialog (➝ P. 157).

Tip
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Specify the IP address of Storage Server to connect Viewer
If you installed the Viewer and Storage Server on separate PC, specify an IP address of
Storage Server and connect Viewer to the Storage Server.

Select Use IP address from
the drop-down menu.

Click Connect.

Enter the IP address or host
name of the Master Storage
Server in Host Name or IP,
and the port number in Port.

Click Connect.

Enter your User Name and
Password, and click Login.5

4

3

2

1

The dialog for entering the IP address will also be shown even
when connection to the Storage Server failed.

Tip

z If you need to use a proxy server, you need to change the
Internet option settings in the following procedure:
1. Select Start  > Control Panel > Internet Option.
2. Select the Connection tab.
3. Click LAN settings ….

Change the proxy server settings.
z If using a proxy server between a Viewer and a Storage Server,

it should be one which does not perform response buffering.
Proxies which are configured to perform response buffering
may lead to delays in sending small amounts of data (such as
events) from the Storage Server to the Viewer. You cannot use
the Apache proxy server since it perform response buffering.

z You cannot transmit or receive audio when using a proxy
server.

Note



Launching the VK Viewer and Displaying the Configuration and Preferences Screen

74

When the Viewer accesses a Master Storage Server which has not been set up with
camera information, the entire Viewing Screen is initially blank as shown below. You will
need to configure the Viewer using the Configuration and Preferences screen.

It is strongly recommended that only one Administrator perform
configuration on each network.

Note
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Accessing the Configuration and Preferences screen
To open the Configuration and Preferences screen.

● In the Menu Bar, select View ➝ Configuration

The menu bar is located at the top left of the
Viewing Screen.

In the Menu Bar, select View ➝ Configuration.

The Configuration and Preferences screen
appears.
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Storage and Camera Server Summary windows

Use the Storage and Camera Server Summary screen to create a location and zone,
add the Storage Server, and add the Camera Server.

Displaying the Storage and Camera Server Summary Windows
Launch the VK Viewer and display the Configuration and Preferences screen.

Click the Camera Summary tab.
The Storage and Camera Server Summary
windows appear.

The window consists of two sub-windows which
are opened by their respective tabs, Storage
Servers and Locations/Zones.

2

1

When the
Storage Servers
tab is selected

When the Locations / Zones tab is selected

Click and drag scrollbar(s) to view any portions of the
Summary Area that are not visible.

Tree area Summary Area
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Storage and Camera Server Summary windows

Click and drag divider line to the right to
reveal full values.

Storage Servers and Locations/Zones options
The following options are available via the Storage Servers tab.

Add Storage Server - Allows you to register a
Storage Server with the system (up to ten
Servers are recommended).

Edit - Allows you to change the address of the
selected Storage Server.

Select a Storage Server from the tree in the left panel. The right panel will update with a list
of Camera Servers recorded by the Storage Server you selected.

The following options are available via the Locations/Zones tab.

Add Location - Allows you to add a new location
to the system.

Add Zone - Allows you to add zones to
locations.

When you select a zone within a location in the left panel, a list of cameras in that zone is
displayed in the right panel.

Other Functions in Both Tabs

Camera server functions are located on the right-hand panel regardless of which tab is
selected.

z Find Camera Servers - Allows you to initiate a network search for unlisted Camera
Servers on the LAN.

z Add Camera Server - Allows you to add a Camera Server to the system.
z Edit Camera Server - Allows you to edit an existing Camera Server’s settings.
z Remove Camera Server - Allows you to remove a Camera Server from the system.

If you are using the Viewer only, the Camera Server,
Location/Zone, and Camera Type are only shown in the Camera
Server List.Note
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Location and Zone

Create a location and zone before registering the Camera Server. 

Cameras are grouped into Locations and Zones. Locations are for example, an office
building, shop or school. Zones are a part of Locations, that is, a zone could be assigned
to each floor in the office building and specific areas in a shop such as a cash register
area.

The diagram below illustrates an example of physical Locations and Zones on a VK-
64/VK-16 network. Viewer access is via the Location and Zone drop-down menus.

Zones are different areas of the one
Location.

Location #2

Zone 4 Zone 5

Zone 6

Location #3

Zone 7

Zone 8

Location #1 (Shopping Mall)

Zone 1

Zone 3

Once configured, Locations and Zones are
selected from the Viewing Screen Camera
Selection area. When you select other
locations, their Zones become accessible.

Zone 2



79

4

R
eg

isterin
g

C
am

era
S

erver
an

d
S

ettin
g

R
eco

rd
in

g
S

ch
ed

u
le

Location and Zone

When a Location is selected from the drop-down menu at left, all of the Zones associated with the
Location will appear to the right as camera thumbnail images.

This tab containing four thumbnail images indicates that there are four cameras in the Zone.

This tab containing six thumbnail images indicates that there are six
cameras in the Zone.

z The Location/Zone hierarchy is independent of the grouping of
cameras into Storage Servers. For example, a single Storage
Server may record video from multiple Locations, and
cameras from a single Location can be recorded to multiple
Storage Servers.

z When more than one Storage Servers are used and a Storage
Server which already has registered Camera Servers is
changed to the Master Storage Server, thumbnails of
registered Camera Servers may not be displayed. In this case,
update the thumbnails by clicking Connect on the Edit Camera
Server dialog for each Camera Server on the Master Storage
Server.

Note
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Location and Zone

● Step 1: Click Add Location on the Locations/Zones tab

In the Camera Summary window,
select the Locations/Zones tab if it is
not already selected.

Click Add Location to bring up the Add
Location dialog.

Enter the name of the new
location (up to 20 characters),
then click OK.

3

2

1

Adding a Location or Zone

● Step 2: Click Add Location on the Locations/Zones tab

In the Camera Summary window,
select the Locations/Zones tab if it is
not already selected.

Click Add Zone to bring up the Add
Zone dialog.

Enter the name of the new
zone (up to 20 characters).

Select a location from the
drop-down menu in the
Location field, then click
OK.

The selected zone will now
appear in the specif ied
Location folder.

4

3

2

1

z If you want to add a Zone to another location not listed, you
must first create the Location before you add the Zone.

z Each Location name must be unique and each Zone name
within a Location must be unique.

z There is no fixed limit on the number of Zones and Locations
that can be added.

Note
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Location and Zone

Editing a Location or Zone

Double-click a location or zone.
The Edit Location or Edit Zone dialog opens.

Enter connection settings and click OK.
2

1

Deleting a Location or Zone

Click a location or zone in the list to highlight it and select Delete from the Edit
menu.
Alternatively, click a location or zone to select it, then press the Delete key on your
keyboard.

A confirmation dialog will appear. Click Yes.
Click No to cancel deletion.2

1



Displaying the Storage and Camera Server Summary Windows
Launch the VK Viewer and display the Storage and Camera Server Summary window.

Adding the Storage Server

In the Storage and Camera Server
Summary, select the Storage Servers
tab.

Click Add Storage Server to bring up
the Add Storage Server dialog.

Enter connection settings
and click OK.3

2

1

Adding the Storage Server

82

If you are using multiple Storage Servers, add each Storage Server as directed below. You
need not perform these steps if you are using only one Storage Server and that Storage
Server has already been added. 

By adding the Storage Server, you can select the Camera Servers managed by the
Storage Server from the Viewer screen.

You can operate VK-64 with up to ten Storage Servers using any
Up to 192 Camera Servers can be operated.

Tip

If you are using the Viewer only, the Storage Servers tab is not
shown and you cannot add the Storage Server.

Note
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Adding the Storage Server

Editing the Storage Server
In the Storage and Camera Server Summary, select the Storage Servers tab.

A list of Storage Servers already added are displayed.

Double-click the Storage Server in
the list.

Alternatively, select the Storage
Server and click Edit.

This will bring up the Edit Storage
Server dialog.

Enter connection settings and click
OK.3

2

1

To save changes, click
Save Changes at the
bottom right-hand corner
of the Camera Summary
window.

Click Discard Changes
to cancel any changes
you have made.

4

z Do not add the same Storage Server more than once.
z If you add a Storage Server with a different configuration

(such as one managed by another Master Storage Server),
your original Locations and Zones will be lost.

z If you are using Windows XP SP2 or Windows Server 2003,
you need to change Windows settings. Refer to “Notes on
Operating Environment” (➝ P. 24).

z Do not change the port number.

Note

z This function lets you change the network address used to
access a particular Storage Server in case the IP address has
changed.

z The Master Storage Server cannot be edited.

Note
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Adding the Storage Server

Deleting the Storage Server
In the Storage and Camera Server Summary, select the Storage Servers tab.

A list of Storage Servers already added is displayed.

Click a Storage Server in the list to highlight it and select Delete from the Edit menu.

Alternatively, click a Storage Server to select it, then press the Delete key on your
keyboard.

A confirmation dialog will appear. Click Yes.

Click No to cancel deletion.

To save changes, click
Save Changes at the
bottom right-hand corner
of the Camera Summary
window.

Click Discard Changes to
cancel any changes you
have made.

4

3

2

1

z If a Storage Server is deleted, all Location, Zone, thumbnail
and Layout information for cameras associated with this
Storage Server will be lost.

z The Master Storage Server cannot be edited.

Note
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Registering Camera Server

After preparing for Camera Server registration (i.e., creating a location and zone, and
adding the Storage Server), you can register the Camera Server. 

You must register the desired Camera Server on the Storage Server if it has not been
registered.

Storing the Camera Server (by Search)
After registering the Camera Server, you can select the Camera Server from the Viewer
screen.

● Displaying the Storage and Camera Server Summary Windows

Launch the VK Viewer and display the Storage and Camera Server Summary window.

● Finding the Camera Server

In the Camera Summary window, click
Find Camera Servers which is located
above the right-hand panel.

z Up to 192 Camera Servers can be operated.
z To connect to the Camera Server managed by another Storage

Server, you must first add that Storage Server (➝ P. 82).
Tip
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Registering Camera Server

The Search Results dialog opens and a list of detected Camera Servers will appear.

z When you initiate the Find Camera Servers function, your
computer searches the Viewer’s local subnet for all Camera
Servers connected to it. Camera Servers on another subnet
cannot be searched and must be added using Add Camera
Servers (➝P. 87).

z The camera names listed are those specified by the Camera
Server. Refer to the Camera Server’s User’s Manual for more
information on setting the name (“Camera Name” for VB-C50i/
VB-C50iR, VB-C50FSi, VB-C50Fi, VB-C10/VB-C10R, “Device
Name” for VB150 and VB101, and “VB-C300NA” or “VB-
C300PA” for VB-C300).

Note

z If you cannot find the Camera Server, click Add Camera Server
to add it.

z For the Camera Servers which are already registered,
“Registered” is displayed in the “Register” column. The
“Register” columns for unregistered Camera Servers are
blank.

Tip
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Registering Camera Server

● Adding the Camera Server

In the Search Results
dialog, click a Camera Server
in the search results list to
select it.

Click Add Camera Server....

The Add Camera Server
dialog appears.

Alternatively, double-click an
item to bring up the Add
Camera Server dialog.

Continue settings on the Add
Camera Server dialog.

2

1

Recording schedules must be set in order to record video.
Clicking OK does not immediately start recording video.

Note

The Add Camera Server dialog’s appearance will depend on the
type of Camera Server connected.

Tip
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Registering Camera Server

● Connecting to Camera

Enter the Host Name or IP address
in Host Name or IP, then enter the
port number for the Camera Server
in Port.
The Host Name or IP must be 255
characters or less (each label,
separated by a period, must be 63
characters or less), the IP address
must be 15 characters or less
(each label, separated by a period,
must be 3 characters or less), and
the Port must be a figure within
the range from 1 to 65535.

Enter the user name and password to connect to the Camera Server. Enter the user
name in User Name and password in Password.

The settings are then saved to the Storage Server.

Click Connect.

Once the Viewer has connected with the Camera Server, a tab is shown next to the
Add Camera Server dialog.

3

2

1

Use the user name and password configured on the Camera
Server. If the user name and password are not sure, ask for the
System Administrator of the Camera Server.Note

z You must click Connect before clicking OK to close the dialog
(the OK button is disabled until you do so).

z When two or more cameras are used with VB150 (when “Video
Input” is set to “Single”), two through four tabs are added. The
number of tabs shown for a VB150 does not indicate the
physical number of cameras connected, but indicates the
number of cameras which have been enabled using the VB150
Camera and Video Settings Page. Please refer to Chapter 3, P. 36
of the VB150 User’s Manual for more details.

z For VB101 (or VB150 when “Video Input” is set to “Single”),
the camera name displayed as the Camera Server Name is the
first camera name in the server’s camera name list. Therefore,
it is recommended that the Administrator should set the first
camera name to be a general name, applicable to the entire
Camera Server.

z If you are using a VB101 or VB150 with the “Settings Web
page URL” other than the default setting “admin”, a
connection error occurs when you click Connect. Restore the
default setting and try again.

Note
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Registering Camera Server

● Selecting the Storage Server

Select a Storage Server from the
drop-down menu which lists pre-
configured Storage Servers and
enter the Host Name or IP
address in Host Name or IP and
Port number in Port.

The Host Name or IP must be
255 characters or less (each label,
separated by a period, must be 63
characters or less) and the Port
number must be a figure within the
range from 1 to 65535.

If you do not want the Camera Server to record video, select Do not record from
the drop-down menu of Storage Server.2

1

● Configure External Device Input

To switch On or Off the external device
input, check the Invert the state of the
following external option.

One or more inputs may show depending on
the type of the Camera Server. It is not
necessary to change this setting if it is not
required.

If you have a Multi-Terminal Module VB-EX50 unit plugged into a
VB-C50i/VB-C50iR, VB-C50FSi, VB-C50Fi and have configured the
“Use External Video Input”, video seen in the Viewer may be
taken from cameras connected to the Multi-Terminal Module.
Switch the video at the Admin Viewer as required.

Tip

z Recording schedules must be set in order to record video.
z There is a maximum number of 64 Camera Servers that can be

registered on one Storage Server with VK-64 (or 16 cameras
with Network Video Recorder VK-16).

z If you are using the Viewer only, the Storage Server cannot be
configured.

z If you have changed the Camera Server’s IP address, you also
need to change the host names in the Connection Settings
and Storage Server Settings dialogs.

Note
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Registering Camera Server

● Assign a location and zone

If multiple Cam tabs are shown to the
right of the screen, select a tab for
the Camera Server to edit settings.

Change the name of the Camera
Server in the Camera Name field as
required.

In the Location field, select a location for the Camera Server from the drop-down
menu.

In the Zone field, select a zone for the Camera Server from the drop-down menu.

If necessary, click Add... to add another Location or Zone.

The Add Location or Add Zone
dialog opens.

Enter the Location Name or Zone
Name and click OK.

When you add a Zone in the Add
Zone dialog, you must also add it
to a Location in the same dialog.

Select a location from the drop-
down menu.

Refer to P. 80 for how to add locations and zones.

4

3

2

1

z Enter the Camera Name in up to 15 characters.
z Changing the Camera Name setting here does not change the

camera name of the Camera Server.
Note
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Registering Camera Server

● Update or Set the Viewer Thumbnails

In the Preview area, click Update to
capture an image used for the
thumbnail of the Viewer screen. 

To change the camera angle or zoom
magnification using the mouse, click
Start Control.

Move the mouse cursor around the image. Arrows
will appear and you can click and drag the cursor in
that direction. The preview will change accordingly.
When you move the mouse cursor to the center of
the image, a zoom in or zoom out control will
appear.

Hold down the mouse on “+” to zoom in.

Hold down the mouse on “-” to zoom out.

Choose a pre-defined camera position (if already configured) from the Preset
Angle drop-down menu.3

2

1

If you want to change the thumbnail and the preview area is blank
(and the Update and Start Control buttons are disabled), click
Connect (located in the Connection Settings field).Tip

z For a VB-C50FSi and VB-C50Fi, only zoom is available.
z If a fixed camera or an external camera such as VC-C50i is

connected to VB-C50i, you cannot use pan, tilt, and zoom
operations.

Note

z Presets need to be configured in advance. Please refer to the
Camera Server User’s Manual for details on making camera
presets.

z If predefined presets are not shown in the Preset Angle drop-
down menu even if they have been defined on the Camera
Server, click Camera Control to display the Camera Control
Panel, obtain camera control, then configure the settings
again.

Tip
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Registering Camera Server

● Select the drive to save video data.

In the Drive menu, select a hard disk drive
on the Storage Server.

● Closing the Add Camera Server Dialog

Click OK to close the Add Camera Server dialog. 

If you invoked the Add Camera Server dialog from the Search Results screen, you will
return to the Search Results screen. 

Click Cancel to return to the Camera Summary window.

If you clicked Add Camera Server to invoke the Add Camera Server dialog, you will
return to the Camera Summary window.

z Network drives registered via Storage Server Configuration
are also shown on the Drive drop-down menu. Refer to
“Selecting Disk Drive Settings” (➝ P. 52) for the details.

z If you are using the Viewer only, the drive cannot be configured.

Note
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Registering Camera Server

● Save Settings

To save Camera Server settings, click Save Changes at the bottom right-hand corner of
the Camera Summary window.

Click Discard Changes to cancel any changes you have made.

● Returning to the Viewer Screen

If you wish to return to the Viewer Screen, select Viewer Screen from the View menu bar.

The bottom right-hand corner of
the Camera Summary window
consists of two buttons, Save
Changes and Discard
Changes.
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Registering Camera Server

Click Edit Camera Server.

The Edit Camera Server
dialog appears. This dialog
is identical to the Add
Camera Server dialog (you
can also double-click an
entry to bring up the dialog).

● Change the Camera Server’s Settings

Change the Camera Server settings as directed in P. 88 through P. 93. 

2

Editing the Camera Server
The right-hand portion of the Camera Summary window features Edit Camera Server
for Editing the Camera Server(s) on your system, regardless of which tab you have
selected (Storage Servers or Locations/Zones). The same dialog as Add Camera
Server (➝ P. 87) opens.

● Start Editing Camera Server

In the Camera Server list,
cl ick a Camera Server to
highlight it.

1
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Registering Camera Server

● Finish Editing

Click OK when finished.

The Camera Summary window reappears.

● Save Edit Contents

To save edited Camera Server settings, click Save Changes at the bottom right-hand
corner of the Camera Summary window.

Click Discard Changes to cancel any modifications you have made.
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Registering Camera Server

Deleting the Camera Server
The right-hand portion of the Camera Summary window features Remove Camera
Server for removing the Camera Server(s) from your system, regardless of which tab you
have selected (Storage Servers or Locations/Zones).

● Deleting the Camera Server

In the Camera Server list,
cl ick a Camera Server to
highlight it.

1

Click Remove Camera
Server (you can also press
the Delete key on your
keyboard).

A confirmation dialog will
appear. Click Yes.

Click No to cancel deletion.

3

2

If a Camera Server is deleted, all the settings for VK-64/VK-16
associated with this Camera Server will be lost.

Note
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Registering Camera Server

● Reflect Deletion

To reflect Camera Server deletion, click Save Changes at the bottom right-hand corner of
the Camera Summary window.

Click Discard Changes to cancel any modifications you have made.



After you have registered the Camera Server, you can set the recording schedules.

You can start recording using a recording schedule by specifying “when” and “what” to
record.

“When” - Select from the following:

z Specified day of the week (Normal Schedule)

z Specific day (Special Day Schedule)

“What” - Select one or more from the following:

z Record video throughout the specified period of time (Continuous recording)

z Record video by Motion Detection during the specified time period (Motion Detection
recording)

z Record video by sensor during the specified time period (Sensor Event recording)

The Motion Detection recording starts recording video when a motion has been detected.
Refer to “Setting Motion Detection Recording” (➝ P. 118) for details.

The Sensor Event recording starts recording video when a sensor input has occurred.
Refer to “Setting Sensor Event Recording” (➝ P. 125) for details.

98

Overview of Setting Recording Schedules

If you are using the Viewer only, you cannot set recording
schedules.

Note

z Use a Normal Schedule for normal recording operation.
z Refer to P. 103 for how to use the Normal Schedule dialog.

Example of Normal Schedule: Record video from 7:00 A.M.
through 8:30 A.M. on every
Wednesday and Friday.

z Refer to P. 133 for how to use the Special Day Schedule
dialog. 
Example of Special Day Schedule: Record video during the winter

holidays from December 28
through January 3.

Tip

One recording schedule can have Continuous, Motion Detection,
and Sensor Event recording settings. You can record a Camera
Server continuously at 1 frame per second and, for example, set
recording to increase to 5 frames per second when motion
occurs.

Tip
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Recording Schedule

Two types of recording schedules are available: Normal Schedule and Special Day
Schedule. 

For both types of schedules, you must set the recording schedule for each Camera Server
in the Recording Schedules screen.

● Display the Recording Schedules screen

Launch the VK Viewer and in the Menu Bar, select View ➝ Configuration. 

The Configuration and Preferences screen appears.

Click the Recording Schedules tab to display the Recording Schedules screen.

Click the Normal Schedule tab to display the Normal Schedules screen.
3

2

1
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Recording Schedule

Zone representing camera
areas in the LocationZone Camera schedule time bars

Day of the week

Location

Click and drag the

vertical scroll-bar

downward to view

any other zones.

Click and drag the

horizontal scroll-bar

to the right to view

other schedule days.
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Recording Schedule

Click the Special Day Schedule tab to display the Special Day Schedule screen.
4
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Recording Schedule

Storage Server selector Single day schedule area (24 hours)

Zone representing camera

areas in the LocationLocation

Schedule Type selector    

Day selector  
Click and drag the 

scroll-bar(s) to view more

schedules if necessary.

z The scheduling area functions the same as the Normal
Recording Schedule but only covers a single day (from 00:00
hrs. to 24:00 hrs). To have a special day schedule run over a
long weekend (Fri, Sat & Sun), all dates of three days must be
added to the list of days to use the schedule.

z When Special Day Schedules are running, Normal Schedules
are disabled. If an invalid schedule exists, the following
warning message will be displayed. “There is a camera with
no recording schedule. Are you sure to save the settings?”

Note
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Configuring a Normal Schedule

The Normal Schedule consists of:

z Storage Server list - Select the Storage Server to edit the recording schedule.

When the Recording Schedules window is first opened, the first Storage Server in the
list is shown with its associated schedule to the right.

z Schedule Area - Used to set up standard day-to-day recording settings of the system.

Storage Server selector Schedule Area
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Configuring a Normal Schedule

Creating a Normal Schedule

● Display the Recording Schedule screen

In the Menu Bar, select View ➝ Configuration.

The Configuration and Preferences screen appears.

Click the Recording Schedules tab to display the Recording Schedules screen.

Click the Normal Schedule tab to display the Normal Schedule screen.

● Changing the Storage Server

If you wish to display another Storage
Server’s schedule, click the Storage Server
menu, otherwise proceed to the next step.

The menu may list more assigned Storage Servers. If you select another Storage Server,
the Schedule Area will refresh and associated schedule zones will be shown.

● Creating a Normal Schedule

Click and drag a time period for a camera
name and release the mouse button. The
Add Schedule Item Camera dialog is
displayed.

3

2

1

Alternatively, right-click anywhere in the
Schedule Area alongside a camera name
and click Add Schedule... from the context
menu.
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Configuring a Normal Schedule

You can also click and drag an area covering several
cameras to bring up the Add Schedule Item - multiple
cameras dialog. This allows you to easily set schedules for
multiple cameras. Once created, settings for each camera
can be customized.

z The shortest recording time for a schedule is 15 minutes.
z You cannot create overlapping schedule items within a single

Camera Sever.
Note

Configuration is discussed on the following pages.

Set start and end times and the day of the
week (➝ P. 106).

Set frame rate, enable Motion Detection
and sensor event recording (➝ P. 107).

Move the mouse cursor in the Preview
area to change the camera angle 
(➝ P. 91).

Set the preset camera angle and backlight
compensation (➝ P. 108).

Set the external device output
(➝ P. 111).
* The number of external devices

available for setting depends on the
type of the Camera Server.

Set the Night Mode, Resolution and
Options (➝ P. 109).

The Top page of the Camera Server is
displayed after Internet Explorer launches.

Control the camera via the Camera
Control Panel (➝ P. 185).
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Configuring a Normal Schedule

● Set the recording period

Click the hours or minutes fields to
select, then click the up/down
arrows or directly enter a value to
change time.

● Select a day of the week to record video

In the Repeat on area, check the
days you wish to repeat the
recording period you set in the
Times area above.

z If you have defined any special day schedules, such as public
holidays, such schedules will override normal schedule times
for the whole day.

z Times are given in 24 hours, for example 18:00 is 6:00 pm.
z If a Camera Server has been configured with Restrict Service

Time, VK-64/VK-16 will not be able to record from the Camera
Server during restricted times.

z The time zone used for the recording schedule will be the time
of PC where the Storage Server is running.

z The Storage Server will adjust for Daylight Savings if
configured in the operating system.

Note

z An example time period could be for overnight recording such
as ‘Start 22:00 to End 08:00’.

z Click All Day if you want 24 hour recording. The Start and End
times will be set at 00:00 respectively.

Tip
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Configuring a Normal Schedule

● Configuring Motion Detection Recording Settings

Click the On motion
detection box if you want
recording activated when
motion is detected during this
time period.

Click the On sensor event box if you want recording activated from a sensor during
this time period.

Click Settings... to change the details.

Refer to P. 118 and P. 125 for details of Motion Detection and Sensor Event
recordings.

3

2

1

● Set Continuous Recording

Click the Continuously at
Max. box if you want to set
continuous recording for the
duration of the time period.

Select a frame rate for recorded video from the drop-down menu, or input a value
from the keyboard.

You can set the frame rate from 0.1 frames per second to 30 frames per second.
The default is 5 seconds.

Refer to P. 117 for details of Continuous Recording.

2

1
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● Set the Preset Camera Angle and Backlight Compensation

In the Preview field a live preview is
given of the selected camera view
when connected.

Select a Preset camera position from
the drop-down menu of available
camera angles, to retain a live preview
from that angle.

Alternatively, move your mouse pointer in the Preview area to display controls and
clicking to pan, tilt and zoom (➝ P. 91).

Check Preset Tour to move among multiple preset positions sequentially (VB-
C300, VB-C50i/VB-C50iR, VB-C50FSi, VB-C50Fi only). Click Settings ... to specify
the order to switch among presets.

Refer to P. 132 for how to set the Preset Tour.

Select On or Off from the Backlight drop-down menu (You can set the backlight
compensation to High, Medium, Low or Off for VB-C300, VB-C50i/VB-C50iR, VB-
C50FSi and VB-C50Fi).

Selecting Not Specified accepts whatever backlighting the Camera Server offers.

3

2

1

z Preview area. Camera angle can be changed by moving your
mouse pointer in the Preview area to display controls. Click
the controls to pan, tilt and zoom (➝ P. 91).

z After the camera has been controlled, the preset will be set to
Custom. The value this is set to will be the value used for
recording and the position set will be the position recorded. If
you set a preset position using the digital zoom of the VB-
C300, the viewing angle may be misaligned.

z If you select Not Specified the Storage Server does not
attempt to change the setting, rather it accepts whatever
resolution/mode the Camera Server offers. If the camera angle
is changed from the Viewer, the changed setting is used for
recording.

z In the following cases the Storage Server records whatever
the Camera Server currently displays;
- Multiple number of cameras are connected to VB150 with the

Video Input set to Single.
- VB-C50i/VB-C50iR, VB-C50FSi, VB-C50Fi with an external

camera connected and have configured the “Use External
Video Input”.

Note
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Configuring a Normal Schedule

● Set the Night Mode and Resolution (VB-C300, VB-C50i/VB-C50iR,
VB-C50FSi, VB-C50Fi and VB150)

Select the Night Mode from the
drop-down menu. You can select
from Not Specified, Disabled,
Enable, and Auto.

1

z During initializing the camera head position of VB-C50i/VB-
C50iR, the camera head moves to face front, and then moves
back to the current position. Please note that video will be
recorded during this time.

z The On Motion Detection, Backlight compensation, and
additional options are not available, if you use the Preset Tour
function.

z If you change the Backlight Compensation setting and use the
Camera Control Panel to do the pan, tilt, or zoom operation,
the value in the Preset drop-down menu will changed to
Record Current Position.

z Preset used for the Preset Tour are created on the Camera
Server. Please refer to the Camera Server User’s Manual for
details on making camera presets.

z Although the VB-C300 does not allow Preset Tour on the
Camera Server, the Preset Tour is available via this setting.

z If you are using a preset on the Camera Server, the Camera
Server’s preset takes precedence and the current position is
changed to the preset position.

z If Continuous is set, the pre-event recording is not available.
z If Exposure is set, the Backlight compensation option is set to

Not Specified.

Note

z If you select Enabled, the Night Mode status will be changed
to Disabled after the configured recording schedule finishes.

z A higher resolution results in larger disk usage. Make sure
you have enough disk space.

z If you set Night Mode to “Auto”, please make sure that
Exposure mode is set to “Auto” on the Camera Control Panel.

z You can select from Not Specified, Disable, Enable, and Auto
(for VB-C300 only) for VB-C300, VB-C50i series, and VB150.

z Video turns to monochrome in the Night Mode.
z If you specify Auto, you cannot control the Night Mode using

the Camera Control Panel.
z You cannot use the built-in infrared lamp if you are using the

optional dome housing.

Note
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● Set Additional Options

To use the exposure, white balance,
and/or focus settings on the
Camera Control Panel, check the
corresponding check box.

Select a resolution for recording from the drop-down list. You can select from Low,
Medium, High or Not specified.

If you select Not specified, the Storage Server does not attempt to change the
setting, rather it accepts whatever Night Mode setting and resolution the Camera
Server offers.

2

Correspondence between the specified resolution and actual
resolution is shown below.

Tip

Small Size

Medium Size

Large Size 

160 x 120 (NTSC)
192 x 144 (PAL_ VB-C50i series)

320 x 240 (NTSC)
192 x 144 (PAL_ VB-C50i series)

640 x 240 (NTSC_ VB101/VB150)
640 x 480 (NTSC_VB-C10/VB-C50i series/VB-C300)
768 x 576 (PAL_ VB-C50i series)

z The additonal option is only allows to use with VB-C300. Other
models cannot use these options.

z If the Exposure box is checked, the Backlight compensation
option will be disabled.

z If the Preset Tour is enabled, you cannot use additional
options.

z The additional option settings will be return to the original
settings if the Camera Server settings are changed during
schedule execution.

Note

z In the Night Mode, the IR cut filter is disabled and the camera
acts as an IR camera. After the schedule expires, the Night
Mode will be disabled.

z Day Mode activates the Camera Server’s IR cut filter to reflect
the infrared ray and pass the visible rays.

Tip
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Configuring a Normal Schedule

● Set External Device Output

Click External Outputs Setting
to control any external devices
that may be connected to your
Camera Server.

Click Setup... to change the details of external outputs. If you do not change the
settings, the defaults will be used.

If Setup... is clicked, click the drop-
down menu for the target external
device and set External Outputs to On
or Not specified on the External
Outputs Setting dialog.

3

2

1

● Finish Setting

Click OK to save the new settings and close the dialog.

Click Cancel to discard the new settings.

When you click OK, the Preset and Backlight settings are effective on Video Windows in
the Viewer. Control the camera as required by clicking Camera Control.

For the VB-C300, only one external device can be configured on
the External Outputs Settings dialog.

Note
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Configuring a Normal Schedule

● Save Schedules

To save the Normal Schedule, click Save Schedule at the bottom right-hand corner
of the Normal Schedule window.

Click Discard Changes to cancel any modifications you have made.

If you wish to return to the Viewer, select Viewer Screen from the View menu bar.
2

1

Camera Servers have certain features to allow image capture
operations based on sensor input or schedule. If settings are
enabled on the Camera Server, they take precedence over any
settings made in VK-64/VK-16. This may cause some confusion if
your VK-64/VK-16 recording schedules fail to record with the
correct camera preset. You should disable such Camera Server
features if you wish VK-64/VK-16 settings to take precedence.

Note



Changing the Camera Server Settings
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The Top page of the Camera Server is displayed after Internet Explorer launches (VB-C50i).

Click Setting Page to display the Settings Page to change the Camera Server settings. 
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Changing the Camera Server Settings

Items related to recording schedule setting are as follows. Refer to the Camera Server
manual for details.

● User Name and Password

z Set the user name and password for the Camera Server. You cannot set them with the
VK-64/VK-16.

● Motion detection recording

z If the Camera Server is the VB-C50i/VB-C50iR, VB-C50FSi, VB-C50Fi, or VB150, you
can configure the Motion Detection settings on the Camera Server. 

z To configure the Motion Detection settings on the VB-C50i/VB-C50iR, VB-C50FSi, VB-
C50Fi, or VB150, you must install the VB Administration Tools supplied with the Camera
Server in advance. You can set up to four Motion Detection areas. Be sure to set a
recording schedule to execute the specified Motion Detection recording using the
Schedule Setting Tool.

z For a VB150 (“Video Input” must be set to “Single”), the Motion Detection settings are
configured using the normal VK-64/VK-16 Motion Detection Settings dialog (➝ P. 119).

z If the Motion Detection settings are configured on the Storage Server, the load on the
CPU may go high depending on the detection settings and the number of Camera
Servers, and affect the recording. We recommend that you configure the Motion
Detection setting at the Camera Server.

● Quality

z You can set the video quality. The Motion Detection settings are affected by the video
quality setting of the Camera Server. After configuring the Motion Detection settings, do
not change the video quality on the Camera Server.

● Camera Name 

z Set the name of the camera displayed in the Camera Server list. You cannot set them
with the VK-64/VK-16.
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Changing the Camera Server Settings

● Preset

z Presets must be set on the Camera Server in advance. You cannot set them with the
VK-64/VK-16.

z If the recording settings using a preset are used on the Camera Server, the preset
position will override camera positions set by VK-64/VK-16, including those in recording
schedules and Camera Server position. If VK-64/VK-16 has camera control, this will be
lost when the Camera Server is setting a new preset position.

z If predefined presets are not shown in the Preset drop-down menu even if they have
been defined on the Camera Server, click Camera Control to display the Camera
Control Panel, obtain camera control, then configure the settings again.

● Restrict Service Time

z If a Camera Server has been configured with Restrict Service Time, VK-64/VK-16 will
not be able to record from the Camera Server during restricted times.

● External Device

z Specify the name of the external device, such as sensor name. You cannot set it with
the VK-64/VK-16.

z If the external device is not set on the Camera Server, the VK-64/VK-16 cannot set it.

● Sensor Input, Recording to Camera Memory 

z Camera Servers have certain features to capture image into its memory based on
sensor input or schedule.  If settings are enabled on the Camera Server, they take
precedence over any settings made in VK-64/VK-16. This may cause some confusion if
your VK-64/VK-16 recording schedules fail to record with the correct camera preset. You
should disable such Camera Server features if you wish VK-64/VK-16 settings to take
precedence.
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Batch-Setting Schedules

You can set multiple schedules at once.

● Create Multiple Camera Schedules

You can also click and drag an area covering several cameras to bring up the Add
Schedule Item - multiple cameras dialog. This allows you to easily set recording
schedules for multiple cameras. Once created, settings for each camera can be
customized.

Example : Drag over the Schedule area covering three Camera Servers to set the same
schedule for the three Camera Servers.

● Change or Move Multiple Camera Server Schedules

While holding down the Ctrl key, click on individual schedule items to select them, and
drag the mouse to change or move multiple recording schedules.



117

4

R
eg

isterin
g

C
am

era
S

erver
an

d
S

ettin
g

R
eco

rd
in

g
S

ch
ed

u
le

Setting Continuous Recording

You can set Continuous recording with the frame rate of 0.1 frames per second to 30
frames per second when creating a Normal Schedule or Special Day Schedule.

Specify the number of still images to record every second. 

Higher fps value generates smooth video, however, the load on the Storage Server or
network goes higher. Video data quantity also increases to consume hard disk space. 

To configure the Camera Server for recording:

● Set Recording Mode

Click the Continuously at
Max. box if you want to set
continuous recording for the
duration of the time period.

Select a frame rate for recorded video from the drop-down menu, or input a value
from the keyboard.

You can set the frame rate from 0.1 frames per second to 30 frames per second.
The default is 5 seconds.

2

1

z When the load on Storage Server CPU and hard disk is high,
recording at the specified frame rate may not be available, or
the video recording may be interrupted.

z Higher frame rates for result in larger disk usage. Make sure
you have enough disk space.

z The frame rate specified is the frame rate that the Storage
Server will attempt to record, and may not be the actual frame
rate used for recording video. Factors such as the number of
Viewers, load on the Camera Server and the Storage Server,
and network traffic may reduce the actual frame rate recorded.
Also, the maximum frame rate for a VB-C10 configured with a
resolution of 640 x 480 is 10 frames per second, and for a
VB150 with 4 cameras is 2-3 frames per second.

Note
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Setting Motion Detection Recording

Configuring Motion Detection Recording Settings
The Motion Detection recording starts recording video when a motion has been detected. 

Configure the Motion Detection recording settings in the Motion Detection Settings
window which appears when you click Settings. 

Some items in the Motion Detection Settings window overlap with the items in the
Add/Edit Schedule Item dialog. In Motion Detection recording, the settings in the Motion
Detection Settings window take precedence. Preset and Backlight settings in the
Add/Edit Schedule dialog are applied to the Motion Detection recording.

z The Motion Detection settings are affected by the video quality
setting of the Camera Server. After configuring the Motion
Detection settings, do not change the video quality on the
Camera Server.

z Motion detection is done by the Storage Server or Camera
Server (whichever selected in the Motion Detection Settings
window). If the Camera Server executes motion detection,
motion detection is not available while the Camera Server is
performing the pan, tilt, or zoom operation (motion detection
by the Storage Server is available during these operations).

z If the recording schedule expires during Motion Detection
recording, the Motion Detection recording also terminates.

Note

Editing Motion Detection Recording Settings
You can specify the detection area and the amount of sensitivity for Motion Detection
Recording. The area for detection can also be modified which is ideal, for example, if the
field of view has two entrances and you wish to monitor motion for one entrance.
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Setting Motion Detection Recording

● Step 1: Next to On Motion Detection, click Settings...

The Motion Detection Settings
dialog opens (The dialog for VB-
C300 is shown below).

Click and drag a
control point to
re-size the active
region.

Set a priority for events
triggered by motion.

Select sensitivity
options.

Select frame rate and pre/post event duration for
recording triggered by motion.

Motion detection
level indicator
will increase
during activity.

Click to activate Motion Detection on the Camera Server
for VB-C50i/VB-C50iR, VB-C50FSi and VB-C50Fi.

Activate external
device output.

z If the Sensor Event recording is also enabled and motion
detection and sensor input occur simultaneously, the Sensor
Event recording takes precedence. Refer to “Priorities of
Motion Detection and Sensor Event Recording” (➝P. 131) for
details.

z You cannot use the Preset Tour and the Motion Detection
recording together.

z Certain Camera Servers have certain features to allow image
capture operations based on sensor input or schedule. If
settings are enabled on the Camera Server, they take
precedence over any settings made in VK-64/VK-16, and your
VK-64/VK-16 recording schedules fail to record with the
correct camera preset. You should disable such Camera
Server features when using VK-64/VK-16 to record images.

Note



120

Setting Motion Detection Recording

● Step 2: Set the active region for recording

In the Active Region field, adjust the region
where motion detection is triggered. By default,
the Active Region is the full area. You cannot use
pan, tilt, and zoom operations in this window.

Click one of the corner or edge handles and
hold down the mouse button.

Drag the handle to change the motion-
trigger boundary (dotted frame); click the
corners to adjust the area or click the edge
handles to bring each side in or out
respectively.

● Step 3: Set Motion Detection Options

Set the following options on the Motion Detection Settings dialog.

In the Detect Motion Using menu, select
one of the following: 

Storage Server
Obtains video from the Camera Server and
detects motion with the Storage Server.

Camera Server
Uses the Motion Detection function of the
Camera Server to detect motion (This
menu is only active for VB150 servers with
the Video Input set to Single or VB-
C50i/VB-C50iR, VB-C50FSi, VB-C50Fi).

In the Analysis Frame Rate menu, select from 0.1 to 30 frames per second.

If you select the Camera Sever to detect motion, Settings… becomes available.
Settings... is now enabled. Click to launch your VB Admin Motion Detection Setting Tool.
You must have VB Admin Tools installed in advance. Refer to the Camera Server’s User’s
Manual for how to configure the motion detection settings.

2

1

2

1

z To use the Motion Detection function of the VB-C50i/VB-C50iR,
VB-C50FSi and VB-C50Fi, it is necessary to configure
schedules from the “VB Admin Schedule Setting Tool”.

z Setting motion detection at the Storage Server causes high
CPU load. It is strongly recommended to set motion detection
at the Camera Server whenever it has the motion detection
function.

Note
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Setting Motion Detection Recording

The Motion Detection Options field also allows you to set the sensitivity for Motion
Detection within the Active Region.

Motion detection status is shown by the Detection Indicator during operation.

Detection Indicator Colors
Motion is displayed in the Detection Indicator as a green color bar and will remain green if the
level of motion is below the set Sensitivity and within a defined Area Ratio. If motion reaches
the set Sensitivity and Area Ratio, the color bar changes to yellow and if the detected motion
remains at the yellow level for the defined duration, a red color bar is displayed and an event is
triggered. The behavior of the Detection Indicator is described as follows.

z Green color bar - The area of change that is less than the
specified Area Ratio, i.e., activity remains at the left of the Area
Ratio marker.

z Yellow color bar - The area of change that is equal to or greater
than the specified Area Ratio (activity peaks on or to the right of
the Area Ratio Marker) but the required amount of motion has
not met the specified duration in order to trigger an event.

z Red color bar - The amount of change that meets the defined
detection conditions and motion is detected, triggering an event,
i.e., the required amount of motion has been detected for the
specified duration.

Area Ratio marker.

Area Ratio marker.

Area Ratio marker.

Area Ratio slide bar.

Area Ratio marker.
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Setting Motion Detection Recording

● Set the Sensitivity

Sensitivity is the degree of change detected as motion.

Select Low-Med or Med-High. The
available sensitivity settings range
from 1 to 256.

You can specify 1 through 128 as
Sensitivity by clicking Low-Med and
129 through 256 by clicking Med-High.

Drag the slide bar to adjust Sensitivity to the desired value (depending on the
range setting).

● Set the Area Ratio

Area Ratio is the degree of change of area (ratio against the defined detection area)
detected as motion.

Click and drag the Area Ratio slide bar to
any posit ion from 0% to 100%. This
establishes the proportion of image inside the
Active Region (dotted frame) allowed before
motion is detected.

When you drag the slide bar, the black vertical line in the Detection
Indicator will move to reflect the change in specified Area Ratio.

2

1

Area Ratio marker.

The Motion Detection settings are affected by the video quality
setting of the Camera Server. After configuring the Motion
Detection settings, do not change the video quality on the
Camera Server.

Note
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Setting Motion Detection Recording

● Step 5: Set frame rate and pre and post event recording duration

Max. Frame Rate - select a maximum
frame rate for recorded video from the
drop-down menu. Choose from 0.1
frames per second to 30 frames per
second (5 is the default).

Record for before event - enter a number of seconds for the amount of recording
time before the event occurs (up to 30 seconds).2

1

Record for after event - enter a number of seconds for the amount of recording
time after the event occurs (up to 999 seconds).3

z If Continuous is also set, Record for before event is not
available.

z If Record for before event is set to one second or longer, it will
take approximately 10 seconds after event occurrence until its
display.

Note

● Set the Duration

Duration is the length of time necessary for the change to be recognized as motion.

Click and drag the Duration slide bar to any
position between 0.0 and 5.0 seconds. This
establishes the duration of motion allowed
before an event is tr iggered. It also
establishes the period where there is no
motion in order for the event to be completed.

● Step 4: Set the event priority status

In the Priority field, select the priority for the
event to be generated for this motion from a
menu of five options, ranging from 1. Highest
to 5. Lowest. Priorities are color-coded in the
Timeline in the Viewing Screen.
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Setting Motion Detection Recording

Click OK to save the new settings and close the dialog.

Click Cancel to discard the new settings.

Refer to the Chapter 6 for optimizing the Motion Detection
operation.

Tip

If the before event and after event fields are set to 0 seconds,
video will still be recorded while motion is detected.

Note

● Step 6: Set the External Outputs

Click the drop-down menu for the
target external device and set On or
Not specified.

z Available external outputs depend on the Camera Server.
z If the Picture Recording feature of a Camera Server is used

and its configuration includes a preset position then this
preset position will override camera positions set by VK-
64/VK-16, including those in recording schedules and the
Viewing Screen. If VK-64/VK-16 has camera control, this will
be lost when the Camera Server is setting a new preset
position.

Note
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Setting Sensor Event Recording

Configuring Sensor Event Recording Settings
The Sensor Event recording starts recording video when a sensor input has occurred. 

Configure the Sensor Event recording settings in the Sensor Event Settings window
which appears when you click Settings. 

Some items in the Sensor Event Settings window overlap with the items in the Add/Edit
Schedule Item dialog. When the Sensor Event recording is executed, the settings in the
Sensor Event Settings window take precedence.

If using a VB150 with multiple cameras and “Video Input” is also
specified, you can configure different Sensor Event recording
settings for each camera (or you can specify “Do not record”).Tip

If the recording schedule expires during Sensor Event recording,
the Sensor Event  recording also terminates.

Note
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Editing Sensor Event Recording Settings
You can specify recording settings based on the occurrence of a sensor event. A number
of tabs in the Sensor Event Settings dialog are shown to reflect the number of sensors
on each camera. You can modify the recording settings for each sensor.

● Step 1: Next to On sensor event, click Settings...

The Sensor Event Settings dialog
opens.

Setting Sensor Event Recording

Click a tab to modify
that sensor’s settings.
The sensor name
displayed is the name
set by the Camera
Server.

The Top page of the
Camera Server is
displayed after
Internet Explorer
launches.

Set whether or not to
use additional options
(exposure, white
balance, and focus).

Night Mode is
available for VB-C300,
VB-C50i/VB-C50iR,
VB-C50FSi and VB-
C50Fi Camera Servers
or VC-C50i/VC-C50iR
cameras connected to
Camera Server
VB150s. Click Night
mode and select
Disabled, Enabled, IR
light off or Enabled, IR
light on from the sub-
menu.

You can set External
Outputs to On or Not
specified when a
sensor event occurs.

Control the camera via
the Camera Control
Panel. Refer to the
Viewer Manual for the
information about the
Camera Control Panel.

z Frequent sensor events result in high CPU load on the Storage
Server. If you have 10 or more sensor events per minute
continuously, we recommend continuous recording.

z Setting Night Mode to Enabled will activate the IR cut filter. It
will not turn on the built-in IR light. To turn on the IR light,
perform the operation from the Video Window menu.

Note
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Setting Sensor Event Recording

● Step 2: Enable recording and set an event priority

Check Record on this sensor
to enable recording when a
sensor is triggered.

In the Priority field, select the
priority for the event to be
generated for this motion from a
menu of five options, ranging from
1. Highest to 5. Lowest. Priorities
are color-coded as events in the
Timeline in the Viewing Screen.

2

1

● Step 3: Specify a camera angle when the sensor is triggered

In Camera Angle, select a preset
camera angle from the Preset drop-down
menu. When the sensor is triggered, the
camera will be changed to this position.
If you select Not Specified , the
camera will not be moved.
The camera angle can also be changed
by moving your mouse pointer in the
Preview area to display controls and
clicking to pan, tilt and zoom (➝ P. 91).
After the camera has been controlled,
the Preset will be set to Custom.

z Click the Backlight drop-down menu and select On to compensate
for camera views with strong backlighting. The setting will be used
when the sensor is triggered. This is useful, for example, if a
camera angle would change from an indoor view to an outdoor
view when the sensor is triggered.

z If you set the Preset option in the Sensor Event Settings window, the
pre-event recording position may be different from the specified position
because the Camera Server moves when a sensor input occurs.
Also, if you specify the post-event recording time to “0”, and the
sensor input occurs for a short period of time, recording may
terminate before the Camera Server reaches the preset position (If the
sensor input is momentary, the Camera Server may not even move).

z If you are using a normal close type sensor, you need to set the
presets with the Camera Server recording screen. Refer to
“Configure External Device Input” (➝ P. 89) for the details.

Tip

If you set a preset position using the digital zoom of the VB-C300,
the viewing angle may be misaligned.

Note
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Setting Sensor Event Recording

● Step 4: Set the Night Mode (VB-C300, VB-C50i/VB-C50iR, VB-
C50FSi, and VB-C50Fi)

Select the Night Mode from the drop-
down menu. You can select from
Disabled, Enabled, or Not specified.

● Step 5: Set Additional Options (VB-C300)

To use the exposure, white balance, and/or
focus settings on the Camera Control
Panel, check the corresponding check box.

● Step 6: Set frame rate and pre and post event recording duration

In the Record Video At field:

Max. Frame Rate - select a
maximum frame rate for recorded
video from the drop-down menu,
or enter a value from the
keyboard. Choose from 0.1 to 30
frames per second (5 is the
default).

1

The frame rate specified is the frame rate that the Storage Server
will attempt to record, and may not be the actual frame rate used
for recording video. Factors such as the number of Viewers, the
number of Camera Servers used, network traffic and load on the
Camera Server and the Storage Server may reduce the actual
frame rate recorded.

Note

z VB-C300 only allows these options to be used.
z If Exposure is set, the Backlight compensation option is set to

Not Specified.
Note
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Setting Sensor Event Recording

z If the before and after event fields are set to 0 seconds, video
will still be recorded while the sensor is activated.

z Longer pre-event recording will increase memory usage.
Longer pre-event recording with insufficient memory may
greatly reduce performance when the disk-based virtual
memory runs short.

z Even when Record for after event is enabled, the frame rate,
frame size and network delays may have an effect on when the
last frame is recorded and thus the full requested duration of
post event recording may not be available. 

Note

Record for before event - enter a number of seconds for the amount of recording
time before the event occurs (up to a maximum of 30 seconds).

Record for after event - enter a number of seconds for the amount of recording
time after the event has transpired (up to a maximum of 999 seconds).

Click OK to save the new settings and close the dialog.

Click Cancel to discard the new settings.

3

2

● If Continuous Recording is also set, Record for before event is
not available.

● If Record for before event is set to one second or longer, it
may take approximately 10 seconds after event occurrence
until its display.

Note
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Setting Sensor Event Recording

If Setup... is clicked, click the
drop-down menu for the target
external device and set External
Outputs to On or Not specified
on the Control External
Devices dialog.

3

● Step 7: Set the External Outputs

Click External Outputs
Setting to control any
external devices that may be
connected to your Camera
Server.

Click Setup... to change the details of external outputs. Otherwise the default
settings will be used.2

1

z Available external outputs depend on the Camera Server.
z Higher frame rates for Record Video At result in larger disk

usage. Make sure you have enough disk space.
z Camera Servers have certain features to allow image capture

operations based on sensor input or schedule. If settings are
enabled on the Camera Server, they take precedence over any
settings made in VK-64/VK-16. This may cause some
confusion if your VK-64/VK-16 recording schedules fail to
record with the correct camera preset. You should disable
such Camera Server features if you wish VK-64/VK-16 settings
to take precedence.

Note
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● Priorities of Motion Detection and Sensor Event Recordings

You can specify events priorities for the Motion Detection and Sensor Event recordings,
and if the events occur simultaneously, the recording with the higher priority is performed
first.

When using the Motion Detection and Sensor Event recordings together and motion
detection and sensor input occur simultaneously, the Sensor Event recording takes
precedence.

If two events with the same priority occur, the later event takes precedence. When the later
event terminates and the former event still remains, the former event will be handled. 

Example: When Event A occurs with Sensor #1 and Event B occurs with Sensor #2

1. If the former event terminates before the later event:

1. (Assuming that the time for both events is two units)

2. If the former event terminates after the later event:

2. (Assuming that the time for Event A is four units and the time for Event B is two units)

Sensor1 Sensor2

Time

: Event A

: Event B

Time

Sensor1 Sensor2

Setting Sensor Event Recording
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Setting the Preset Tour

Use the Preset Tour function to move among multiple preset positions sequentially. 

In the Add/Edit Schedule Item dialog, there are two options available for setting the
Preset Tour function. To set the Preset Tour function.

Setting Presets

● Add a Preset

Check the Preset Tour box and click
Settings....

The Preset Tour Settings dialog is
displayed.

Click Add.

The Preset Tour (Add) dialog
appears.

Select a preset to add from the
Preset drop-down menu.

For the selected preset, configure the Speed (PT), Speed (Z), and Pause (sec)
settings.

Drag the slide bar for each item to set the value.

4

3

2

1

z The durability of camera Pan/Tilt mechanism may be affected
depending on the Preset Tour setting (➝ P. 135).

z In the Preset Tour, the camera position returns to the first
preset after the last preset.

z When the Preset Tour is used, the Motion Detection recording,
backlight compensation, and additional options are not
available.

z Presets used for Preset Tour are created on the Camera
Server.
Please refer to the Camera Server’s User’s Manual for details
on creating camera presets.

z Preset Tour can be used with VB-C300, VB-C50, and VB-C50iR
only.

Note
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Setting the Preset Tour

Check the settings and click OK.

This returns to the Preset Tour Settings dialog.

● Test the Preset Tour

Check the Preset Tour box and click Settings....

The Preset Tour Settings dialog is displayed.

Click Start Test.

Clicking Start Test executes the Preset Tour once and you can check the operation.

● Change the Preset Settings

Check the Preset Tour box and click Settings....

The Preset Tour Settings dialog is displayed.

Select a preset to change from the
list and click Edit.

The Preset Tour (Edit) dialog
appears.

For the selected preset, change the Speed (PT), Speed (Z), or Pause (sec)
settings.

Drag the slide bar for each item to set the value.

Check the settings and click OK.

This returns to the Preset Tour Settings dialog.
4

3

2

1

2

1

5

For VB-C300, you can return the focus to the default setting by
checking the Focus is returned to default when the camera is
operated. option.Tip
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Setting the Preset Tour

● Change the Preset Order

Check the Preset Tour box and click Settings....

The Preset Tour Settings dialog is displayed.

Select a preset to change the order from the list, and click Move Up or Move Down.

● Delete a Preset

Check the Preset Tour box and click
Settings....

The Preset Tour Settings dialog is
displayed.

Select a preset to delete from the list and click Remove.

Click OK.

This returns to the Preset Tour Settings dialog.
3

2

1

2

1
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Setting the Preset Tour

If the following warning appears, change the settings according
to the tables below.

Warning example 

* The tour time shown depends on the settings.
Click Cancel to return to the setting screen.
Click OK to save the current settings.
(If you are using the Preset Setting Tool, click Save on the setting
page of the tool)
Endurance of the pan/tilt mechanism is approximately 100,000
round trips at the full range. The total tour time depends on the
combination of the movement rate, movement range, and still
time. Refer to the following tables.
Total tour time for 100,000 round trips in the pan direction
(estimated).

Example: If the movement rate (PT) is 1, still time is 30 seconds,
and movement range (angle) in the pan direction is 50
degrees, it takes approximately 9,444 hours for 100,000
round trips in the pan direction.

Note

Movement rate (PT) is 1.

Still time
Movement range in the 
pan direction (angle)

0

10

20

30

    50

3872

5666

7555

9444

    100

3825

4722

5666

6611

    150

3809

4407

5037

5666

(Unit: Time)

(sec.)

0

10

20

30

 
 

    50

1983

3777

5666

7555

    100

1936

2833

3777

4722

    150

1920

2518

3148

3777

Movement rate (PT) is 2.

Still time
Movement range in the 
pan direction (angle)

(Unit: Time)

(sec.)
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Setting a Special Day Schedule

About Special Day Recording
The Special Day Schedule window is used for configuring particular days such as public
holidays. When Special Day Schedules are set, Normal Schedules that conflict with the
Special Day Schedules are disabled.

In the Configuration and Preferences Screen, click the Recording Schedules tab and
ensure the Special Day Schedule is selected. The Special Day Schedule consists of:

z Storage Server - Select a Storage Server from the list to add/edit schedules for that
server. Associated Locations and Zones are displayed in the Schedule Area.

z Schedule Type selector - Allows you to select a schedule type. These are user-defined
schedules such as Public Holidays and Long Weekends.

z Days selector - Allows you to choose a day to use this schedule.

z Schedule Area - Covers a single day, 24 hours. Overrides a Normal day schedule.
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Setting a Special Day Schedule

Enter a name in the Schedule Name
area, for example “Company Holidays”.

Click OK.

The schedule type is added and the
dialog closes.

The new name will appear in the
Schedule Type list.

3

2

Adding, Editing and Deleting a Schedule Type
The Add Schedule Type dialog allows you to create a name for a new schedule type, for
example, a public holiday. You must create a schedule type first before you can associate
days with it. There is no limit to the number of schedule type that can be added.

To launch the dialog and add a Special Day Schedule.

● Add a Schedule Type

Click Add....

The Add Schedule Type dialog is
displayed.

1

● The scheduling area functions the same as the Normal
Recording Schedule but only covers a single day (from 00:00
hrs. to 24:00 hrs). To have a special day schedule run over a
long weekend (Fri, Sat & Sun), all dates of three days must be
added to the list of days to use the schedule.

● When Special Day Schedules are running, Normal Schedules
are disabled. If an invalid schedule exists, the following
warning message will be displayed. “There is a camera with
no recording schedule. Are you sure to save the settings?”

Note
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Setting a Special Day Schedule

● Delete a Schedule Type

In the Special Day Schedule window, click a
schedule type in the Schedule Type list to
select it.

Click Delete. 

The schedule type is deleted.
2

1

● Edit a Schedule Type

In the Special Day Schedule window, click a
schedule type in the Schedule Type list to
select it.

Click Edit.

This will bring up the Edit Schedule Type
dialog.

Overwrite the existing name. For example, you
may wish to change the name “Company
Holidays” to “Company Special Days”.

Click OK.

The new settings are saved and the dialog
closes.

3

2

1

If you delete a schedule type where there are dates associated
with that schedule, a warning will appear. Delete the associated
dates before deleting the schedule type.Note
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Setting a Special Day Schedule

Adding and Deleting a Day
The Select Date calendar allows you to select a day that can be used for the schedule
type.

To add a day:

● Add a Day

In the Special Day Schedule window, click a
schedule type in the Schedule Type list, for
example, “Company Holidays” (created on P.
137) and then in the Days list click Add....

This will bring up the Select Date calendar
(see below).

Click to select a day in the calendar, then click
OK.

Click Add... again to add another day to the
same schedule type if you wish.

Added days are shown in the Days list (see
example on next page).

Other calendar selection methods are shown
on the next page.

2

1

Click to scroll back

through the months.

Click to scroll forward

through the months.

Click a day to 

highlight it, then

click OK to

bring up that

day in the Days

list.
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● Delete a Day

In the Special Day Schedule window, click a
schedule type in the Schedule Type list, for
example, “Company Holidays” and then in the
Days list click one of the days associated with
the schedule type.

Click Delete below the Days list. The day is
deleted from the schedule type.2

1

Alternatively, click the current month
and a month selector will appear.

To select another year, click
the current year and scroll
down or back up, using the
up/down arrows.

z If you attempt to associate the same day with different special
day schedules, you will be given a warning and asked to
delete the other entry before creating a new one.

z Expired days are listed in italics.

Note
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Setting a Special Day Schedule

● Save Changes

Click Save Schedule to keep all your settings.

The settings are then saved to the Storage Server.

Click Discard Changes to cancel any changes you have made.

If you wish to return to the Viewer, select View > Viewing Screen from the menu
bar.2

1

The bottom right-hand
corner of the
Recording Schedule
window consists of
two buttons, Save
Schedule and
Discard Changes.
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Displaying the Recording Setting Summary

Display the summary information of the set recording schedule.

Click Display Record Setup Summary to
display the Record Setup Summary dialog.

The Record Setup Summary dialog shows the following information for the time period
where the highest load is expected when the schedule is performed.

Number of Camera Servers
Number of Camera Servers with Motion Detection
Total Recording Frame Rate

Total Recording Frame Rate (Continuous Recording)
Total Recording Frame Rate (Sensor/Motion Detection Recording)

Maximum Retained History
Maximum File Size/Duration
Disk Space Used

Click OK to close the Record Setup Summary dialog.

Display Record
Setup Summary is
located at the center-
bottom of the Special
Day Schedule
window. 
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Displaying the Recording Setting Summary

Click Copy to copy the contents of the Recording Setting
Summary dialog to the Clipboard.

Tip

If the load is too high, adjust the recording schedule again.
Note
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Chapter 5
Viewer Reference
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This chapter outlines how to use and configure the Viewer.

● Setting the Viewer

Explains how to configure settings that are specific to the Viewer.

● Arranging and Saving Layouts

Explains how to arrange layouts and set layout sequences.

● Video Window Operation

Explains how to create a video window and display it in the Viewing Area and control the
Camera Server.

● Using the Timeline and Viewing Events

Explains how to use the Timeline for live and recorded viewing as well as view and search
events.



147

5

V
iew

er
R

eferen
ce



148

Record Now button
(➝ P. 196)
A manual recording
with duration of one
minute is initiated.

Capture Still Frame
button (➝ P. 196)
Click to keep the
current image on a
Video Window.

Viewer Operation Flow

Location selector (➝ P. 177)
Drop-down menu indicating
locations available in the system.

Zone selector (➝ P. 177)
Drop-down menu indicating
zones within a location.

Camera Control Panel 
(➝ P. 185)
The Camera Control Panel
enables you to control a
camera and quickly determine
a camera position.

Event indicator (➝ P. 183)
A color bar is displayed at the
top of l ive Video Windows
when an event occurs (if
enabled).

Viewing Area for Video
Windows (➝ P. 154)
The Video Windows are
arranged here. Video Windows
can be re-sized.
They can also be arranged into
a uniform grid.

Playback controls (➝ P. 194)
Click the VCR-like controls to
play, rewind, fast forward or
jump to previous and next
events.

Timeline (➝ P. 194)
Paste date and time as well as events which
occurred are displayed here. Events are displayed
as bars colored according to the priority. Click and
drag the Time bar to go back or forwards in time.

Camera Server (➝ P. 192)
Name of the Camera Server
currently selected.

Menu bar
Access common menus
from here.

Timeline control (➝ P. 192)
Scroll forwards through the
current day or jump forward
incrementally by day or
week.

Video Window (➝ P. 178)
Recorded videos and l ive
videos are displayed in these
windows.
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Viewer Operation Flow

Timeline Play Head (➝ P. 194) 
Drag the play head to a position on the Timeline to
start playing back recorded video from that time.

Return to Live button (➝ P. 198)
Click to return the Timeline
Playhead to the current time. If
you click this button while playing
recorded video, the selected
Video Window will return to live
video.

Jump to Time button (➝ P. 195)
Click to enter a specific date and
time to jump to, to start playing
recorded video. The Timeline
moves to the time selected.

Extract Video button (➝ P. 198)
Click to extract a segment of
video to save as another file.

Zoom In/Zoom Out buttons
(➝ P. 197)
Click to zoom in or out of the
Timeline.

Live Events Log list (➝ P. 199)
Indicates events that have been
logged on Storage Servers after
the Viewer was launched.

Video window menu icon
(➝ P. 188)
Select preset camera angles,
custom pan, tilt and zoom, and
select a Video Window size.

Camera Selection Area (➝ P. 176)
Thumbnails of Camera Servers added to each zone are displayed
here. Thumbnail representations of cameras can be dragged onto the
Viewing Area for viewing.

Event Search button (➝ P. 201)
Click to bring up a dialog and
enter search details based on
time range, Location/Zone and
priority.

Timeline control (➝ P. 193)
Scroll forwards through the
current day or jump forward
incrementally by day or week.
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Starting the Viewer

Launching Procedure
Before you launch the Viewer, make sure your monitor resolution is set to a minimum of
1024 x 768 pixels.

● Start the Viewer

Double-click the VK Viewer desktop icon.

localhost
Connects to Storage Server
and starts the Viewer.
Select this option to use the
local PC where Viewer is
installed as the Master
Storage Server.

Alternatively, from the Windows Start menu select: Programs > WebView
Livescope > Network Video Recorder VK Series v1.3 > VK Viewer.

The connect option menu for Storage Server is displayed. Select the Master
Storage Server option and click Connect.

Start-up Screen

Use IP address
Connects to Storage Server
and starts the Viewer by
specifying its IP address.
Select this option when the
Storage Server and the
Viewer are installed on
separate PCs.

Not use Storage Server
Select this option to use the 
Viewer only without 
connecting to a Storage 
Server.

You need the user name and password set for the VK-64/VK-16
Storage Server to start the Viewer.

Note

If a connection error occurs, you may not have a Master Storage
Server connected.

Tip
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Starting the Viewer

Connect to the localhost
If you want to use the local PC where Viewer is installed as the Master Storage Server,
select localhost to start the Viewer.

Select localhost from the
drop-down menu.

Click Connect.

Enter your User Name and
Password, and click Login.3

2

1

The user name and password for the VK-64/VK-16 entered in this
step are defined by your System Administrator on the he Storage
Server Configuration dialog. They can be different from the user
name and password used to log into Windows.

Note
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z If you need to use a proxy server, you need to change the
Internet option settings in the following procedure:
1. Select Start > Control Panel > Internet Option.
2. Select the Connection tab.
3. Click LAN settings ….

Change the proxy server settings.
z If using a proxy server between a Viewer and a Storage Server,

it should be one which does not perform response buffering.
Proxies which are configured to perform response buffering
may lead to delays in sending small amounts of data (such as
events) from the Storage Server to the Viewer. The Apache
proxy server does perform response buffering so is not
recommended.

z You cannot transmit or receive audio when using a proxy
server.

Note

Specify the IP address of Storage Server to connect Viewer
If you installed the Viewer and Storage Server on separate PCs, specify an IP address of
Storage Server and connect Viewer to the Storage Server.

Select Use IP address from
the drop-down menu.

Click Connect.

Enter the IP address or host
name of the Master Storage
Server in Host Name or IP,
and the port number in Port.

Click Connect.

Enter your User Name and
Password, and click Login.5

4

3

2

1

The dialog for entering the IP address will also be shown even
when connection to the Storage Server failed.

Tip
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Starting the Viewer

Use Viewer only without connecting to Storage Server
(Viewer Only Mode)
You can use the Viewer only without connecting to a Storage Server. When Storage
Server is not used, some functions are not available.

● Use Viewer only

Select Not use Storage
Server from the drop-down
menu.
Click Connect.

2

1

● Viewing Screen

● Timeline is not displayed. Timeline under the View menu cannot be used.
● Capture Still Frame feature cannot be used.
● Search Events under the Edit menu cannot be used.
● Live Events under the View menu cannot be used.
● Shared Layouts are not displayed.
● In the Add Layout Sequence dialog, a type of layout is fixed to Personal Layout Sequence.

● Configuration and Preference Screen

● Recording Schedules tab is not displayed (→ P. 99). Some functions such as video
recording, sensor events, and motion detection are not available.

● In the Storage and Camera Server Summary, Storage Servers tab is not displayed (→ P. 76).
● In the Storage and Camera Server Summary, the Camera Server list shows only

Camera Server, Locations / Zones and Type (→ P. 77).
● In the Add Camera Server and Edit Camera Server dialog, the following items are

gray (disabled):
● Save Recorded Video on
● Camera Server Settings
● Camera Settings > Save video in

● In the Viewer Settings window (→ P. 156), items in the Event Notification Settings
area are gray (disabled).

Functions not Available during Viewer Only Mode (Not Use
Storage Server)
When you launch the Viewer with Viewer Only Mode, the following functions are not available.
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Viewer Start-up Window
When you start the VK-64/VK-16 for the first time when no Layouts have been configured,
you will notice that the Viewing Area is blank as shown below. Previously-configured
cameras on the network will appear as thumbnail images in the Camera Selection Area on
the top of the screen. These can be dragged onto the Viewing Area for monitoring. If your
Administrator has already created a Layout for you, then the Viewing Area will display
the first Personal Layout (or first Shared Layout if there are no Personal Layouts) as
shown in the example on the previous pages.

Viewing Area

Click to maximize the
Viewing Screen.

You can 
hide these 
panels via 
the View 
menu.

Refer to P. 165 for details on editing layouts.
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Viewer Start-up Option
You can set the start-up option of the Viewer to omit the display of Start-up screen (➝P.
71, P. 150) and login screen to enter a user name and password (➝P. 72, P. 151).

You can place a shortcut icon on the Desktop for your convenience by following the
method described below.

For this setting, you cannot use the shortcut icon that was automatically created on the
Desktop after installing this software, which is used for starting the Viewer.

Right-click on the icon for NVR_Viewer.exe located in the installation directory and
select Create Shortcut from the menu. The shortcut icon will be created. Move it to
the Desktop.

The default destination directory is shown below.
<System Drive>:\Program Files\Canon\WebView\NVR

1

Right-click on the shortcut icon that was moved onto the Desktop and select
Properties from the menu.

Example

“C:\Program Files\Canon\WebView\NVR\NVR_Viewer.exe” -h=192.168.100.1 -p=80 -
u=admin -pw=NVR
Make sure to enter a space after 
“C:\Program Files\Canon\WebView\NVR\NVR_Viewer.exe”.

2

Specify Target as follows (using alphanumeric characters)
-h=<IP address of the Storage Server>

This specification is mandatory
(➝P. 73, P. 152).

-p=<port number> It can be omitted. When omitted, 80 is
specified (➝P. 73, P. 152).

-u=<user name> Specify the user name (➝P. 72, P. 151).
-pw=<password> Specify the password (➝P. 72, P. 151).
-u and -pw can be omitted. When omitted, the start-up
screen will not be displayed (➝P. 71, P. 150). Instead, the
login screen for entering a username and password is
displayed. When you use the Viewer alone, you also need to
specify “nohost” for -h.

System Drive is a drive that contains a directory (folder) in which
the Operating System files are stored. For example, if the
Operating System is installed on Drive C, your system drive is
Drive C.

Tip

Password can be referred through the Properties of the shortcut
icon. You need to make sure that the Password is secure.

Note
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About the Viewer Settings window
The Viewer Settings window is used for settings such as notification priorities and the live
viewing frame rate. Settings are stored on the Viewer PC, not on the Master Storage
Server.

This window consists of:

z Video Viewing Settings - Select the maximum viewing frame rate for live videos.

z Master Storage Server - The current Storage Server is indicated. You can switch to
display or not to display the Master Storage Server option window (connect menu) on
start-up, and also add/delete Master Storage Server into/from the connect menu.

z Proxy Setting - Use this option to make an access to Storage Server via proxy server.

z Layout setting - Confirm if the layout was preserved when quitting or when the screen
changes.

z Event Notification Settings - Set operator notification and adjust duration in seconds,
set operator acknowledgement (recognition) of an event , set an audio alert, and
suppress event display.

z Audio Setting - Set automatic termination of audio transmission after a specified period
of time.

z Focus Operation Setting - Set the focus position to return to the default setting of the
camera when operating the camera.

Click the Viewer Settings tab to
display the Viewer Settings
window.

Event Notification Settings areaMaximum frame rate for live viewing
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Setting the Viewer

Lower priority items can 
have less notification 
sett ings associated with 
them.

When ticked even if an 
event occurs, it is not 
displayed in the Live Events 
Log in the Viewing Screen.

Set up notifications by 
priority from 1 (highest) to 5 
(lowest). Priorities are color-
coded as follows.

Color Priority

Red Highest

Orange High

Yellow Medium

Light Green Low

Dark Green Lowest

If a high maximum frame rate is specified, the load on the
computer CPU will be high and Viewer operations may take
longer. When Auto Adjust Frame Rate is ticked, frame rate is
automatically reduced when CPU load becomes high.

Note

Maximum frame rate for live viewing
Select a frame rate from the drop-down list. 

Adjust frame rates automatically.
Enable larger Video Window captions in the Viewer.

The current Master Storage Server is indicated.

You can select the Master Storage Server when
launching the Viewer (➝P. 71, P. 150).

Add the current Storage Server into connect menu.

Delete the current Storage Server form connect
menu.

Set duration of alert.
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Viewer Settings window - Use large captions for Video
Windows

Tick Use large captions for Video Windows
to enable easier-to-read Video Window captions
in the Viewer.

Standard caption in Video Window.

Large caption in Video Window.

Viewer Settings window - Identify the Master Storage Server
A Master Storage Server maintains settings for Camera Servers and Layouts. 

The selected Master Storage Server is indicated
in the Viewer Settings window.

Viewer Settings window - Configure the proxy server
When you wish to access the Storage Server
Using the proxy server set in the Internet
Option, tick Use internet proxy settings and
restart the Viewer.

Viewer Settings window - Configure layout in the Viewing
Screen

If you wish to confirm whether the layout
information has already been saved when
finishing the Viewer or when switching to the
Viewing Screen, tick the Confirm if the layout
was preserved when quitting or when the
screen changes check box and restart the
Viewer. If not ticked, the layout information will
not be saved.
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Setting the Viewer

Viewer Settings window - Audio Transmission Settings
The camera which is sending or
receiving audio to a Viewer cannot
interact with other Admin or NC
Viewers. Audio transmission and
reception can be terminated
automatically even if you forget to
disconnect the audio connection.

When using this option, tick The voice transmission will be ended for fixed time
automatically check box, and specify the period within the range from 1 to 60 minutes
(default is 10 minutes). When the specified period of time passes during audio
transmission, it will be terminated automatically.

Viewer Settings window - Configure Focus Settings
You can set the camera to return its
focus mode to the default setting
when the camera orientation is
changed. The focus mode returns
to default if it has been changed to
Manual after any focus operation
using a preset with focus setting
defined or via Camera Control
Panel.

Use this option by ticking the It returns to the default setting on the camera side when
the camera is operated check box.

Automatic termination works even if the servers are
communicating with each other. Switching to another Video
Window resets the time.Tip
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Viewer Settings window - Edit Event Notifications
When an event occurs, it is indicated in the Live Events Log in the Viewer. In the Viewer
Settings window, Event Notification Settings area, you can set up actions based on
events according to the priority of the event. To set the event notifications.

● Set priority alerts from Highest to Lowest

In the Priority area, you configure the following settings:

Tick the Operator Notification for box to enable a notification period when an
event occurs. Select a notification period in seconds from the Seconds drop-down
menu or enter it from the keyboard (0 - 99). When a event occurs, the event flashes
in the Live Event Log window for the period of time specified using this option, and
a color bar indicating the event’s priority light on the top of a live Video Window for
one minute.

If you specify 0 second, an event which has occurred will not flash and a color bar
will light for one minute.

Tick the Requires operator acknowledgement box for the event. When an event
occurs it will flash in the Live Events Log and the audio alert will sound (if
specified) until the operator double-clicks on the event (that is, the notification time
will not apply to the event in the event log). (That is, the notification time will not
apply to the event in the event log.)

Tick the Audio Alert box to have an audio alert play during the event notification
period.

The Windows system sound “Exclamation” is used for audio alerts (For a PC with
no sound board installed, a beep sound is used). This sound repeats for the
duration of the Operator Notification. If Operator Notification is not set, the audio
alert is played once.

Tick the Don’t show events to have the event not displayed on the Timeline of the
Viewing screen or on the Live Events Log window even if the event occurs.4

3

2

1

Even if Don’t show event is ticked, events are shown in the
Search Results in the Event Search dialog.

Tip
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Setting the Viewer

Saving Viewer Settings

z Click Save Changes to keep all your settings. The Viewer settings are then saved to
the local disk.

Click Discard Changes to cancel any modifications you have made.

z If you wish to return to the Viewer, select View > Viewing Screen from the menu bar.

The bottom right-hand corner of
the Viewer Settings window
consists of two buttons, Save
Changes and Discard Changes.
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■ Managing Video Layouts

About the Layout menu
The Layout menu allows you to save particular Video Window layouts for easy monitoring.

The name of the currently-displayed layout can be found in
the top-left corner of the Viewing Area, next to the Layout
button. You can create a new layout, save a layout or
open and rename a previously-saved layout.

Click the Layout button to open the Layout menu. You can also right-click anywhere in the
Viewing Area to display the Layout menu.

Below the Layout menu options, existing Layouts
are displayed and divided into two sections.

Shared Layouts:
All the users can available these layouts. You need
Administrator privilege to create a layout (➝ P. 66).
Normal users cannot modify these layouts.

Personal Layouts:
Lists layouts created by the current user. These are
shown under the Shared Layouts list to distinguish
the different types of layouts. Other users cannot
use them.

Optional
Layout
Menu

Shared
Layout

List

Personal
Layout

List

This chapter details how to create and save Video Window Layouts and Layout
Sequences.

The layout displayed when launching the Viewer is the first
layout listed in the Personal Layouts (or in the Shared Layouts if
there is no Personal Layouts).Tip
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Arranging and Saving Layouts

● To create a new layout (a previously-saved layout is displayed):

Click the Layout button to open the menu, and then select New Layout.

The Viewing Area will become blank and the default layout name “Untitled” will be
displayed.

The process of creating folders and saving a layout could be done in the following order:

1

Organize and create
Layout folders

2

Arranging Video
Windows in Layout

3

Save Layout to a 
folder

Drag the Camera Server’s thumbnails onto the Viewing Area to create the layout.



● Create a new folder...

In the Organize Layouts & Layout Sequences dialog, click on a shared or personal
folder and then click Create Folder.... The Folder Name dialog appears.

Enter a name up to 50 characters
and click OK.

The new folder will appear in the
Organize Layouts & Layout
Sequences dialog.

2

1

164

Organizing Layouts and Layout Sequences
The Organize Layouts & Layout Sequences dialog allows you to create folders and sub-
folders in which to save item (layouts and layout sequences) (➝ P. 166). To display the
dialog:

● Open the Layout menu and select Organize...

The Organize Layouts & Layout Sequences dialog opens (Administrator version
shown). The Shared Layouts folder will not display if you have logged in as an Operator.

Create a new folder.

Move an item to 
another folder.

Move an item up or 
down within a folder.

Delete an item or folder 
containing items.

Edit an item name or
folder name.

Copy an item to 
another folder.

Arranging and Saving Layouts



165

5

V
iew

er
R

eferen
ce

Arranging and Saving Layouts

● Move or Copy a layout or layout Sequence to another folder...

In the Organize Layouts & Layout Sequences dialog, click an item to highlight it,
then click Move to Folder....

The Select destination folder dialog opens showing a list of created folders.

Click to select the target folder in the list
and click OK.

The item will be moved into that folder.

If you selected Copy to Folder..., you
can copy items in the same manner.

2

1

● Move an entry up or down...

Click an item or folder to highlight it, then click Move Up or Move Down. The item will
move up or down within a folder.

● Edit or delete a layout or folder...

Click an item or folder to highlight it, then click Edit. The respective Layout Name or
Folder Name dialog will appear for you to overwrite a new name.

Click an item or folder to highlight it, then click Delete. If you have Operator status, you will
not be able to delete a shared layout or layout sequence.

z You cannot change the parent folder names, Shared Layouts
or Personal Layouts.

z You need Administrator privilege to manage shared folders
(➝P. 66).

Note
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● Step 2: Create a name for the layout or layout sequence

Change “Untitled” or an existing layout name to save the item with a new name.

Click a location in the list. Click to select the folder to save the layout and click OK.
The item is saved to that folder.

Alternatively, click Create Folder... to create a new folder (➝ P. 164) and save the
item in there. For example, if you wish to save an Administrator-shared layout to a
personal folder.

Once you have saved an item, the name will
appear next to the Layout button in the Viewing
Area.

2

1

Arranging and Saving Layouts

Saving a Layout or Layout Sequence
Administrators and Operators can save layouts and layout sequences to an existing folder
or a new folder via the Save Layout dialog.

● Step 1: Open the Layout menu and select Save or Save As...

The Save Layout dialog opens. A New Folder button
and Name field is also available for you to create a
new name and location for the copied layout or layout
sequence.

Administrator’s 
Save Layout dialog

Operator’s 
Save Layout dialog
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Arranging and Saving Layouts

Arranging Layout Sequences
You can set up an automated sequence of shared and personal layouts to display in the
Viewing Area at set intervals.

From the Layout menu, select New Layout Sequence.... The Add Layout
Sequence dialog displays.

Enter a sequence name for the new layout sequence and choose a Type of layout
sequence from the menu, Personal Layout Sequence or Shared Layout
Sequence (you can switch between the two as you add layouts).

Use the Add Layout > button to add layouts to the new sequence. Click Up and
Down to change the display sequence of layouts. Click Delete to delete the layout.

In the Duration menu, select a set duration of display time for each layout or enter a
custom time, overwriting the existing time.4

3

2

1

● Opening a previously-saved layout...

Click the Layout button to open the menu and then click a layout or layout sequence in the
list. The item will be loaded onto the Viewing Area.

If you select another item without saving the
current item, a dialog will appear prompting
you to save the current layout or layout
sequence (if the Layout setting (➝ P. 158) in
the Viewer Settings window is ticked).



168

Arranging and Saving Layouts

● Opening and running a layout sequence...

To start the layout sequence, select it from the Layout menu.

When a layout sequence is running, further options are
available in the Layout menu.

z Click Edit Layout Sequence to change settings in the
currently-running layout sequence. The current
sequence will be indicated as Paused.

z Click Resume Layout Sequence to play the current
layout sequence.

Click OK to bring up
the Select destination
folder dialog.

Select or enter the 
time. 
You can set the time 
within the range from 
1 to 9999.

Click Add Layout to 
add a selected layout 
from the left-hand 
column.

Click on a
layout to
select it.

Enter a new name.

Select a layout
sequence type.

Layout Sequence:

All the users can share these layouts. You need Administrator privilege to create a layout
sequence. Normal users cannot modify these layouts.

User Layout Sequence:

Lists layouts created by the current user. Other users cannot use them.

z You can only save layouts as a layout sequence.
z VB101 cannot be used for layout sequence.

Note
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Arranging and Saving Layouts

■ Working with Layout Grids

You can customize your layouts by applying one of the following grids:

z None - You can arrange Video Windows
freely.

z Alignment Grid - creates a grid of dots
in the Viewing Area. You can re-size
Video Windows using the grid.

z Small Grid, Medium Grid and Large Grid - creates a small (160x120), medium
(320x240) or large (640x480) grid where you can place Video Windows in a tile-like
manner.

z Custom Grid - You can set the grid size (➝ P. 174).
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● Drag, drop and re-size a Video Window

In the Camera Selection Area, click a
thumbnail image and drag its selection
boundary onto the Viewing Area grid. The
boundary will re-size.

Release the mouse button. The selection
will become a Video Window, and “snap”
into alignment along the grid closest to it.

To re-size the Video Window, click any
corner and drag the image outwards to
snap to a larger grid area. Release the
mouse button. The selection boundary
will become a Video Window and “snap”
into alignment along the grid closest to it.

2

1

Working with the Alignment Grid
Select the Alignment Grid from the Layout Grids sub-menu. The Viewing Area displays a
grid of dots. When you place a Video Window, it “snaps” to the grid boundaries.

● Create and align more Video Windows

Click and drag other
camera thumbnails onto
the Viewing Area to
create Video Windows
for monitoring, and resize
the window. A layout
example is shown to the
right.
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● Working with Small, Medium and Large Grids

When you select Small Grid, Medium Grid or Large Grid from the Layout Grids sub-
menu, the Viewing Area displays “cells” for Video Windows. These are boundaries
indicating a uniform size which is used to display Video Windows in a tile-like manner.

● Drag a camera thumbnail image into a blank tile

In the Camera Selection Area,
click a thumbnail image and drag
its selection boundary onto the
Viewing Area grid. The boundary
will re-size.

Release the mouse button. The
selection boundary will become a
Video Window and “snap” into
alignment along the grid closest
to it.

To re-size the Video Window, click any
corner and drag the image outwards to
‘snap’ to a larger grid area. Release the
mouse button. The selection boundary
will become a Video Window and “snap”
into alignment along the grid closest to
it.

2

1

z The Layout menu is also available by right-clicking anywhere
in the Viewing Area.

z A Video Window can be increased in size to take up a number
of tiles, (for example 4 tiles, 9 tiles etc) so that Video Windows
of different sizes/priorities can be viewed.

Tip
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The Viewing Area with a Small Grid could look like this:

The Viewing Area with a Medium Grid could look like this:

Although you can add more, the number of Video Windows you
can display simultaneously will depend on your video card, the
speed of your computer, the maximum frame rate (➝P. 157)
configured with Viewer setting, the video size and video quality
coming from the Camera Server and the size of each Video
Window displayed. A maximum of 16 cameras is recommended
in the Layout Area.

Note
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The Viewing Area with a Large Grid could look like this:

In this example, the Camera Selection Area and Timeline are hidden (➝ P. 173).
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Working with the Custom Grid
The Custom Grid feature allows you to set a custom-size for displaying Video Windows.

● Set a custom grid

Select Custom Grid from the Layout Grids sub-menu. The Custom Grid dialog
appears. Values are given in pixels.

In the Horizontal or Vertical field, overwrite the
existing value with a custom value, or use the
up/down arrows to select a value. When you
adjust the value in one field, you’ll notice the
value change in the other field. This is because
the proportions of the re-sized Video Window
are constrained and the dimensions are scaled
accordingly.

Click OK to close the dialog. The grid will re-size to your new settings.
3

2

1

Using Custom Grid may cause high CPU load.
Note
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■ Hiding and Showing Task Areas

The View menu allows you to show/hide task areas and other display elements in the
Viewer. When you unselect Camera Selector and Timeline and then select Fullscreen,
the result is a large area in the Viewer for displaying more Video Windows as shown
below in the Large Grid example. Pressing the Esc key returns the menu bar. You can
also select to hide Video Window Captions, the Camera Control and Live Events.

The number of Video Windows in the display achieved is dependent on the display
resolution. A higher resolution will result in more Video Windows displayed.

View ➝ Camera Selector

View ➝ Timeline

View ➝ Full-Screen (Large grid, 1280x1024). The Windows task bar is also hidden.
Pressing the ESC key displays the task bar.
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Basic Video Window Functions

This section shows you how to create Video Windows for viewing in the Viewing Area and
how to adjust camera angles.

■ Selecting Cameras for Viewing

About the Camera Selection Area
The Camera Selection Area is used to display thumbnails of all the cameras. You can
select another set of thumbnails of currently-available cameras via the Location and Zone
drop-down menus and then place them into the Viewing Area as Video Windows.

z The Location drop-down menu lists the physical locations of cameras on the system.

z The Zone drop-down menu lists the groups of areas within each location.

About Camera Thumbnails
When a Location is selected, the thumbnail images of the Camera Servers registered in
that Location will appear. Depending on the number of cameras in the selected Location, a
scrollbar at the base of the Camera Selection Area can be used to scroll the display of
thumbnails.

Each Zone is grouped into camera thumbnail images and these can be dragged onto the
Viewing Area to create Video Windows.

When you select a location, its associated zones will be listed below.

You can hide the Camera Selection Area to allow more display
space for Video Windows. From the View menu, select Camera
Selector to hide/show the Camera Selection Area.Tip

Locations, zones and thumbnails are configured and managed by
users with Administrator privileges.

Note
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● Step 2: Select a Zone from the menu or thumbnail folder region

Click the Zone drop-down menu or on the down
arrow.

A list of pre-configured zones appears.

Click a zone in the list.

Once a Zone is selected from the drop-down
menu, the Camera Selection Area for the selected
Zone moves to the left.

Alternatively, click the scrollbar
located under the Camera
Selection Area. Drag it to the
right until the desired Zone is
displayed.

Selecting Locations and their Zones
Selection is performed in the following order:

● Step 1: Select a Location from the drop-down menu

Click the Location drop-down menu or on the
down arrow.

A list of pre-configured locations appears.

Click a location in the list. Zones for that list will
appear in the thumbnail section to the right.

1

Select a Location

2

Select a Zone 
in that Location

3

Click and drag 
thumbnails to 
view live video
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An error message will appear in the Video
Window if there is a connection problem.

Note

Basic Video Window Functions

■ Basic Video Window Functions

Creating, scaling and moving Video Windows
Once you have chosen a location and chosen a zone, you are ready to view one or more
cameras in that zone. Camera thumbnail images are used to create Video Windows in the
Viewing Area. The Viewing Area can support multiple Video Windows for live monitoring
and viewing recorded video simultaneously.

● Click and drag a camera thumbnail onto the Viewing Area

Click the thumbnail image and, while
holding down the mouse button, drag
its boundary anywhere onto the
Viewing Area.

Release the mouse button. The re-
sized outline becomes a live Video
Window.

2

1

When placed, the Video Window
is re-sized and re-positioned
according to the Layout Grid.

A selected Video Window is
highlighted.
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● Re-size a Video Window

Click a Video Window to highlight it. An
arrow icon will appear in the lower right
corner. Click the arrow icon and drag
outwards. You can also click on the other
corners and drag to re-size the window.

Release the mouse button when you
have reached the desired size.

Alternatively, cl ick the Video
Window menu button and select

Video Display Size. Select Video
Receive Size from the menu, and then
select Small, Medium, Large, or Default
from the sub-menu.

A right-click action on the Video Window
will also bring up the same menu.

● Move a Video Window

Click anywhere on a Video
Window and drag it to any
position in the Viewing Area.

2

1

z For best performance on the Viewer, such as to view as many
Video Windows as possible, re-size (160x120, 320x240,
640x480) the Video Windows so they are a standard
resolution.

z When Video Windows that are other than a standard
resolution are displayed, the load on the computer CPU will be
high and Viewer operations may take longer.

Note
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● Add more Video Windows

Click and drag other camera thumbnails onto the Viewing Area to create Video Windows
for monitoring. Your Viewing Screen could look like this.
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There are various ways you can manage the layout of Video Windows in the Viewing Area
(➝ P. 170).

Selecting Multiple Video Windows
You can select multiple video windows easily. You can also move, cut, or copy selected
multiple windows simultaneously.

● Selecting Multiple Video Windows

There are three ways to select multiple windows:

z On your keyboard, hold down the Ctrl key and click each
Video Window to select them, or.

z In the Viewer, the number of Video Windows you can display
simultaneously will depend on your video card, the resolution
and quality settings of the camera and the Live Video Viewing
Settings (frame rate) set in the Viewer Settings window of the
Configuration and Preferences screen.

z If the load on the computer CPU is high, Viewer operations
may take longer.

Note

z Video Windows from different zones and locations can be
displayed in the same Layout.

z You can copy and paste a multiple selection of Video
Windows t one time which can be pasted into and saved as a
new Layout.

Tip

z Click outside the Video Windows
and drag a selection box around
the Video Windows you want
selected, as shown below. Only
windows contained within the
area of selection are selected.
Dragging around part of an
image will not select it.

z If you wish to select all Video
Windows, click Select All from
the Edit menu (or on your
keyboard press Ctrl + A).
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Live Events Log list

Double-click an event to view it in the
corresponding Video Window. The
Live Events Log opens automatically
when you launch the Viewer, if left
open in a previous session.

Recorded

Click to view recorded footage in the
corresponding Video Window.

■ Video Window States

Video Window Properties include:
z Title bar - indicates name of camera, live or recorded viewing.

z Video display - displays live or recorded information.

z Recorded video indicator - displays a time/date stamp in the title bar for recorded footage.

z Event indicator - displays a colored bar across the top of the Video Window.

z Pan, tilt and zoom controls - when the Video Window is double-clicked or the Video
Window menu item, Get Camera Control is selected, controls appear to enable pan, tilt
and zoom.

About Video Window states
Video Windows can be displayed in the Viewing
Area according to their conditions:

z Live - when viewing live video from a Camera
Server.

z Recorded - Displays recorded video from a
Storage Server.

The full camera name/event may not display if you reduce the
size of the window.

Note
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Color Priority

Red Highest

Orange High

Yellow Medium

Light Green Low

Dark Green Lowest

Each Video Window displays video from an
individual camera. Video Windows can be
re-sized, repositioned or closed.

z Title bar

The title bar consists of menu, camera name
and live or recorded status.

Live video Recorded video,
Playback

z Recorded Video
Indicator

When recorded video
is shown, the title bar
on a Video Window will
change from black to
gray.

z Video display conditions

For recorded video, the
time/date indicator may
not fully display if the
Video Window size has
been reduced.

z Event Indicator

If the option for Operator
Notification has been set, a
color bar will flash on top of a
live Video Window when an
event occurs. The color
indicates the event priority.
The bar will flash for a pre-
defined time and then remain
steady for one minute until
disappearing. An audio alert
may also sound if pre-defined.

The lightning symbol in the lower
right-hand corner indicates live video.
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■ Adjust Pan, Tilt and Zoom

This is done in one of three ways:

z Directly from within the Video Window

z Using the Camera Control Panel

z Selecting a Preset

● Using the Camera Directly from within the Video Window

Enable the controls by double-clicking on a live Video Window.

Alternatively, click the down-arrow at the base of the Video
Window (or right-click on the window). A drop-down menu
will appear. Select Get Camera Control.

If the camera is being used by the Viewers or another VB
Administration Tools associated with the Camera Server, a
“Can’t get camera control” message will appear. You may
have to wait a few moments and attempt to get control later.

Arrows will appear in the cursor position when you
have gained control of the camera. When you move
the mouse cursor over a Video Window, the mouse
cursor changes its shape. Click and drag the cursor
in the direction of the arrow for pan and tilt. When
you move the mouse cursor to the center of the
image, a zoom in or zoom out control will appear.

Hold down the mouse on “+” to zoom in.

Hold down the mouse on “-” to zoom out.

When you have finished, select Release Camera Control from the Video Window menu.

z For a VB-C50FSi and VB-C50Fi, only zoom is available.
z If a fixed camera or an external camera such as VC-C50i is

connected to VB-C50i, you cannot use pan, tilt, and zoom
operations.

Note
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z If you have camera control, you can only drag the window by
clicking and holding the title bar.

z When you have control, the camera can be controlled either by
clicking or moving the mouse while holding the left button
down. The latter method provides finer control.

z If a control warning “Control will be lost in 10 seconds.”
appears, it means you have stopped making changes for 30
seconds and a 10 second countdown commences. To continue
control, click in the Video Window, i.e. use the controls.

z You can still manipulate a camera that is currently recording.
If the recording position has been set, the Camera Server will
return to that position after the Viewer release camera control.

Tip

When using the VB-C300, you cannot use Night Mode in the
following cases:
z When Day/Night is set to Auto on the Camera and Video Settings page
z When the Night Mode is set to Auto with a recording schedule

Note

● Using the Camera Control Panel

To display, select View > Camera Control
from the menu bar, or click the Video
window menu icon (or right-click in the
Video Window) to bring up a context menu
and select Camera Control.

If a Video Window is not selected, the
preview window will be blank. Click on a
Video Window to control the camera.

Pan/Tilt controls. Click
to nudge or click and
hold for continuous
movement.

Click this button to
display exposure
control (➝ P. 186).

Click this button
to display white
balance control
(➝ P. 186).

If preset camera
angles have been
set up by your
Administrator, they
will be available from
a drop-down menu.

Set Night
Mode.

Switch On and Off of
external device
output of the camera.

Click and drag the Zoom slider to perform the
zoom operation.

You can control the pan, tilt, and zoom
operation using a panorama image. Click
inside the Panorama window to adjust the pan
and tile angles so that the clicked position
becomes the center of the image.
Alternatively, you can move or zoom in/out the
yellow scope to perform the pan, tilt, and zoom
operation.

If the digital zoom is enabled by the Camera
Server, a boundary between the optical and
digital zoom is displayed.

When the Video
Window is selected,
click Get Control.
Click Release
Control when
finished.

Click this button to display extended camera
control panel (➝ P. 187).

Clicking this button
returns the camera
to face the front.
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● Exposure Control Items (when the Exposure Mode is Auto)

● Exposure Control Items (when the Exposure Mode is Manual)

● White Balance Control Items

Set the Exposure Mode to Manual
(VB-C300 only).
Auto: Automatically adjusts the 

exposure.

Set the Exposure Mode to Auto ( VB-
C300 only).
Manual: Dragging slide bars adjust

the aperture value, shutter
speed, and gain value.

Drag each slide bar to adjust the
aperture value, shutter speed, or gain
value.

Select the White Balance mode from
the drop-down menu. The following
modes are available (VB-C300 only).
Auto: Automatically adjusts the

white balance.
fluorescent:

Select this option when using
the camera under a day-light
or white fluorescent lamp.

fluorescent H:
Select this option when using
the camera under a day-light
fluorescent lamp.

Mercury lamp:
Select this option when using the
camera under a mercury lamp.

Sodium lamp:
Select this option when using
the camera under orange
light of a sodium-vapor lamp.

Halogen lamp:
Select this option when using
the camera under a halogen
or incandescent lamp.

Manual:Drag each slide bar to adjust
each gain value (R or B gain).

To forcibly adjust the white
balance, capture a white
object (e.g., a piece of white
paper) and click One-Shot
WB.

Drag each slide bar to adjust
each gain value.

Clicking this button disables
backlight compensation.

Clicking this button enables low-
level backlight compensation.

Clicking this button enables mid-level
backlight compensation.

Clicking this button enables high-level
backlight compensation.
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● Selecting a Preset Camera Angle

If preset camera angles have been set up and stored as
presets, they will be available from the Preset drop-down
menu of the Camera Control panel or a sub-menu. The
following explains how to select a preset from a sub-menu.

Double-click a Video Window
or select Get Camera Control
from the Video Window menu.

From the Video Window menu,
click Preset Camera Angles.

Select a preset position from
the sub-menu.3

2

1

● Other items

z When you have finished, select Release Camera Control from
the active Video Window menu.

z Panorama picture needs to be set on the Camera Server in
advance. VB-C50FSi/VB-C50Fi cannot display panorama
picture.

z Exposure can be adjusted for VB-C300 only.
z White balance can be adjusted for VB-C300 only.

Note

Switch between Auto Focus and Manual Focus.
Auto: Adjust the focus automatically.
Auto (for dome housing):

When the optional dome housing is used, select this option to automatically adjust the
focus without focusing on the wall surface.

Infinity: Focus is fixed at a point of infinity.
Manual: Press and hold Far or Near button to adjust the focus. Clicking One Shot AF adjusts the

focus just once automatically (VB-C300 only).

Select from Fast and Slow for
Zoom.

Select from Fast, Normal, and
Slow for Pan and Tilt.
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■ Other Video Window Functions

Change the size of a Video Window
Apart from manually clicking on the corner and dragging out the Video Window to a new
size, you can also select a set size from the Video Window menu.

To change the display size of a Video Window via the menu:

● Open the Video Window menu and select Video Display Size.

Click the Video window menu icon, or
right-click in the Video Window to bring
up a context menu.

Select Video Display Size from the
menu, and then select Small, Medium,
Large, or Raw from the sub-menu. A
Raw selection displays the Video
Window selected at the Video Receive
Size.

2

1

Change the size of a Received Video (VB-C50i/VB-C50iR,
VB-C50FSi, VB-C50Fi only)
You can select a video size received by the Viewer. To change the size of received video
via the menu.

● Open the Video Window menu and select Video Receive Size.

Click the Video window menu icon, or
right-click in the Video Window to bring
up a context menu.

Select Video Receive Size from the
menu, and then select Small, Medium,
Large, or Default from the sub-menu.
Selecting Default displays the Video
Window in the size received from the
Camera Server.

2

1
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Enabling Backlight Compensation
Backlight compensation is a camera feature used to compensate for camera views with
strong backlighting, i.e., viewing a dark image against a strong backlight. It can be enabled
from the Video Window menu. It is not to be confused with Shade Correction.

To enable backlight compensation:

● While Camera Control is active, select Backlight Compensation.

Click menu bar of the Video window, or
right-click in the Video Window to bring
up a context menu.

Select Backlight Compensation from
the menu and select Off, or On from
the sub-menu.

2

1

You can set the backlight compensation to
Off, Low, Medium or High for VB-C300, VB-
C50i / VB-C50iR, VB-C50FSi and VB-C50Fi.

z When multiple Video Windows from a single Camera Server
are displayed and the Video Receive Size is changed from one
of them, the change will apply to all Video Windows.

z Selected video receive sizes are saved when the layout is
saved.

z The Video Receive Size used for Default is determined when
connection with Camera Server starts. Even if you change the
size from the Camera Server after the connection is made, it
will not apply.

Note

If High, Medium, or Low is selected, the tick (black dot) is not
displayed.

Note
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z It is recommended to install the Viewer and/or NC Viewer in
advance.

z The camera server which is sending or receiving audio cannot
interact with other Viewer or Admin Viewers.

z Shade Correction cannot be applied to multiple Video
Windows.

z Shade correction is performed by using image processing
within the Viewer and not on the Camera Server. It can be
used on live or recorded video (see below).

Note

Arranging Video Windows

Other Menu Options
Other functions available from the Video Window menu include:

Click Shade Correction to correct shaded areas in
the Video Window. This affects the individual Video
Window on display, i.e., any duplicate (unselected)
windows are not affected. This is discussed on the
following page.

Click Admin Viewer the WebView Livescope Viewer if the Admin Viewer or
NC Viewer is both installed. For the VB-C300, the NC Viewer is activated.
Refer to your Camera Server User’s Manual for more information on the Admin
Viewer or NC Viewer.

When the audio function of the VB-C300, VB-C50i/VB-C50iR, or VB-C50FSi is
enabled, you can transmit and receive audio. To use audio, click this menu to
display the Audio Panel (➝ P. 191). Refer to your VB-C300, VB-C50i/VB-
C50iR, or VB-C50FSi User’s Manual for more information on the audio
settings.

Click Close Window to close the Video Window that is currently selected. You can also
close a selected Video Window by pressing the Delete key.

Click Night mode and select Disabled, Enabled, IR
light off, or Enabled, IR light on from the sub-menu.
Selecting Enabled, IR light on will remove the IR cut
filter and turn the built-in IR light on. The IR light cannot
be used with the VB-C300, VB-C50FSi, or VB-C50Fi.

Click Control External Devices to control any external
devices that may be connected to your Camera Server.
This is only enabled when you have camera control.
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About Shade Correction
Shade Correction compensates darker regions of images and makes them lighter.

Correction only applies to the
displayed Video Window in the
Viewer.

Shade Correction Off Shade Correction High

Darker regions are most affected by Shade Correction.

About Audio Panel

Clicking this button after selecting a Video 
Window, or selecting a Video Window after 
clicking this button starts audio playback.

Clicking this button after selecting a Video 
Window, or selecting a Video Window after 
clicking this button starts audio 
transmission.When ticked, audio is 

played back even 
when a microphone is 
used.

Click this button to
display silent detection
control.

You cannot transmit and receive audio when using a proxy
server.

Note

When ticked, silent interval is detected
while transmitt ing audio. For a si lent
interval, network load can be mitigated by
reducing data to transmit.

Tick this option to 
detect silent intervals 
with predefined 
sensitivity.

Tick this option to manually 
specify the detection sensitivity. 
Drag the slide bar to adjust the 
detection sensitivity.
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Using the Timeline and Viewing Events

This chapter shows you how to use the Timeline for live and recorded viewing as well as
view and search events.

Timeline Overview
On the Viewing Screen, a timeline of past events associated with displayed cameras is
shown in the Timeline Area (➝ P. 148) at the bottom of the Viewer as colored bars.
Selecting a colored bar moves the playhead to the event and the associated Video
Window is switched to playback mode.

Zoom in or out of
the Timeline to see
events in more or
less detail.

Events for non-selected cameras
(Video Windows) in the Viewing Area
are called “secondary event.” They
are displayed in weaker colors than
primary events.

Click in this area of
the Playhead shaft
and drag to positions
on the Timeline.

Previous Event.

Rewind.

Nudge Back.

Play/Pause.

Nudge Forward.

Fast Forward.

Next Event.

Playback controls

Playback controls.
Buttons for playback, 
rewind, etc.

Camera Server name
The name of the 
camera currently 
selected.

Playhead region

Click to scroll forward 
hours, by days or by 
weeks.

You can save the
current image on a
Video Window in a
file.

A manual recording 
with duration of one
minute is initiated.

Darker areas indicate 
recorded video for this 
period.
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Monitoring Live Video in relation to the Timeline
When a Video Window is created from a camera thumbnail, video is seen live. The
Playhead (shown below) will be in a “live” position. The “live” position represents the
present time. The playhead remain fixed as time scrolls to the left underneath,
representing the passage of real time.

Click to search for
past events.

Click to jump to a
specified date/time.

Extract recorded video
to save as another file.

Event display area.
Day indicator.

Click to return the
Playhead to the
Live position (if it
has been moved).

Events associated with
selected cameras (Video
Windows) in the Viewing
Area are indicated in
stronger colors as primary
events.

If no cameras are selected, all events are
shown as primary events.

Note

Click the time bar and drag to
scroll through the Timeline.

Click to scroll 
forward hours, by 
days or by weeks.

You can hide the timeline by de-selecting
Timeline from the View menu.

Tip

Priorities are color-coded as follows.

Color Priority

Red Highest

Orange High

Yellow Medium

Light Green Low

Dark Green Lowest
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Using the Timeline to examine, play and extract video
You can view recorded video by moving the playhead control in the Timeline or entering a
timecode and jumping to it. Methods include:

● Use the Playback Controls

You can control to play, rewind, fast forward or jump
to previous and next events (➝ P. 192).

The fast forward and rewind speeds change by 1x,
2x, 5x and 10x each time you click the buttons.

● Drag the Playhead to a new time

Click and drag the Playhead shaft to another location. When you
move the Playhead, you are effectively controlling all Video
Windows that have been selected.

● Click in the Event Display Area of the Timeline

Click in the Event Display Area of the Timeline. The
Playhead will move to that location and playback of
recorded video commences from that time.

z When you choose to play back video, the video is played over
a network. Therefore the response and smoothness of the play
back will depend on network traffic and other properties of the
network.

z The time displayed on the Timeline is the time of PC where the
Viewer is running.

Note

Videos recorded at different times can be played back
simultaneously. First select a Video Window and move the
Playhead to start playback. Next select another Video Window
and move the Playhead to another time. This is ideal for
comparing the same or different cameras at different times.

Tip
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● Jump to time entered

Select a Video Window and click Jump to Time.

The Jump to Time dialog opens. Select a day
and/or time.

Click OK.

The Playhead and Timeline will move to the
time selected. If no Video Windows are
selected, only the timeline is moved.

Using the calendar is shown below.

3

2

1

● Click and drag the time bar to move through the Timeline...

Move your mouse pointer over the time bar and it
becomes a hand. Click and drag to the left or right
to move back or forward in time. You can only
scroll right to the current time, or “live” time.

Click to scroll back
through the months.

Click to scroll forward
through the months.

Click a day to highlight it,
then click OK to bring up
that day in the Timeline.

Click up/down arrows to
select a t ime or cl ick
each time segment and
overwrite existing value.

Alternatively, click the
current month and a
month selector wil l
appear.

To select another year, click
the current year and scroll
down or back up, using the
up/down arrows.
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Initiating a manual recording with duration of one minute
A manual recording with duration of one minute can be initiated at the maximum frame
rate. The manual recording is displayed on the Timeline and Live Events Log as Manual
Rec. username). This is handy for capturing random events not associated with sensor
recording or outside preset recording times.

To initiate manual recording:

Select a Video Window for
manual recording.

Click Record Now.
2

1

Shooting a Snapshot
Click Capture Still Frame to keep
the current image on a Video
Window.

Select a Video Window to
capture a still image.

Click Capture Still Frame.
2

1

z The Record Now function records at the maximum frame rate.
Extended recording time will use additional disk space on the
Storage Server.

z The Record Now function is only enabled if a Storage Server is
configured for the camera.

z Recording will be for approximately one minute. The actual
duration of recorded video may vary depending on settings
and network delays.

z The priority of an event created by a manual recording using
Record Now will always be Priority 1. It cannot be changed
from Event Tab.

Note
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● Click event to select it

When you click an event to
select it, the associated
Video Window will display
the event(s).

Using the Timeline and Viewing Events

Daylight Savings Indicator
The Storage Server will adjust for Daylight Savings if configured in Date and Time
property of the control panel as follows:

z When normal time has changed to Daylight Savings time, time that is skipped is
displayed in the Timeline as missing.

z When gaining time (rewinding the clock back from 02:00 to 01:00), the extra time is
duplicated.

● Zooming In and Out of the Timeline

Click Zoom In to zoom into a time period in the Event
Display Area.

Click Zoom Out to zoom out a time period in the Event
Display Area.

Where Daylight Saving changes have occurred, the Timeline
display is still continuous. Only the labels are affected.

Note

Move mouse over event to get details.

Skipped Time

Duplicated Time

Type of event Time of eventCamera Name

Click
event to
select it.

A time segment with darker color
indicates that recorded video
exists for that period.
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Using the Timeline and Viewing Events

Extracting video to save to another location
A portion of video can be saved to another location if required. Files are automatically
saved as QuickTime .mov format and can be viewed in a QuickTime player or any other
player that supports .mov files. A maximum of one hour of video can be extracted at a
time. If you do not have a QuickTime player installed, visit http://www.quicktime.com for a
free download.

● Select a Video Window and time period then click Extract Video.

Click a Video Window to highlight it, then click and drag
a time period for it in the Timeline.

Click Extract Video. The Extract Video dialog opens.

In the Date: field, click each
segment and overwrite with
desired date. Alternatively
click the down arrow to use
the calendar.

Click up/down arrows to
select a time or click each
time segment and overwrite
existing value.

Click OK to display the Save
As... dialog. The Save As dialog
opens. Browse to a suitable
folder in which to save the
extracted video, and click Save.

5

4

3

2

1

● Returning to Live Video

To return to the live video, click Return to Live ➞. The Playhead
returns to the live position in the Timeline.

z You must select only one Video Window to extract video.
z QuickTime player version 6.5.1 or later is recommended.Note
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Using the Timeline and Viewing Events

■ Viewing and Searching Events

About Live Events Log list
The Live Events Log displays events that have occurred with one or more cameras after
the Viewer has been launched. Events are color coded according to priority. The Live
Events Log opens automatically when you launch the Viewer, if left open in a previous
session of VK-64/VK-16.

Re-sizing the window to a custom size
Click the corners or edges and drag the
window out to a new size. Release the
mouse button.

When you launch the Viewer again, the
Live Events Log will retain the size
you selected.

Click and drag scroll bar to view events.

The bell icon is displayed when the event is acknowledged by double-clicking. Double-clicking
the event to acknowledge it changes the icon to a dot.

To maximize, double-click title bar or click the maximize icon.
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Using the Timeline and Viewing Events

Displaying the Live Events Log List
To display the Live Events Log List:

● Selecting Live Events from View Menu
From the VK-64/VK-16 menu bar, select View and Live Events.

Live Events Log list opens.

Once selected, the menu item will be ticked next time you display it.

Overview of Alert Parameters

● Acknowledging and Viewing Events

A new event entry will appear at the top of the Live Events Log list and will flash for a
defined period if configured. If Operator Acknowledgement is required, the event will flash
indefinitely if not acknowledged.

In the Live Events Log, double-click on the event to acknowledge it and a recorded
video at that time is displayed in its associated Video Window.

In the bottom right corner of the Viewer, click Return to Live ➝ when you have
finished viewing the event. The Video Window will return to live viewing.2

1

Only the most recent 200 events are shown in the Live Events
Log.

Note

Acknowledgement status

Priority of the event (1:Highest, 2:High, 3:Medium, 4:Low, 5:Lowest)

Event type that has occurred

Camera name where event occurred

Date and time of event

Location and Zone
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Using the Timeline and Viewing Events

Searching Events
If you have multiple events, you can initiate a search for a particular event via the Event
Search dialog.

To launch the Event Search Dialog:

● Click Event Search

On the Timeline, click Event Search.

The Event Search dialog opens.

Select a 
Location and 
Zone.

Enter a keyword for
particular events.

Enter a search end 
date and time.

Enter a search start 
date and time.

Select a 
Priority.

Select a 
state of 
event.

Select a 
type of 
event.

Search 
Result
Display Area

Double-click an event to view it in the Video Window, or click an event to
highlight it and then click View Event in Camera to view it.



202

Using the Timeline and Viewing Events

Selecting Criteria for Searching
When you initiate a search, certain criteria can be specified such as Priority, Location and
Zone on the network, a date range when the event may have occurred and a time period.

To initiate a search:

● Step 1: Select a date and time range to search

Click in the From: and To: date panels and overwrite the existing entries for
month/day/year and time.

Alternatively, click the down arrow next to each date panel
to bring up the calendar. Click off the calendar to close it
again.

In the Event Search dialog, you can also scroll through
time using the up/down arrows. Click an hours, minutes or
seconds segment to highlight it and then click the up or
down arrow.

● Step 2: Select an event keyword

In the Description: field, enter a
keyword such as, “deleting”,
“recording”, “frames”, etc. Found
events will be based on your text
entry.

● Step 3: Select a Location and Zone to search

From the Where: fields, select a
Location and Zone from the drop-
down lists. 
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Using the Timeline and Viewing Events

● Step 7: Click Search

When you have entered the day and time range, click Search to initiate the event search.
Events that are found will be listed in the window below. If necessary, stop a search at any
time by clicking Stop Search.

● Step 4: Select a type of Event

Select a type of Event from the drop-down list.

● Step 5: Select a State

Select a State for the event, whether it was On or Off during
the period. Alternatively, select All States.

● Step 6: Select a Priority

Select a Priority from the drop-down list.

Viewing found events
To view an event in a Video Window,
click the event to highlight it and click
View Event in Camera to view it in a
Video Window.

You can also double-click an event to
view it in a Video Window.

Clicking Cancel stops any searching
and closes the dialog.

When you have finished viewing an event in a Video Window,
click Return to Live ➝ in the Timeline to return the Video Window
to live viewing.Note
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Operation and Management
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This chapter explains points to notice concerning the Storage Server when you operating
and maintaining the network camera system, as well as guidelines for operating the
system.

● Health Check for Storage Server

Explains VK event display messages and required counteractions.

● Operation Guideline for Recording and Viewing

Explains frame rates for recording and live viewing via the Viewer.

● Operation Guideline for Sensor Event Recording

Explains operation tips concerning the sensor event recording, including points to notice
and counteractions against troubles.

● Optimization of Motion Detection Recording (Index)

Explains operation tips concerning the Motion Detection recording, including points to
notice and counteractions against troubles.
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VK Events (Timeline for VK Viewer)
If any of the events listed in the table below occurs, you may have to take the specified
counteraction.

The text within { } in each message depends on the situation.

Indicates the free
space on the disk

Starts and stops
deletion due to space
shortage. (*)

Pauses and resumes
recording due to
space shortage. (*)

Connection error to
the Camera Server

Recording frame rate
change

Indication (on) / recovery (off)
{Drive Name} is running out of
space: {Situation}

Start (on)/Stop (off)
Deleting files on Drive {Drive
Name} due to disk free space
shortage: {Situation}

Start (on)/Stop (off)
Recording paused due to disk
free space shortage on Drive
{Drive Name}: {Situation}

Error occurrence (on) /
recovery (off)
Connection to host ({Camera
Server Address}: {Port}):
{Situation}

Effective recording rate
({recording rate before
change} ➝{recording rate
after change} %)
Example:
Ex. “Recording rate (100.0 ›
90.0 %)”
* This is not an On/Off event.

This event occurs when the disk
free space has run under the
specified value or the used disk
space has exceeded the
specified valued. 
In this case, data may be
deleted before the designated
storage time elapses. 
Disk capacity indication is only
effective when it is on.

This event occurs when the disk
free space has run under the
threshold value or the used disk
space has exceeded the
threshold valued.

This event occurs when the disk
free space has run under the
threshold value or the used disk
space has exceeded the
threshold valued.

This event occurs when an error
has occurred while connecting
to the Camera Server. However,
it does not necessarily occur for
every connection failure. When
this event occurs, the recording
engine tries for reconnection
and a COMM error occurs if the
retry fails.

This event indicates that the
recording frame rate has been
reduced due to increased server
load.

Review the
recording and
Camera
Server settings
(➝ P. 51, P. 98).

Review the
network
connection 
(➝ P. 88).

Review the
recording
settings or
consider
adding the
Storage Server 
(➝ P. 82).

Event type Message Description Counteraction example

For the items marked with (*), refer to “Disk Space Management <Important>” (➝ P. 58).
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The following explains the automatic frame rate adjustment function for viewing and
recording.

This function checks the load of the PC on which the Storage Server and the Viewer are
running and adjusts the frame rate for video recording and live viewing.

Live-View Frame Rate Adjustment

● Auto Adjust Frame Rate in the Viewer Settings (➝ P. 157)

* This option is enabled by default (recommended).

When displaying live video, the Viewer requests the camera to send the video at the

specified frame rate (➝ Max. Live Frame Rate on P. 157).

If you use this function, you can maintain a stable display of live video with a temporarily

lowered frame rate even if your PC temporarily becomes highly loaded for some reasons.

If you do not use this function, menu operation or display response may be affected when

the load on your PC is high.

Using this function is recommended; however, make sure you
perform tests under actual conditions before starting operations.

Note
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Recording Frame Rate Adjustment

● Reduce recording frame rate when disk is under high load in the
Storage Server Configuration dialog (➝ P. 51)

* This option is enabled by default (recommended).

When the network recording software writes images received from cameras into the hard
disk, if the load (mainly the load of writing into the hard disk) of the PC on which the
Storage Server is running is too high, the software cannot write the images immediately.

If the amount of the image that is waiting to be written increases for a certain period of
time, the Storage Server considers the PC to be highly loaded. When this happens, the
Storage Server stores images at intervals rather than storing all of the images the Storage
Server received, in order to reduce the PC load.

If you use this function, you can avoid recording failure as much as possible even if your
PC temporarily becomes highly loaded for some reasons.

Note that events are generated when the network recording software starts and ends the
operation of the function (➝ P. 269, “Changing the Recording Frame Rate”). You can
check the operating status of the function via the Event Search dialog (➝ P. 201).

If you do not use this function, recording may be interrupted when the load on your PC is
high. This software cannot detect the recording interruption.
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Proper Operation of Sensor Event Recording (Optimization
of Sensor Arrangement and Sensitivity)
Frequent sensor events result in high CPU load on your PC, and the recording frame rate
may be reduced or recording may be interrupted. If you have 10 or more sensor events per
minute continuously, we recommend continuous recording.

For each Storage Server, it is recommended to lower the sensor sensitivity or use
continuous recording.

z 20,000 or more sensor events occur a day.
z 10 or more sensor events occur every minute.

Check the number of sensor events with the status bar.
Tip
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The Motion Detection recording is not suited to applications where high levels of reliability
are required. Therefore, it is recommended to use continuous recording for monitoring or
other purposes if consistently high levels of reliability are required. Canon accepts no
liability whatsoever for faults, etc. resulting from the use of the Motion Detection recording.

Frequent motion detection events result in high CPU load on your PC, and the recording
frame rate may be reduced or recording may be interrupted. If you have 10 or more motion
detection events per minute continuously, we recommend continuous recording.

Frame Rate indicates the number of frames for Motion Detection recording. Lowering this
value mitigates load on the Storage Sever.

● Motion Detection Setting for Each Camera Model

VB-C50i/VB-C50iR, VB-C50FSi, VB-C50Fi, VB150

Configure the Motion Detection settings on the Camera Server.

Please refer to the Camera Server User’s Manual for details.

For the VB150, Video Input must be set to Single.

VB-C300

Configure the Motion Detection settings on the Storage Server.

Refer to “Setting Motion Detection Recording” (➝ P. 118) for details on how to set the
Motion Detection parameters.

Typically, set the total frame rate to 150 fps (e.g., 30 fps with five cameras) with the display
resolution of QVGA.

z Longer before event recording with insufficient memory may
lead to the use of disk-based virtual memory which will greatly
reduce performance. Shorter before event recording will
reduce memory usage.

z The full requested duration of post event recording may not be
available due to data size and network delays.

Tip
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Chapter 7
Backup Scheme
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This chapter explains how to make backups for each purpose. 

Since the volume of video data the largest among various data types requiring backup, you
must carefully choose backup equipment and learn the backup techniques.
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Purpose of Backup

Purposes of backup include.

z Backup for Data Protection

Prevents data from system crush or hard disk failure. This type of back up targets video
data, event data, and configuration files.

z Backup for Archive

Stores video data and event data on other media for a long period of time.
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About Backup Device
Prepare necessary equipment for backup depending on the data quantity of the VK-64/VK-
16. Basically, you should use the DDS-4 type device if a single backup copies several
Gigabytes through 40 GB of data, and DAT72 or AIT if it copies around 70 GB of data.

Further, if backup data quantity reaches 100 through 400 GB, you should use the LTO
device. If you need more capacity or want to omit media replacement, you can consider
auto loaders for the LTO device.

z Backup Example for VK-64/VK-16

If 10 Camera Servers record video for 30 days at 1 fps (10 KB)

the required data capacity is 300 GB per month, 70 GB per week, and 10 GB per day.

In this case, it is recommended to use the LTO device (Ultrium tape device). This type
of device records 100 through several hundreds GB of data at the average transfer
speed of 25 through 30 MB/sec (or 40 through 60 MB/sec when data is compressed).

The time required for making backup of data for 30 days (300GB) is approximately
12,000 seconds (i.e., 3.5 hours). The time is shortened to approximately 2.5 hours
when data is compressed (Although the hardware specifications mention that the
transfer speed will be doubled by compressing data, the expected compression ratio
depends on data formats. Therefore, it is dangerous to think so).

The time required for making backup of data for a week (70GB) is approximately 2,800
seconds (i.e., a little longer than 46 minutes).

The time required for making backup of data for one day (10GB) is approximately 400
seconds (i.e., 6 minutes 40 seconds).

Notes: Recording does not stop while making a backup of data; however, the recording
frame rate may be reduced from the specified value due to disk I/O load and
CPU load.

About Backup Tool
It is recommended to use a third-party backup tool for Windows. Read the manual of the
tool for deployment.

About Restore Server for Archiving
If the purpose of backup is archive, you must prepare a separate PC for the Storage
Server to which data will be restored. This PC must have the same drive configuration
(e.g., hard disk configuration). For example, if the source server’s system drive is C and
data storage drive is D, and video data drive is E, you must configure the PC with the
same drive configuration. However, the hard disk capacity must be determined according
to data to restore.

Video data for VK-64/VK-16 is non-reversible compressed data.
Compression process done by tape or other devices is not
necessary.Tip
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Files to Make a Backup

Storing Location of Recorded Data and Event data
Video data being recorded is saved in a temporary file (refer to “About Temporary File”
below), and the file is settled and saved as video data when its size reaches 1 GB (by
default) to the storage drive. 

The recorded video data and event data are saved in the following folders according to
your settings for Save video in and Drive when you register Camera Servers 
(➝ P. 92).

● Recorded Video data

Save video in: \WebView-NVR\videofiles

The following two file types are backed up:

File name =

NVR_INDEX_xxxxxxxxxxxxxxxx_yyyymmdd_hhmmss_yyyymmdd_hhmmss.mov
Camera ID        Recording start date_time Recording end date_time

File name =
NVR_MEDIA_xxxxxxxxxxxxxxxx_yyyymmdd_hhmmss_yyyymmdd_hhmmss.avi

z About Temporary File

File name = NVR_STANDBY_MEDIA_xxxxxxxxxxxxxxxx_yyyymmdd_hhmmss.avi

File name = NVR_STANDBY_MEDIA_xxxxxxxxxxxxxxxx_yyyymmdd_hhmmss.avi.tmp

File name = NVR_STANDBY_MEDIA_xxxxxxxxxxxxxxxx_yyyymmdd_hhmmss.mov

These three files are not yet settled by the system. 

z Recorded Data Concept

Video data being recorded is saved in a temporary file, and the file is settled and saved as
video data when its size reaches 1 GB (by default) to the storage drive. This recording unit
can be changed in the Maximum file size/duration field, in the Storage Server
Configuration window’s Settings tab (➝ P. 51).

Temporary files cannot be backed up in the normal procedure.

These two files are used in pairs. Be sure to back up both files.
Note

The recorded video data file name contains the Greenwich Mean
Time as the time stamp. 

Tip
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● Event data

Save video in: \WebView-NVR\eventfiles

The following file types are backed up:

File name = NVR_EVENT_xxxxxxxxxxxxxxxx_yyyymmdd_hhmmss.evt
Camera ID       Recording start date_time

● Configuration files

The configuration files for the Storage Server and Viewer are saved in the following folders
of the PC where each program is installed.

<System Drive>:\Documents and Settings\All Users\Application Data\Canon
\WebView\NVR\

Back up the entire contents of this folder. 

NVR_STANDBY_MEDIA_xxxxxxxxxxxxxxxx_yyyymmdd_hhmmss.avi

NVR_STANDBY_MEDIA_xxxxxxxxxxxxxxxx_yyyymmdd_hhmmss.avi.tmp

NVR_STANDBY_MEDIA_xxxxxxxxxxxxxxxx_yyyymmdd_hhmmss.mov

NVR_EVENT_xxxxxxxxxxxxxxxx_yyyymmdd_hhmmss.evt

NVR_INDEX_xxxxxxxxxxxxxxxx_yyyymmdd_hhmmss_yyyymmdd_hhmmss.mov

NVR_MEDIA_xxxxxxxxxxxxxxxx_yyyymmdd_hhmmss_yyyymmdd_hhmmss.avi

NVR_EVENT_xxxxxxxxxxxxxxxx_yyyymmdd_hhmmss.evt 

Recording

Recorded video data (after settled)

The recorded event data file name contains the Greenwich Mean
Time as the time stamp. 

Tip

The configuration file names do not appear if the “Show hidden
files” is not checked under the Windows Folder Option.

Tip
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Backup for Data Protection

About Backup
When making a backup of data for protection, you must back up the following data:

z Recorded video data ---- It is recommended to make an incremental backup of this data.
Refer to P. 217 for the file names and storage location.

z Event data ----------------- It is recommended to make an incremental backup of this data.
Refer to P. 218 for the file names and storage location.

z Configuration file --------- Usually, make a backup of the configuration file when the
system is installed, and do it again each time you change the
settings of the VK-64/VK-16. However, if doing so makes
management complicated, you can perform a full backup every
day. Refer to P. 218 for the storage location.

● Notes on Backing Up Recorded Video Data

Video data being recorded is saved in a temporary file. The temporary file cannot be
backed up in the normal procedure.  Refer to “Recorded Video Data” (➝ P. 217) for
details. 

The temporary file cannot be backed up until it is converted into video data. 

You should choose the backup hardware best suited for the backup data quantity.
Basically, you should use the DDS type device if a single backup copies 1 through 10 GB
of data, and AIT device if it copies 10 GB through 100 GB of data, and LTO device if it
copies 100 through 400 GB of data. If you need more capacity, you need to consider
multiple backup devices. Also, it is recommended to use a backup device with a high data
transfer rate.

If the total capacity of the hard disk reaches several terabytes, you should rather consider,
than making backups, using hot-spare hard disks or highly reliable storage system, or
further reliable and available RAID system.
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Backup for Archiving (Long-Term Storage of Data)

When making a backup of data for long-term archive, you must back up the following data:

z Recorded video data ---- It is recommended to make an incremental backup of this data.
Refer to P. 217 for the file names and storage location.

z Event data ----------------- It is recommended to make an incremental backup of this data.
Refer to P. 218 for the file names and storage location.

z Configuration file --------- Usually, make a backup of the configuration file when the
system is installed, and do it again each time you change the
settings of the VK-64/VK-16. However, if doing so makes
management complicated, you can perform a full backup every
day. Refer to P. 218 for the storage location.

● Notes on Backing Up Recorded Video Data

Video data being recorded is saved in a temporary file, and the file is settled and saved as
video data when its size reaches 1 GB (by default) to the storage drive.  The temporary file
cannot be backed up in the normal procedure. Therefore, backup only the settled files.
Refer to “Backup for Data Protection” (➝ P. 219) for details. 

When choosing the backup device, consider the backup unit.  For example, if the backup
unit is 100 through 400 GB, use a high-density tape device called “LTO device”. If it is
around 2TB (far beyond 400 GB), consider LTO auto loader device.
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Backup Procedure for Video Data and Event Data

Back Up Video Data and Event Data.

Estimate the total quantity of recorded video data for backup.

The video data quantity per day can be calculated as: Image file size per frame x
Frame rate x Number of Camera Servers x Recording time (seconds) per day. 

Refer to “Server Sizing Concept” (➝ P. 29) for details.

Prepare the backup device and backup tool for Windows according to the estimated
quantity.

Set up the backup tool as directed on P. 219 and P. 220.

Be sure to exclude the temporary files from the backup target.
3

2

1

If the VK-64/VK-16 continues recording video while making a
backup, you must take into account the increased I/O load on the
hard disk due to data transfer to the backup device. If the
recording frame rate of the Storage Server is reduced by
performing the backup, consider the following:
z Lower the recording frame rate during backup in the

Recording Schedule Setting window.
z Establish multiple I/O channels (e.g., RAID cards) on the

Storage Servers to deploy multi-storage configuration and
distribute the recorded video data among servers. Choose a
backup device according to the storage configuration.

z Use multiple Storage Servers and use a dedicated backup
device for each server. Refer to P. 28 for how to use multiple
Storage Servers.

Note
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Restore Procedure

Restoring Data from Backup for Data Protection
The following explains how to reconstruct the Storage Server for the VK-64/VK-16 for
maintenance or recovery from a failure.

Check that the PC hardware environment has been restored to the former state.
Be sure to use the same folder organization as before.

Install the VK-64/VK-16.

After installation completes, stop the Storage Server from the Storage Server
Configuration window.

Restore the VK-64/VK-16’s configuration file to the former location. 
The default location is as follows:

<System Drive>: \Documents and Settings\All Users\Application Data\Canon\
WebView\NVR\

Restore the recorded video data file to the former location.
The default location is as follows:

<Save video in>: \WebView-NVR\videofiles

Restore the event data file to the former location.
The default location is as follows:

<Save video in>: \WebView-NVR\eventfiles

Start the Storage Server from the Storage Server Configuration window.

Check that the recording operation is performed correctly. Also check that restored
video data is played back correctly.8

7

6

5

4

3

2

1

If the Maximum retained history setting is used in the Storage
Server Configuration window and the restored video data
contains data exceeding the retaining period, that data will be
deleted when the Storage Server starts.

Note



Restore Procedure

223

7

B
acku

p
S

ch
em

e

Restoring Data from Backup for Data Archiving
The following explains how to restore only necessary files from the data backup for
archive.

Check that the drive configuration of the PC to which the files are restored is the
same as the PC from which the files were backed up.

Be sure that the hard disk has a capacity larger than the total size of the video data
files to restore.

Install the VK-64/VK-16.

Restore the VK-64/VK-16’s configuration file to the former location. The default
location is as follows:

<System Drive>: \Documents and Settings\All Users\Application Data \Canon\
WebView\NVR\

Uncheck the Maximum retained history option in the Storage Server Configuration
window.

Launch the Viewer and delete all the schedules for all the Camera Servers in the
Recording Schedule tab under the Settings screen.

After deleting schedules, stop the Storage Server from the Storage Server
Configuration window.

Restore video data files matching the date and time you want to play back to the
former location. The default location is as follows:

<Save video in>: \WebView-NVR\videofiles

Restore event data files matching the date and time you want to play back to the
former location. The default location is as follows:

<Save video in>: \WebView-NVR\eventfiles

Start the Storage Server from the Storage Server Configuration window.

Also check that restored video data is played back correctly.
10

9

8

7

6

5

4

3

2

1
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● Notes on Restoring Data from Backup for Data Archiving

z Restoring the configuration file also restores the old recording setting information. After
restoration, the PC may start recording video according to the old recording schedule. If
you do not want to record video, delete the recording schedules after restoration.

z If the Maximum retained history setting is used on the Storage Server, uncheck this
option. If this option is enabled, the past data may be lost.
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Examples

Configuration 1: Backup for Data Protection 1

Premise

5 VB-C50i

Recording condition

Frame rate is 1 fps (one frame per second), Camera Server video quality is 50, resolution
is 320x240, the size for one image data is 15 KB.

The Maximum file size/duration option in the Storage Server Configuration window is
set to six hours.

Under this condition, the video file size per Camera Server per day is 310 MB x 4 files. 

Therefore, the video data quantity per Camera Server per day is 1.25 GB and 6.25 GB for
five Camera Servers.

Hardware requirement

6.25 GB per day x 30 days = 190 GB Hard disk capacity of around 240 GB is required.

If the storage period of video data on the Storage Server is 30 days, an archive backup for
1-week data can be saved on 50-GB tape with an AIT drive. To save 30-day data on a
single cassette of tape, a 200-GB LTO drive is necessary.

Configuration 2: Backup for Data Protection 2

Premise

10 VB-C50i

Recording condition

Frame rate is 1 fps (one frame per second), Camera Server video quality is 50, resolution
is 320x240, and the size for one image data is 15 KB.

The Maximum file size/duration option in the Storage Server Configuration window is
set to six hours.

Under this condition, the video file size per Camera Server per day is 310 MB x 4 files.

Therefore, the video data quantity per Camera Server per day is 1.25 GB and 12.5 GB for
ten Camera Servers.
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Hardware requirement

12.5 GB per day x 30 days = 375 GB Hard disk capacity of around 450 GB is required.

If the storage period of video data on the Storage Server is 30 days, and the required
archive period is 180 days, an archive backup for 1-week data can be saved on 100-GB
tape with an LTO drive (Ultrium). If you use a 400-GB LTO drive, you can save 30-day
data on a single cassette of tape.

Configuration 3: Backup for Data Archiving

Premise

5 VB-C50i

Recording condition

Frame rate is 1 fps (one frame per second), Camera Server video quality is 50, resolution
is 320x240, and the size for one image data is 15 KB.

The Maximum file size/duration option in the Storage Server Configuration window is
set to six hours.

Under this condition, the video file size per Camera Server per day is 310 MB x 4 files.

Therefore, the video data quantity per Camera Server per day is 1.25 GB and 6.25 GB for
five Camera Servers.

Hardware requirement

6.25 GB per day x 30 days = 190 GB Hard disk capacity of around 240 GB is required.

If the storage period of video data on the Storage Server is 30 days, and the required
archive period is 180 days, an archive backup for 1-week data can be saved on 50-GB
tape with an AIT drive. If you use a 100-GB LTO drive, you can save 1-week backup data.

However, if the tape capacity for archive is too large, it takes too long to find desired data
to restore.
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Configuration 4: Backup from Multiple Storage Servers
(Backup for Data Protection)

Premise

100 VB-C50i

Recording condition

Frame rate is 1 fps (one frame per second), Camera Server video quality is 50, resolution
is 320x240, and the size for one image data is 15 KB.

Twenty Camera Servers are registered in five Storage Servers to record video. 

The Maximum file size/duration option in the Storage Server Configuration window is
set to six hours.

Under this condition, the video file size per Camera Server per day is 310 MB x 4 files.

Therefore, the video data quantity per Camera Server per day is 1.25 GB and 25 GB for
twenty Camera Servers.

Hardware requirement

25 GB per day x 30 days = 750 GB Ten servers is required (for each Hard disk
capacity of 900 GB or more).

In this case, it is ideal to prepare one backup device for each server for backup. If you use
a 400-GB LTO drive, you can save 2-week data on a single cassette of tape. Alternatively,
you can prepare two or three servers dedicated for backup, and use network backup for
central management.
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This chapter describes upgrading and reinstalling of VK-64/VK-16 as well as how to
restore previous versions of these software components. It also describes how to update
the Camera Firmware.
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Upgrading VK-64/VK-16

This section describes how to upgrade previous versions of VK-64/VK-16.

● Upgrading from Version1.0

Obtain the released version of v1.3 (you cannot use the upgrade program).

Back up the following folders that are in the Storage Server of v1.0.

<Installation folder for VK-64> \NVR\1.0\conf

<<Example>> C:\Program Files\Canon\Webview\NVR\1.0\conf

<All drives> :\WebView-NVR”

Please note that the capacity of this folder is large.

Install the new version.

If a failure occurs, restore the previous version by following “Procedure for Restoring
Previous Version” (➝ p. 233).

● Upgrading from Version 1.1 and 1.2

Obtains the v1.3 upgrade program (free program).

Available from: canon.com/webview

Back up the following folders that are in the Storage Servers of v1.1 and v1.2.

<Startup drive for OS> :\Documents and Settings\All Users\Application Data\
Canon\Webview\NVR

<All drives> :\WebView-NVR”

Install the new version by following the upgrade procedure described at our
WebView Product web page.

If a failure occurs, restore the previous version by following “Procedure for Restoring
Previous Version” (➝ p. 233).

3

2

1

3

2

1
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Reinstalling VK-64/VK-16

You cannot reinstall the software if you use the upgrade program.

When You Have the Released Version

Uninstall v1.3.

Obtains the v1.3 upgrade program (free program).

Available from: canon.com/webview

Back up the following folders that are in the Storage Servers of v1.1 and v1.2.

<Startup drive for OS>: \Documents and Settings\All Users\Application Data\
Canon\Webview\NVR

<All drives> :\WebView-NVR

Install the new version by following the upgrade procedure described at our
WebView Product web page.

If a failure occurs, restore the previous version by following “Procedure for Restoring
Previous Version” (➝ p. 233).

When You Do Not Have the Released Version 1.3

Uninstall v1.3.

Install the previous version.

Execute the v1.3 upgrade program.
3

2

1

4

3

2

1

When You Want to Perform the Full New Installation
If you have removed the application from Add or Remove
Programs in the Control Panel, the application folder, including
its setting files and recorded data, remains undeleted. To delete
all these files, delete all the following folders.
z <System drive> :\Program Files\Canon\Webview\NVR
z <System drive> :\Webview-NVR (storage folder for recorded

and event data)
z <System drive> :\Documents and Settings\All Users\

Application Data\Canon\WebView\NVR (storage folder for
setting files)

Tip
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Procedure for Restoring Previous Version

Required Media and Data
Make sure that you have the installation CD, patch installer and backed-up data for the
previous version.

Remove Canon Network Video Recorder VK Series v1.3 from Add or Remove
Programs in Control Panel.

Delete the following folders.

<Startup drive for OS>: \Documents and Settings\All Users\Application Data\
Canon\Webview\NVR

<All drives> :\WebView-NVR

Install the previous version by using the installation CD and patch installer for the
previous version.

Stop the Storage Server in the Storage Server configuration.

Quit the Viewer.

Replace the existing folders with the following backed-up data.

Restoring Version 1.1 and 1.2

<Startup drive for OS>: \Documents and Settings\All Users\Application
Data\Canon\Webview\NVR

Restoring Version 1.0

<Installation folder for VK-64/VK-1> \NVR\1.0\conf

<<Example>> C:\Program Files\Canon\WebView\NVR\1.0\conf 

Replace Start the Storage Server.
6

5
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Updating Camera Firmware

The information concerning firmware can be obtained for free on the following Canon Web
site: canon.com/webview

Procedure for Updating Camera Firmware (VB-C50 series)
To update firmware:

Obtain the latest firmware including the firmware update tool as well as backup and
restore tools for configured values.

Save the values configured in the Camera Server by using the backup tool for
configured values.

Perform the Firmware update by using the firmware update tool.

If a failure occurs in step 3, restore the settings by using the restore tool for
configured values.

canon.com/webview

3

2

1
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Overview of This Chapter

236

This chapter explains the chart of countermeasures against failures, measures to be taken
when a trouble occurs (troubleshooting), error messages, and log files.



When a recording trouble occurs when playing back recorded vide data (e.g., data is not
found), you can guess the cause by checking the Event Logs of the VK-64/VK-16 and
Storage Server Log (re_log) .
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Troubleshooting for Recording

Event

Connection to
<Camera Server’s IP
address> error: Error
occurred (<Error No.>:
<Description>)
Ex. Connection to
192.168.100.1 error:
Error occurred (10060:
Connection time-out) 

Effective recording
rate (<Recording rate
before change> ➝
<Recording rate after
change> %) 
Ex. Effective recording
rate (100➝90.0%)

N/A

N/A

N/A

Recording to E:\drive is on
standby due to shortage
of free HDD space.

Storage Server

ERROR (connect) : socket type=
(IMAGE/EVENT/COMMAND),
cameraserver= (<host>:<port>)
win32_error= (<Winsock Error
Code>:<Error Message>)

Camera <camera> Effective recording
rate (y%->z%) 

If the following message is also
recorded, a large amount of captured
data may have been discarded:

· Camera <camera>: <x>/<y> frames
discarded due to busy frame queue in
last 1 minutes.

Camera <camera>: <x>/<y> frames
discarded due to busy drive thread in
last 1 minutes.

Camera <camera>: <x>/<y> frames
discarded due to busy frame queue in
last 1 minutes.

Error writing frame for camera <camera>:
<error message>

If the following messages are also
recorded, a large amount of captured
data may have been discarded:

· Camera <camera>: <x>/<y> frames
discarded due to busy frame queue in
last 1 minutes.
· Camera <camera>: <x>/<y> frames
discarded due to busy drive thread in
last 1 minutes.

No Storage Server Log

Cause

Error No.

10050

The effective recording rate is too low
(below 50 %).
· Sensor and motion detection events
occur too frequently, exceeding the
standard given by the guideline.
· CPU load of the Storage Server PC
may be high.

Load due to writing recorded video
data onto HDD may be too high.

CPU load of the Storage Server PC
may be too high.

· The specified drive may be unable to
be written.
· The time setting of the VK-64/VK-16
Storage Server PC may have been
changed to the past (in the NTP
operation environment).

Load due to writing recorded video
data onto HDD may be too high.

Description

Network may be out
of service.
A Camera Server’s
network problem or
session
disconnection due to
Camera Server’s
reboot has occurred.

10054

10060

10061

10064

Countermeasure

Check the network (HUB, cables,
etc.) for any problem and confirm
that the Camera Server is
operating normally.

· Adjust the recording schedule and
sensitivity of motion detection.
· Check the CPU usage and
terminate any applications which
are putting heavy loads to the CPU.

Use the Windows’ Performance
Monitor to check the writing status of
HDD. Review the recording
schedule or add servers as required.

· Use the Task Manager to find out
the application causing the problem.
· If the VK-64/VK-16 module
(AE.EXE) is causing the problem,
the event generation frequency
may be too high. Try the following:
- Shorten the Maximum retained
history setting for the recorded data
- Reduce the number of events to
generate
- Add servers to distribute the load.

· Check the drive for recording
video data.
· If you are using NTP to adjust time,
shorten the synchronization interval
with NTP (e.g., 7 days ➝ 1 day).

Shorten the Maximum retained
history or add HDD. Also, review
the recording schedule.

Log
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VK Troubleshooting

Viewing Screen and Video Windows
This section describes how to solve problems that may occur when you are using VK-
64/VK-16.

z Some of the thumbnails are not showing in the Camera Selection Area.

Situation You do not have enough thumbnails on display to make the scrollbar appear,
but some of the thumbnails that were displayed before are no longer shown.

Solution Most likely you have selected another Zone or Location from the drop-down
menu that is further down the list and the thumbnails have been scrolled to the
left to show the selected Zone (➝ P. 148). Check the selected Location and
Zone.

z Cannot Pan, Tilt or Zoom a Camera Server in a Video Window.

Situation You have clicked a Video Window to get Camera Server control, but the shape
of the mouse cursor is not changed to operate the Camera Server.

Solution Double-click the Video Window or select Get Camera Control from the Video
Window menu (➝ P. 184). Alternatively, check whether recorded video is not
being played. If video is being played, the title bar of the Video Window will be
gray, not black (➝ P. 183).

z The Record Now feature is gray and disabled in one Video Window menu, however it is
enabled in other Video Window menus.

Situation You have clicked a Video Window to display a Video Window menu and
Record Now is gray (disabled). However, other Video Windows have the
function enabled.

Solution Check if a Camera Server in the Video Window has the setting that disables
recording (when the Camera Server was configured, Do not Record was
selected).

z Layouts set up by another user cannot be seen.

Situation In the Organize Layouts & Layout Sequences dialog, you have clicked in
the Personal Layouts folder in order to open a Layout created by another
user.

Solution Layouts saved in the Personal Layouts folder cannot be seen by other users.
To show a created Layout to all users, it should be created by a user with
Administrator privileges and saved to the Shared Layouts folder (➝ P. 162).
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VK Troubleshooting

z Live and recorded video is not good quality (this does not relate to Resolution).

Situation In a Video Window, the live video quality is lower than that of another Video
Window and recorded video (when you play back video) is also not good
quality.

Solution The quality of live and recorded video cannot be changed in VK-64/VK-16. The
video quality may vary from one Video Window to another because of Camera
Server settings. The quality can be changed to a higher one in the admin
screens of Camera Servers.

z Recording cannot be performed.

Situation1) Recording cannot be performed by all of the network cameras.

Situation2) Recording cannot be performed by a certain network camera.

Solution In the case of 1), check the following:

• The network cable of the server is plugged in.

• The power has not gone down.

• Do not Record is not specified in the Special Day Schedule settings and
others.

• Link lamps on the hub (switch) and on the network connector for the server
are on.
➝If the lamps are off, there may be defects in the cable, hub (switch), or

network connector for the server.

In the case of 2), check the following:

• The power source of the Camera Server and the network have no problem.

• The ping command succeeds for the network camera.

• You can view live video of the Camera Server by using a PC Viewer or NC
Viewer and others.

• Do not Record is not specified in the Special Day Schedule settings and
others.

• Sensor recording or motion detection recording is not set.
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VK Troubleshooting

z Cannot log into a Storage Server from a Viewer.

Situation You cannot log into a Storage Server from a Viewer.

Solution Check the following:

• The login user name and password are correct.

• The network between the server and the Viewer has no problem.

• The IP address of the server to which you want to login is correct.

• The ping command succeeds for the server from the Viewer.

• When the proxy is configured in Internet Explorer, change the settings to
exclude the VK server.

z Cannot view live video.

Situation You cannot view live video.

Solution Check the following:

• If “Could not connect to camera” is displayed in the Video Window, check
whether the power source of the Camera Server and the network have no
problem.

• An error is displayed in the Timeline in the Viewer.

➝ If “Connect to <Camera Server IP Address>: Error Occurred” is displayed,
check whether the power source of the Camera Server and the network
have no problem.

• The screen goes black when layout is switched, but video is displayed after
a few seconds.

➝ Too many Camera Servers that exceed the performance of your PC are
displayed in the Viewer, or a live frame rate that exceeds the performance
of your PC is set. Reduce the number of Camera Servers to be displayed,
or decrease the live frame rate.

z When a layout sequence is running in the Viewer, the Video Window suddenly goes
black and video of the Camera Server cannot be displayed.

Situation When a layout sequence is running, the Video Window goes black and video
of the Camera Server cannot be displayed.

Solution When many Camera Servers are placed in one layout and a layout sequence
is run in a short time, system resources required for communication may run
short. Reduce the number of Camera Servers to be displayed in a layout, or
make the switching interval for layout sequences longer.
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VK Troubleshooting

z Viewer operation seems to slow down.

Situation Viewer operation slows down.

Solution The performance of a Viewer depends largely on CPU specifications and
graphics specifications of the PC on which the Viewer is installed. When
Viewer operation slows down, try to reduce the number of Camera Servers to
be displayed or decrease a live frame rate. If the video quality of Camera
Servers is set high or the resolution is set to VGA, processing may take a long
time because the size of image data is large. In this case, review the video
quality or video size in the Camera Server settings.

Timeline
z The Playback controls are inactive.

Situation You have clicked any of the Playback controls but nothing happens.

Solution Move the Playhead away from the Live position. Playback controls will then be
active. A Video Window needs to be selected for playback. Also, the nudge
buttons (➝ P. 194) and the Extract Video button (➝ P. 198) are enabled only
when one Video Window is selected.

Extracting Video
z Cannot save video as no data could be found.

Situation You have attempted to extract video, but an error message appears stating
that no video can be found in the selected segment.

Solution Check that the selected segment of video has recorded footage (➝ P. 192).

Scheduling and Recording
z Cannot initiate Record Now on a camera.

Situation You have selected a Video Window to initiate Record Now, but the menu
option is not available.

Solution In the Edit Camera Server dialog of the Configuration and Preferences
screen, Do not Record is probably set for the Camera Server. Change the
option to enable recording to the Storage Server (➝ P. 89).
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z Cannot configure the Camera Server not to record.

Situation You have attempted to modify the Camera Server and set Do not Record in
the Edit Camera Server dialog. A message appears stating that the Camera
Server is already set up without recording settings.

Solution In the Camera Server list displayed on the Locations/Zones tab of the
Storage and Camera Server Summary screen, the selected Camera Server
probably has more than one listing. Click the listing which has an associated
Storage Server listed beside it and then click Remove Camera Server. Make
sure you save your changes to permanently remove the deleted Camera
Server.

z Storage Server free disk space is extremely low.

Situation Storage Server disk usage is far in excess of the calculated level (➝ P. 58)
and there is little free space.

Solution When the Camera Server video quality is set high, there is a large amount of
data per frame. Also, if you are using anti-virus software, communication
between Storage Servers and Camera Servers is being recorded and that file
may be several gigabytes in size. Please alter the anti-virus software settings
to eliminate Storage Servers from virus scanning targets.

Connection Issues
z Cannot connect to a Camera Server.

Situation In the Viewer the screen has gone black and a message appears stating
“Could not connect to camera”.

Solution Check whether the network is down, whether the physical connection to the
Camera Server is broken, or whether the camera is not powered.

z Cannot connect to a Master Storage Server.

Situation You have attempted to launch the Viewer and a connection to the Master
Storage Server error message appears.

Solution Check whether the specified Master Storage Server works properly. On the
Storage Server computer, open the Storage Server Configuration utility. If
the Storage Server is not running, click Start Storage Server (➝ P. 55).
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z The Configuration and Preferences screen takes a long time to open.

Situation When you switch from the Viewing Screen to the Configuration and
Preferences screen, a message “Please wait...” appears and remains on
screen for a while.

Solution Check whether you do not have a lot of Camera Servers to disconnect.
Waiting time is dependent on the time required for disconnecting from each
Camera Server on the network. It is recommended that you remove non-
essential or low priority Camera Servers from your Viewing Screen.

z Fails to connect to Storage Servers when switching to the Configuration and
Preferences screen.

Situation You have attempted to switch to the Configuration and Preferences screen
and an error message appears stating a failure to connect to a particular
Storage Server (name), although it can still connect to the Master Storage
Server.

Solution Check whether the specified Storage Server works properly. A network error
may have caused this situation.

Configuration Issues
z Cannot switch to the Configuration and Preferences screen.

Situation You have attempted to switch from the Viewing Screen to the Configuration
and Preferences screen and an error message appears.

Solution Only Administrators can access the Configuration and Preferences screen.
Check whether you have Administrator privileges.

z Camera Servers are not displayed in the Camera Summary window.

Situation In the list of Camera Servers on the Camera Summary window, some of the
Camera Servers are not displayed.

Solution Only Camera Servers associated with the item selected on the Storage
Server tab or the Locations/Zones tab will be shown in the list. Also, if you
have the Storage Server tab displayed, Camera Servers configured as Do
not Record will not be shown.

VK Troubleshooting
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Messages Cause

Event
notification

List of Messages

Operation Messages and Error Messages
Error messages and operation messages displayed during normal recording and operation
of VK-64/VK-16 are shown below.

Storage Server Configuration Error Messages

The address of the recipient
contains an invalid character.

Specify the address of the recipient.

The address of the sender contains
an invalid character.

Specify the address of the sender.

The host name of the SMTP server
contains an invalid character.

Specify the host name of the SMTP
server.

Specify the port of the SMTP server
using a number in the range of 1 to
65535.

Specify the user name using 1 - 100
characters.

The user name contains an invalid
character.

Specify the password using 1 - 20
characters.

The password contains an invalid
character.

A character other than alphanumeric
characters and underscore (_) was
entered in the address of the recipient.

The address of the recipient was not
entered.

A character other than alphanumeric
characters and underscore (_) was
entered in the address of the sender.

The address of the sender was not
entered.

The host name of the SMTP server
contains an invalid character.

The host name of the SMTP server
was not entered.

The port number of an invalid SMTP
server was used.

The user name was out of the valid
number of characters range (This
includes when the user name was
not entered).

An invalid character was entered in
the user name.

The password was out of the valid
number of characters range (This
includes when the password was not
entered).

An invalid character was entered in
the password. Only alphanumeric
characters and underscore (_) can be
used.
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Messages Cause

List of Messages

Event
notification

User
management

Configuration

The host name of the POP server
contains an invalid character.

Specify the host name of the POP
server.

Specify the port of the POP server
using a number in the range of 1 to
65535.

This user name cannot be used
because it already exists.

The user name contains an invalid
character.

The password contains an invalid
character. Only alphanumeric
characters and underscore (_) can
be used. 

The password (confirmation) does
not match. 

Are you sure you want to delete this
user?

Specify the Storage Server name
using 1 - 20 characters.

Specify the host name of the proxy
server. 

The host name of the proxy server
contains an invalid character.

Specify the port of the proxy server
using a number in the range of 1 to
65535.

An invalid character was entered in
the host name of the POP server.

The host name of the POP server
was not entered.

The port number of an invalid POP
server was used.

An attempt was made to add a user
in the Storage Server by using a user
name that is already registered. 

An attempt was made to add a user
by entering a user name that
contains a character other than
alphanumeric characters and
underscore (_).

An attempt was made to add a user
by entering a password that contains
a character other than alphanumeric
characters and underscore (_).

An attempt was made to add a user
by entering a password in the
Confirm Password field, which does
not match the entered password.

An attempt was made to delete the
user. 

The Storage Server name was out of
the valid number of characters range
(This includes when the Storage
Server name was not entered).

The host name of the proxy server
was not entered.

The host name of an invalid proxy
server was used.

The port number of an invalid proxy
server was used.
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Messages Cause

List of Messages

Configuration

When exiting the
application or
approving the
change in all tabs

Specify the maximum retention
period.

Specify one or more days for the
maximum retention period.

Specify the maximum file
size/duration.

Specify 1024MB or less for the
maximum file size.

Specify 32MB or more for the
maximum file size.

Specify 24 hours or less for the
maximum file duration.

Specify 1 hour or longer for the
maximum file duration.

Specify the maximum disk space
used.

Specify 32MB or more for the
maximum disk space used.

Specify the notification settings for
the low disk space warning level.

An error occurred in the
configuration file

An error occurred while writing the
user file

When you change the retention period,
the recorded video may be deleted.
Are you sure you want to continue?

The value of the maximum retention
period was not entered.

An attempt was made to configure
the maximum retention period using
a value of less than 1 day.

The value of the maximum file
size/duration was not entered.

An attempt was made to configure
the maximum file size using a value
larger than 1024MB.

An attempt was made to configure
the maximum file size using a value
less than 32MB.

An attempt was made to configure
the maximum file duration using a
value larger than 24 hours.

An attempt was made to configure
the maximum file size using a value
less than 1 hour.

The value of the maximum disk
space used was not entered.

An attempt was made to configure
the maximum disk space used using
a value less than 32MB.

The value of the low disk space
warning level was not entered.

An error occurred while saving the
Storage Server settings.

An error occurred while saving the
user management information (the
users.txt file).

The maximum retention period was
changed to a shorter period.



247

9

Tro
u

b
lesh

o
o

tin
g

Registering
Storage Servers
and Camera
Servers

Another Add
Camera Server
dialog

Saving/Managing
Video Layouts

List of Messages

Are you sure you want to delete this
camera server ‘camera server
name’?

All schedules configured for the
‘camera number’ will be deleted.
Select “Yes” to continue, or select
“No” to cancel. 

A layout with the same name is
already registered. Are you sure
you want to overwrite?

Are you sure you want to delete the
following layout?
‘Layout name’

Are you sure you want to delete the
following folder with the layouts in
the folder?
‘Folder name’

An attempt was made to delete the
camera server.

When you attempted to edit the
VB150 settings, it was detected that
the camera configuration has been
changed on the VB150 side and the
camera for which the schedule was
configured no longer exists.

An attempt was made to save the
current layout using the same name
as a layout that already exists.

An attempt was made to delete the
layout.

An attempt was made to delete the
layout folder.

Messages Cause

Confirmation Messages of Viewer

The ‘  ’ part of the message differs depending on the situation. 

When exiting the
application or
approving the
change in all tabs

All tabs

Are you sure you want to save the
changes?

Initialization of network
communication failed. 

An attempt was made to exit the
application without saving the setting
change.

Communication initialization was
interfered with due to an internal
program or OS error that occurred
when the Storage Server installation
was activated.

Messages Cause
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An attempt was made to start the
Viewer, however a connection to the
specified Master Storage Server
could not be established.

An attempt was made by a user
without the administrator privilege to
switch to the Configuration window. 

A connection to a Storage Server
other than the Master Storage Server
failed when you accessed the
Configuration and Preferences
screen.

An attempt was made to save the
changes in the Camera Server list in
the Configuration and Preferences
screen, however a connection to the
Storage Server could not be
established.

An attempt was made to save the
changes in the Camera Server list,
however another administrator has
conducted changes.

Another administrator changed the
Master Storage Server settings while
the Camera Server list was
displayed. 

An attempt was made to register a
Storage Server by specifying a loop
back host/address (“local host”,
“127.0.0.1” or
“localhostlocaldomain”). 

An attempt was made to add a
Storage Server that has been already
registered.

An attempt was made to edit the
Master Storage Server.

Connection to the Master Storage
Server failed. Check the settings
and try again.

The configuration window can only
be used by administrators.

The recording settings of the
camera server cannot be configured
for this Storage Server ‘Storage
Server name’.
‘Cause of the error’

The changes cannot be saved
because it cannot be sent to
‘Storage Server name’.

The changes to the thumbnail,
location and zone were not saved
because the Master Storage Server
settings have been changed by
another administrator. Restart the
Viewer.

The Master Storage Server settings
have been changed by another
administrator. Restart the Viewer.

This host name or IP address
cannot be specified.

This Storage Server is already
registered. Check the settings and
try again.

The Master Storage Server cannot
be changed here.

Starting the
Viewer

Configuration
and Preferences
screen

Adding/Editing/
Deleting the
Storage Server

List of Messages

Messages Cause

Error Messages of Viewer

The ‘  ’ part of the message differs depending on the situation. 
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An attempt was made to
change/delete the Storage Server
while there are camera server
settings that have not been saved.

An attempt was made to delete the
Master Storage Server.

The host name or IP address was
invalid when OK was pressed.

The port number was invalid when
OK was pressed.

An attempt was made to add or edit a
zone in the Storage Server without
entering the name.

An attempt was made to register a
location name that is already
registered.

An attempt was made to register a
location without entering the name.

An attempt was made to delete the
location for which a zone has been
added.

An attempt was made to add a zone
while the location has not been
registered.

An attempt was made to add a zone
with a name that has been already
registered.

An attempt was made to register a
zone without entering the name.

An attempt was made to delete the
zone for which a camera server has
been added.

The camera server settings have
not been saved. Save or delete the
settings before changing the
Storage Server settings.

The Master Storage Server cannot
be deleted.

The host name of the Storage
Server is invalid. Check the host
name or IP address.

The port number of the Storage
Server is invalid. Specify a number
in the range of 1 to 65535.

Specify the host name of the
Storage Server.

This location name cannot be used
because it already exists.

The location name is not specified.

Delete the added zone before
deleting the location.

Select a location.

This zone name cannot be used
because it already exists.

The zone name is not specified.

Delete the added camera server
before deleting the zone.

Adding/Editing/
Deleting the
Storage Server

Adding/Editing a
Location and
Zone

List of Messages
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Adding a
Camera Server

Recording
Schedule

List of Messages

The recording settings of this
camera server have already been
configured in the selected Storage
Server. Check the settings and try
again.

Select a location and zone.

Select a location and zone. ‘Camera
number’

The camera server with the same
host name and port number is being
deleted. Save the changes and add
the server again. 

The host name specified in
“Connection Settings” is invalid.
Check the host name or IP address.

The port number specified in
“Connection Settings” is invalid.
Specify a number within the range
of 1 and 65535.

The host name specified in
“Storage Server Configuration” is
invalid. Check the host name or IP
address.

The port number specified in
“Storage Server Configuration” is
invalid. Specify a number within the
range of 1 and 65535.

An error occurred relating to the
schedule change of ‘schedule
name’ for the camera ‘camera
name’ registered in the Storage
Server ‘Storage Server name’. This
change will not be reflected on the
Storage Server side. 

Even though video of a camera
server is configured to be recorded in
the Storage Server, the IP address
and port used are the same as the
camera server that has been
configured in the Storage Server. 

An attempt was made to add a
camera server without selecting a
location and zone.

An attempt was made to add a
camera server without selecting a
location and zone. This is displayed
when VB150 is in the “simultaneous”
mode and multiple cameras are
connected.

After deleting the camera server, an
attempt was made to add the camera
server again when the changes have
not been saved.

An attempt was made to connect with
an invalid host name/IP address.

An attempt was made to connect with
an invalid port number.

An attempt was made to connect to
the Storage Server with an invalid
host name/IP address.

An attempt was made to connect to
the Storage Server with an invalid
port number.

The destination Storage Server was
not found when you attempted to
save the schedule.



251

9

Tro
u

b
lesh

o
o

tin
g

Messages Cause

The destination Storage Server was
not found when you attempted to
delete the schedule.

The Storage Server in which the
schedule is to be saved was not
found when you attempted to display
the Recording Schedules window or
to switch the Storage Server.

The recording schedules are
overlapping.

An attempt was made to register a
schedule with a shorter period than
15 minutes.

An attempt was made to close the
Normal or Special Day Schedule
screen without saving the change.

The Recording Schedules window
was dragged in order to add multiple
recording schedules, however the
camera server for which a schedule
has already been configured exists.

A layout or layout sequence with the
same name exists in the folder to
which the layout or layout sequence
is moved or copied. 

An attempt was made to delete the
special day schedule that is planned
to execute.

An error occurred relating to the
schedule deletion of ‘schedule
name’ for the camera ‘camera
name’ registered in the Storage
Server ‘Storage Server name’. This
change will not be reflected on the
Storage Server side. 

An error occurred when you
obtained the schedule setting
information of the Storage Server
‘Storage Server name’. This change
will not be reflected on the Storage
Server side. 

This schedule overlaps with other
schedule. Check the settings and
try again.

For the end time of a schedule, a
time of at least 15 minutes later
than the start time must be
specified. Check the settings and try
again.

Do you want to save the change in
the recording schedule?

The schedule for the following
camera is not created because the
specified time frame has already
been configured for another
schedule. 

The multiple schedules could not be
added. All of the schedules
attempted to create overlap with
other schedules.

This special day schedule is added
with a date that uses a schedule.
Delete the date before deleting the
special day schedule.

Recording
Schedule

Special Day
Schedule

List of Messages
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This date is already used. In order
to use it in another special day
schedule, the date must be deleted
from the original special day
schedule ‘special day schedule
name’.

The end time of the special day
schedule cannot be set on the next
day. Check the settings and try
again.

This special day schedule name
cannot be used because it already
exists.

Communication with the Storage
Server ‘Storage Server name’ failed.
Press OK to reconnect to the Storage
Server. When Cancel is pressed, the
video information and event
information of the camera servers
registered in this Storage Server can
no longer be referred. Restart the
Viewer manually.

The following layout has been
deleted from the layout sequence.:
‘Layout name’
Press OK to continue the layout
sequence.

The following layout cannot be
found. Contact your administrator
when deleting the layout from the
layout sequence. ‘Layout name’
Press OK to continue the layout
sequence.

The layouts registered in this layout
sequence cannot be found.

The layout registered in this layout
sequence cannot be found. Press
OK to edit this layout sequence, or
press Cancel to return to the
previous layout.

An attempt was made to use the data
for which another special day
schedule is already configured. 

An attempt was made to register a
schedule that passes 24:00.

An attempt was made to add a
special day schedule with a name
that is already registered.

When displaying the Viewing Screen,
the Viewer connects to a Storage
Server. An error occurred during this
process. When multiple Storage
Servers are registered, the Viewing
Screen may be displayed for each of
the servers.

There is a layout that can only be
seen while the layout sequence is
being executed, and the user has the
right to edit the layout sequence.

The shared layout sequence was
started, however there is a layout that
cannot be seen and the user does
not have the administrator privilege.

The shared layout sequence was
started, however there are no layouts
that can be seen and the user does
not have the administrator privilege.

The layout sequence was started,
however there are no layouts that
can be seen. The right to edit the
layout sequence is possessed.

Special Day
Schedule

Viewing Screen

List of Messages
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The configuration window can only
be used by administrators.

Do you want to save the change in
this layout?

The image could not be saved.

Nothing could be saved because no
video was recorded at the specified
time.

Manual recording of the camera
‘camera name’ registered in the
Storage Server ‘Storage Server
name’ could not be started. 

*The following message is added
when the number of camera
servers exceeds the licensing
restrictions.

The number of camera servers
exceeds the number allowed in the
licensing agreement.

The layout sequence settings will be
overwritten. Are you sure you want
to continue?

A layout with the same name is
already registered. Are you sure
you want to overwrite?

‘Layout name’ cannot be deleted
because it is currently in use.

The name is not specified. Check
the settings and try again.

The image could not be saved.

Viewing Screen

Saving/Managing
Video Layouts

Menu Buttons

List of Messages

An attempt was made by a user other
than an administrator to switch to the
Configuration window. 

An attempt was made to close a
layout that has been changed.

A still image was captured using
snapshot but it could not be saved.

There are no recorded videos for the
selected segment thus they could not
be saved.

Manual recording could not be
started. 

An attempt was made to save the
layout sequence with a name that is
already being used for a layout or
layout sequence in the destination
folder. 

An attempt was made to save the
layout sequence in the folder using a
name that is already been registered
as a layout or layout sequence. 

An attempt was made to delete a
layout that is currently being used.

An attempt was made to add a layout
folder without entering the name.

An error occurred when you
attempted to capture a snapshot in
the Video Window.



254

メッセージ 原因Messages Cause

Nothing could be saved because no
video was recorded at the specified
time.

The recording settings of this
camera server are not configured
but the server has already been
registered. Check the settings and
try again.

Could not connect to the camera
server. Check the entered
information.
‘Communication Error Messages -
Details’

The connection to the camera
server has been disconnected.

An error relating to the camera
server connection occurred.

Specify the day.

Specify the recording mode.

Specify the recording frame rate
between ‘fps’ and ‘fps’.

The maximum value of the pre-
event recording is 30 seconds.

The change cannot be saved
because it cannot be sent to the
Storage Server ‘Storage Server
name’.
‘Communication Error Messages -
Details’

Extracting Video

Adding/Editing a
Camera Server

Add/Edit Camera
Server dialog,
Add/Edit
Recording
Schedule dialog,
Motion Detection
Settings dialog,
Sensor Event
Settings dialog

Add/Edit
Recording
Schedule dialog

Add/Edit
Recording
Schedule dialog,
Motion Detection
Settings dialog

Camera
Summary
window

List of Messages

There are no recorded videos for the
selected segment thus they could not
be saved.

When a camera server configured as
Do not record is already added, an
attempt was made to add or edit a
camera server using the same hot
name/IP address and port number.

Could not connect to the camera
server.

An error relating to the camera server
connection occurred.

An unknown error relating to the
camera server connection occurred.

OK was pressed without specifying
the day.

OK was pressed without selecting
the recording mode check box.

An invalid recording frame rate was
entered.

OK was pressed after configuring a
value exceeding 30 seconds for the
pre-event time value.

An error occurred while saving the
settings in the Camera Summary
window.
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Are you sure you want to delete the
Storage Server ‘Storage Server
name’?

Are you sure you want to delete the
location ‘location name’?

Are you sure you want to delete the
zone ‘zone name’?

Are you sure you want to delete this
camera server ‘camera server
name’?

Do you want to save the changes in
the server registration?

An error occurred while saving the
settings in the Master Storage
Server.

The host name of the Master
Storage Server is invalid. Check the
host name or IP address.

The port number of the Master
Storage Server is invalid. Specify a
number in the range of 1 and
65535.

All schedules configured for the
‘camera server name’ will be
deleted. Select “Yes” to continue, or
select “No” to cancel. 

There are no events.

Specify the start time and end time
so that the time interval is 1 hour or
shorter.

The recorded video data cannot be
read.

The name is not specified. Check
the settings and try again.

Camera
Summary
window

Connect to
Master Storage
Server dialog,
Connection
Error dialog

Edit Camera
Server dialog

Event Search
dialog

Extract Video
dialog

Folder Name
dialog

List of Messages

An attempt was made to delete a
Storage Server other than the Master
Storage Server.

An attempt was made to delete the
location.

An attempt was made to delete the
zone.

An attempt was made to delete the
camera server.

An attempt was made to close the
Camera Summary window without
saving the changes.

An attempt was made to save the
settings, however, saving the Master
Storage Server settings failed.

An attempt was made to connect with
an invalid host name/IP address.

An attempt was made to connect with
an invalid port number.

OK was pressed in the Edit Camera
Server dialog when a change was
made to the camera registered in the
camera server.

No events to be displayed in Event
Search were found.

An attempt was made to configure
the time using a value longer than 1
hour.

The recorded video at the specified
time cannot be read.

An attempt was made to add a layout
folder without entering the name.
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A user layout cannot be specified in
shared layout sequences.  
Delete the following layout before
saving the shared layout sequence.

Specify the frame rate for the
motion detection settings between
‘fps’ and ‘fps’.

Specify the recording frame rate
between ‘fps’ and ‘fps’.

The recording settings of the
camera server cannot be configured
for this Storage Server ‘Storage
Server name’.
‘Communication Error Messages -
Details’

The layout that is currently being
used will be overwritten. Are you
sure you want to continue?

‘Layout name’ cannot be deleted
because it is currently in use.

Are you sure you want to delete the
following layout? ‘layout name’

Are you sure you want to delete the
following folder with the layouts in
the folder? ‘layout name’

Are you sure you want to delete the
layout sequence?

It cannot be deleted because it is
used in the running layout
sequence.

Layout
Sequence dialog

Motion Detection
Settings dialog

Normal or
Special Day
Schedule
window and
Add/Edit Camera
Server dialog

Organize
Layouts &
Layout
Sequences
dialog

List of Messages

An attempt was made to change the
layout sequence that contains a
personal layout sequence to a shared
layout sequence.

An invalid value was selected for the
motion detection frame rate.

An invalid value was selected for the
motion detection recording frame
rate.

An error occurred while connecting to
the Storage Server, when the Normal
or Special Day Schedule window is
opened or the Storage Server in the
Recording Schedules window is
changed. Or, a communication error
occurred when you were
adding/editing a Storage Server.

There is a layout with the same name
in the destination to which the layout
is moved and the name is the same
as the layout that is being currently
used. 

An attempt was made to delete the
current layout or the folder that
contains the current layout or layout
sequence.

An attempt was made to delete a
layout that is not currently being
used.

An attempt was made to delete the
layout folder.

An attempt was made to delete the
layout sequence.

An attempt was made to delete a
layout that is registered in the current
layout sequence.
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Organize
Layouts &
Layout
Sequences
dialog

Sensor Event
Settings dialog

Sensor Settings
dialog

Viewer Settings
window

It cannot be overwritten because it
is used in the layout sequence.

The folder cannot be created.
‘Folder name’ already exists.

The layout name cannot be
changed. ‘Layout name’ already
exists.

The folder name of the layout
cannot be changed. ‘Folder name’
already exists.

A layout with the same name is
already registered. Are you sure
you want to overwrite?

A layout or folder with the same
name is already registered. 

It cannot be deleted because it is
used in the layout sequence.

Specify the frame rate for the
sensor ‘sensor name’ recording
between ‘fps’ and ‘fps’.

The maximum value of the pre-
event sensor ‘sensor name’
recording is 30 seconds.

Do you want to save the changes in
the Viewer settings?

An attempt was made to change or
overwrite the layout that is being
used in the currently active layout
sequence.

An attempt was made to create a
new folder with a name that is
already being used.

An attempt was made to change the
name of a layout or layout sequence
to a name that is already being used. 

An attempt was made to change the
name of a folder to a name that is
already being used. 

A layout or layout sequence with the
same name exists in the folder to
which the layout or layout sequence
is moved or copied. 

A folder with the same name as the
folder to which the layout or layout
sequence is moved or copied exists.
Or, a layout or layout sequence with
the same name exists in the folder to
which the folder is moved or copied.

An attempt was made to delete the
current layout sequence.

An invalid recording frame rate was
entered.

OK was pressed after configuring a
value exceeding 30 seconds for the
pre-event time value.

An attempt was made to close the
Viewing Screen without saving the
changes.

Messages Cause
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VK-64/VK-16 Recording Engine Logs
A list of messages shown in the Storage Server log file “nvr_re_log_<N>.txt” (<N> is either
0 or 1) is shown below. These messages are generated by the recording engine (Win32
service) that runs as part of a Storage Server. 

Camera <camera>:
<x>/<y> frames
discarded due to busy
drive thread in last 1
minutes.

Camera <camera>:
<x>/<y> frames
discarded due to busy
frame queue in last 1
minutes.

Error resolving name for
POP server host: port
Error: <Winsock error
code>: <Error message>

Error connecting socket
for POP server host: port
Error: <Winsock error
code>: <Error message>

POP connection error: 0
POP response: <pop
response>

POP user error: 0
POP response: <pop
response>

x frames out of y frames are
discarded because there were a
large number of frames that have
been requested to be written in
the disk. It is difficult for the
current settings of the recording
engine to process this amount of
tasks.
This message is recorded when
recording failure occurs when disk
is under a heavy load.

x frames out of y frames are
discarded because there were a
large number of unprocessed
frames. It may be that CPU or
hard disk drive is unable to
process data at the same speed
rate as the data reception.
This message is recorded when
recording failure occurs due to
motion detection or too many
event occurrences.

When sending E-mail, the
recording engine could not
resolve the host name of the POP
server.

When sending E-mail, the
recording engine could not
connect to the POP server.

When sending E-mail, an error
occurred in the first response sent
after connecting to the POP
server.

When sending E-mail, the user
name entered for the POP server
could not be authenticated.

Reduce the system load using
the following methods.
1) Reduce the amount of data to

record (For example, lower
the resolution or frame rate).

2) Install an additional hard disk.
3) Implement an action such as

upgrading the CPU, or
increasing memory or existing
hard disk space.

Reduce the system load using
the following methods.
1) Reduce the amount of data to

record (For example, lower
the resolution or frame rate).

2) Install an additional hard disk.
3) Implement an action such as

upgrading the CPU, or
increasing memory or existing
hard disk space.

Refer to the corresponding
Winsock error code in “A List of
Error Codes in Log File”
(➝ P. 263).

Refer to the corresponding
Winsock error code in “A List of
Error Codes in Log File”
(➝ P. 263).

Refer to “A List of Error Codes
in Log File” (➝ P. 263).

Check the Storage Server
configuration to see if the
entered user name is correct.

Messages Cause Action
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POP password error: 0
POP response: <pop
response>

Error resolving name for
SMTP server host: port
Error: <Winsock error
code>: <Error message>

Error connecting SMTP
to server host: port
Error: <Winsock error
code>: <Error message>

Error sending E-mail.
SMTP server log follows:
<SMTP error message>

NVR recording engine
stopping

NVR Recording Engine
startup complete. Log
level = (<log level>)

Unable to register a drive
for camera
<host>:<port>.

When sending E-mail, the
password entered for the POP
server could not be verified.

When sending E-mail, the
recording engine could not
resolve the host name of the
SMTP server.

When sending E-mail, the
recording engine could not
connect to the SMTP server.

The recording engine could not
send E-mail due to a
communication error with the
SMTP server. Please refer to the
SMTP server log for details.

This is always displayed when the
recording engine stops.

This is always displayed when the
recording engine starts. The value
in “Log Level” indicates the log
level that is currently being
configured (The default is 1).

The storage destination drive
configured for this camera server
has been deleted.

Check the Storage Server
configuration to see if the
entered password is correct.

Refer to the corresponding
Winsock error code in “A List of
Error Codes in Log File” 
(➝ P. 263).

Refer to the corresponding
Winsock error code in “A List of
Error Codes in Log File” 
(➝ P. 263).

Refer to the corresponding
SMTP error code in “A List of
Error Codes in Log File” 
(➝ P. 263).

There is no necessary action.

There is no necessary action.

Change the storage destination
drive of the camera server in
Configuration of the Viewer.
When the drive of the camera
server remains unchanged even
after this message is displayed,
the Viewer may become unable
to connect to the Storage
Server. When this occurs, stop
the Storage Server and open
the following file using notepad
or other application to delete the
drive configuration in which the
problem is occurring. 

Messages Cause Action
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Error deleting old file
<windows error
message>.

Error writing frame for
camera <camera>:
<error message>

ERROR(timeout): socket
type=(IMAGE/EVENT/
COMMAND),
cameraserver=(<host>:<
port>)

ERROR(connect): socket
type=(IMAGE/EVENT/
COMMAND),
cameraserver=(<host>:<
port>)
win32_error=(<Winsock
Winsock error
code>:<error message>)

A system error occurred when
deleting the file. This file is
probably being used by the
access engine or other
application. When this file is being
used for playing a recorded video,
this error is normal.

Cannot write data in the hard
disk.

A timeout occurred while waiting
for a response from the specified
camera server. This normally
occurs when the camera server is
offline.
IMAGE == Get image process
EVENT == Get camera server
status process implemented by
GetNotice
COMMAND == Camera server
operation/configuration change
command process

An error occurred when
connecting to the specified
camera server.
IMAGE == Get image process
EVENT == Get camera server
status process implemented by
GetNotice
COMMAND == Camera server
operation/configuration change
command process
* same applies for “ERROR

(WSAConnect)”.

There is no necessary action.

Check to ensure that the
specified drive is not configured
as read-only. In addition, ensure
that all directories in this path
are writable. When the drive
cannot be used due to the
above reason, configure it in a
way so that there are no camera
servers records on this drive. 
* This is also recorded when the

date & time of the PC is reset to
past. When this occurs, this
error will no longer be recorded
when the date and time is reset
to the current date and time.

Check to ensure that the
camera server is on and
connected to the network. If a
proxy server is configured using
the Storage Server
Configuration tool, check to
ensure that the proxy server is
running.

Refer to the corresponding
Winsock error code in “A List of
Error Codes in Log File” 
(➝ P. 263).

Messages Cause Action



261

9

Tro
u

b
lesh

o
o

tin
g

List of Messages

ERROR(http): socket
type=(IMAGE/EVENT/
COMMAND),
cameraserver=(<host>:<
port>)
http_status=(<HTTP
error code>)

Failed to write camera
configuration file

ERROR: Out of memory
-- please check
configuration of this PC

Camera <camera>
Effective recording rate
(y%->z%)

ERROR(http): socket
type=(Image),
cameraserver=(<host>:<
port>) http_status=400

An HTTP error occurred when
connecting to the camera server.
IMAGE == Get image process
EVENT == Get camera server
status process implemented by
GetNotice
COMMAND == Camera server
operation/configuration change
command process

Cannot overwrite the camera
server configuration file. The
setting changes conducted after
the recording engine started
cannot be saved.

Failed to reserve memory in the
recording engine since the
system memory is under a heavy
load because unprocessed
frames continued to increase. An
application error will occur in a
few seconds and the Storage
Server functions will stop.

The recording frame rate has
been changed from y% to z%
because the load of the recording
engine continued to increase
(decrease).

An HTTP 400 error occurred
when getting the image.

Refer to the corresponding
HTTP error code in “A List of
Error Codes in Log File” 
(➝ P. 263).

Check to ensure that you have
the write privilege for the
LocalSystem account in the VK-
64/VK-16 configuration
directory.

Reduce the system load using
the following methods.
1) Reduce the amount of data to

record (For example, lower
the resolution or frame rate).

2) Install an additional hard disk.
3) Implement an action such as

upgrading the CPU, or
increasing memory or existing
hard disk space.

Even though there is no
necessary action, you can
reduce the system load using
the following methods if you
want to avoid frame rate
decrease events.
1) Reduce the amount of data to

record (For example, lower
the resolution or frame rate).

2) Install an additional hard disk.
3) Implement an action such as

upgrading the CPU, or
increasing memory or existing
hard disk space.

It may be connected to SNC-P5,
DF40N in the MPEG mode.
Change it to the JPEG mode.
For other causes, refer to the
corresponding HTTP error code
in “A List of Error Codes in Log
File” (➝ P. 263).

Messages Cause Action
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Access Engine Log
A list of messages shown in the Storage Server log file “nvr_ae_log_<N>.txt” (<N> is either
0 or 1) is shown below. These messages are generated by the access engine (Win32
service) that runs as part of a Storage Server. 

VK-64/VK-16 Viewer Logs
A list of messages shown in the VK Viewer log file “nvr_viewer_log_<N>.txt” (<N> is either
0 or 1) is shown below. 

NVR Access Engine
startup complete. Log
level = <log level>

NVR Access Engine has
finished shutting down.

It indicates that startup of the
access engine has been
completed.

The access engine has been
stopped.

There is no necessary action.

There is no necessary action.

Messages Cause Action

CHttpVbSetngThread:
inet error=<wininet error
code>, winsock
error=<Winsock error
code>, count=
<Number of
occurrences>

vbc_HttpCommand:inet
error=<wininet error
code>, winsock
error=<Winsock error
code>, count=
<Number of
occurrences>

A network error occurred while
communicating with the camera
server (This is recorded when a
problem occurs in configuration
protocol communications).

A network error occurred while
communicating with the camera
server (This is recorded when a
problem occurs in WV-HTTP
protocol communications).

Refer to the corresponding
Winsock error code in “A List of
Error Codes in Log File”
(➝ P. 263).

Refer to the corresponding
Winsock error code in “A List of
Error Codes in Log File” 
(➝ P. 263).

Messages Cause Action
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Log Storage Destination
z The Storage Server logs are stored in the following folder in the PC where the Storage

Server is installed.

<System drive>:\Documents and Settings\All Users\Application Data\Canon
\WebView\NVR\logs\

z The Apache logs used by the Storage Server are stored in the following Storage Server
installed folder.

<Storage server installed folder>: \websrvr\logs\

z The Viewer logs are stored in the following folder in the PC where the Viewer is
installed.

<System drive>:\Documents and Settings\All Users\Application Data\Canon
\WebView\NVR\logs\

A List of Error Codes in Log File

● A List of Winsock Error Codes

10038

10048

10050

10051

An operation was attempted on
something that is not a socket.

Only one usage of each socket address
(protocol/network address/port) is
normally permitted.

A socket operation encountered a dead
network.

A socket operation was attempted to an
unreachable network.

This may be recorded in Version 1.1,
however, there is no necessary action.

All resources for communication are
being used. This frequently occurs when
a black screen problem occurs in Viewer
layout sequences.

This occurs when the PC recognizes that
the network is not available because the
closest router or Hub to the PC is
powered off. Normally, this cannot be
recognized, therefore it is rare that this
error is reported. 

This occurs when another network
device recognizes that the network is not
available because the router or Hub is
powered off. Normally, this cannot be
recognized, therefore it is rare that this
error is reported. 

Codes Error Messages Description
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10054

10060

10061

10064

10065

10091

11001

11004

An existing connection was forcibly
closed by the remote host.

A connection attempt failed because
the connected party did not properly
respond after a period of time, or
established connection failed because
connected host has failed to respond.

No connection could be made because
the target machine actively refused it.

A socket operation failed because the
destination host was down.

A socket operation was attempted to an
unreachable host.

WSAStartup cannot function at this
time because the underlying system it
uses to provide network services is
currently unavailable.

No such host is known.

The requested name is valid, but no
data of the requested type was found.

The connection is disconnected by the
camera server due to camera server
restart or other cause. This may occur
when the camera server is restarted
using the restart button on the
configuration page on the software-side.
However, this rarely occurs.

A timeout occurred in the TCP
connection with the camera server (This
occurs when the camera server is down).

The camera server rejected the TCP
connection (This occurs when the port
number specification is incorrect or other
cause).

This is recorded when the camera server
is down (Normally, 10060 occurs).

There are no routes to connect to the
camera server (This may also occur
when there is a failure in the network
cable connected to the PC or HUB).

There is a failure on the PC network
board.

The host name in DNS could not be
resolved.

The host name in DNS could not be
resolved (11004 may occur instead of
11001 in 2003).

Codes Error Messages Description
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421

450

451

502

550

<domain> Service not available, closing
transmission channel

Requested mail action not taken:
mailbox unavailable

Requested action aborted: local error in
processing

Command not implemented

Requested action not taken: mailbox
unavailable

The communication is terminated
because the mail server stopped.

The requested mail process was not
executed because the mailbox is not
available.

The requested execution was canceled
because an error occurred in the mail
server.

The mail server does not support the
command that was sent.

The request was not executed because
the mailbox is not available.

Codes Error Messages Description

● A List of SMTP Error Codes
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400

401

403

500

502

503

504

Bad Request

Unauthorized

Forbidden

Internal Server Error

Bad Gateway

Service Unavailable

Gateway Time-out

When more than 4 Storage Servers are
connected when a Sony camera is used.
This is recorded when the operation
mode of the camera server is mpeg4.

The user authentication or password for
connecting to the camera server is
incorrect.

This is recorded when the connection
cannot be established due to the IP
address restriction on the camera server
side (It may also be returned by the
proxy server).

This occurs when the webview server is
not running even when the HTTP server
is running. This may also be recorded
even during normal operation if the
camera server is restarted.

This is recorded when the proxy server
returned an HTTP 502 error (which
occurs when the proxy server receives
an error from the upper proxy).

This is recorded when the proxy server
returned an HTTP 503 error (which
occurs when the proxy server failed to
connect to the camera server).

This is recorded when the proxy server
returned an HTTP 504 error (which
occurs when the proxy server could not
receive a reply from the upper proxy).

Codes Error Messages Description

● A List of HTTP Error Codes
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12002

12005

12007

12017

12029

12030

12031

The request has timed out.

The URL is invalid.

The server name could not be resolved.

The operation was canceled, usually
because the handle on which the
request was operating was closed
before the operation completed.

The attempt to connect to the server
failed.

The connection with the server has
been terminated.

The connection with the server has
been reset.

A request timeout occurred. It indicates
that connection or request transmission
failed.

The URL is incorrect (Normally, this does
not occur, however, it may occur when
an attempt is made to connect to an
unsupported camera server).

The host name could not be resolved
(This error indicates when a host name
that is not registered in DNS is specified
or that a problem occurred in
communication with DNS).

The communication was canceled (This
error is not a problem, it may be
recording during normal operation).

The connection to the camera server
failed (Normally 12002 is recorded).

The connection to the camera server has
been disconnected (The disconnect
process itself is recorded when it is
executed normally).

The connection to the camera server has
been disconnected forcibly.

Codes Error Messages Description

● A List of wininet Error Codes

ERR never heard of mailbox name

ERR invalid password

ERR unable to lock maildrop

The mail address is incorrect.

The password is incorrect.

The mailbox cannot be used (Another
program is already using it).

Error Messages Description

● A List of POP Error Codes
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Event type Displayed Messages

List of Messages

Starting or stopping the recording engine

User logon

Sensor

Motion detection

Starting or stopping recording

Starting or stopping the recording settings

Manual recording and custom trigger

Disk space warning

Starting or stopping deleting due to low
disk space

Starting or stopping recording due to low
disk space

Connection error to the camera server

Continuing recording

Start (on)/Stop (off)
Recording engine {status}

on
User {user name} logon

on/off
The sensor {sensor name} is {status}.

on/off
The motion detection is {status}.

Start (on)/Stop (off)
Stop recording
or
Start recording. Pre-event
Recording (configured duration)
(sec.)

Create (on)/Close (off)
Recording setting {number} {status}

Start (on)/Stop (off)
For manual recording:
The user {user name} set the manual recording to
{status}.
For custom recording:
(Custom text provided by the triggered client).

Warning (on)/recovered (off)
{Drive} Low disk space: {status}

Start (on)/Stop (off)
Low disk space {drive}
Delete files in the drive: {status}

Start (on)/Stop (off)
Low disk space {drive}
Hold recording to the drive: {status}

Error (on)/recovered (off)
Connect to the host ({camera server
address}:{port}): {status}

Continuing recording

VK Event Information
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Event type Displayed Messages

Error Number: Error Description Cause

List of Messages

Changing the recording frame rate Valid recording rate ({recording rate before change}
➝ {recording rate after change} %)
“Recording rate” is the ratio of received images that
are actually being recorded. If the rate is 100%, then
all received images are recorded. If 50%, 1 frame
per 2 frames is recorded.

10048: The socket cannot be used.

10050: The network is down.

10051: The network cannot be reached.

10054: Forcibly disconnected by the
camera server.

10060: Connection timeout

10061: The connection to the camera
server was rejected.

10064: The camera server is down.

10065: The camera server cannot be
reached.

10091: Failure on the network board

11001: The host name is unknown.

11004: The host name is unknown.

Empty character string

A socket for the communication could not be
generated because a large number of TCP
connections are used in the PC.

The network is down (when a failure occurs in a
HUB or router located near the PC).

A failure occurred in a HUB or router near the
camera server.

The TCP connection is disconnected because the
camera server was restarted or another cause.

A timeout occurred in the TCP connection with the
camera server (This occurs when the camera server
is down).

The camera server rejected the TCP connection
(This occurs when the port number specification is
incorrect or another cause).

The camera server is down (Normally, 10060
occurs).

There are no routes to connect to the camera server
(This may also occur when there is a failure in the
network cable connected to the PC or HUB).

There is a failure on the PC network board.

The host name in DNS could not be resolved.

The host name in DNS could not be resolved (11004
may occur instead of 11001 in 2003).

Other Winsock Errors
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List of Messages

Error Number: Error Description Cause

HT401: Account restriction

HT403: IP address restriction

HT502: Bad Gateway 502

HT503: Service unavailable 503

HT504: Gateway Timeout 504

The user authentication or password for connecting
to the camera server is incorrect. Check to ensure
that it is not an on/off event.

Cannot connect due to the IP address restriction on
the camera server side.

The proxy server returns an HTTP 502 error (which
occurs when the proxy server receives an error from
the upper proxy).

The proxy server returned an HTTP 503 error (which
occurs when the proxy server failed to connect to
the camera server).

The proxy server returned an HTTP 504 error (which
occurs when the proxy server could not receive a
reply from the upper proxy).
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The following figure shows the order of priority for Camera Server control.

When a recording position is specified in VK-64/VK-16, you cannot operate the Camera
Server in the Viewer for PC/Viewer for Java/NC Viewer.

Application

Panorama Creation Tool

WebView Admin Viewer/NC Viewer (Administrator)

Motion Detection Settings Tool (VB-C50i Series VB Administration Tool)

VK-64/VK-16 Storage Server (when a preset is specified for sensor recording)

Motion Detection Module (VB-C50 Series)

Operating the Camera Server in the VK-64/VK-16 settings window

VK-64/VK-16 Viewer (when the Camera Server is operated in the Viewer)

VK-64/VK-16 Storage Server (when a recording position is specified) VK Preset
Tour

NC Viewer (Authorized User), Viewer for PC/Viewer for Java (VB-C50i Series)

VB-C50 Preset Tour

Strong

Weak
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Lifetime of Hard Disk
A hard disk is a storage device that works physically, and has a limited lifetime. It is a kind
of consumables. It is said that the average lifetime of a RAID system composed of SCSI
hard disks is three years. However, this lifetime is considered to be true for standard file
servers or business servers. The disk failure rate of VK-64/VK-16 systems is higher than
that of general file servers. It is reasonable to assume that the lifetime of hard disks in a
VK-64/VK-16 system is about half of that of a standard file server (one and a half years).

Therefore, when you build a VK-64/VK-16 system, it is advisable to provide a hot-spare
(spare hard disks that are active) for RAID configuration.

RAID Reconfiguration
If one of hard disks in RAID1 and RAID5 systems breaks down, you can restore the
system by replacing the broken hard disk before other disks break.

Restoring the data stored on the broken hard disk after replacement is referred to as
rebuilding.

During RAID rebuilding, a recording error may occur because disk system performance
deteriorates.

● RAID Rebuilding Time

When a failure occurs in a hard disk in a RAID system and you want to replace it with a
hot-spare or new one, the rebuilding time is to be considered as follows:

z Rebuilding takes about one minute per 1GB when no I/O is performed in a SCSI RAID
card.

z When a RAID system is composed of four SCSI hard disks of 300GB each, the total
disk size of the hard disks is 1200GB. To rebuild this system, 1200 minutes (20 hours)
are required on the condition that there no I/O is performed.

z If rebuilding takes 20 hours when there is no I/O, the rebuilding time for a VK-64/VK-16
system where I/O is continuously performed can be assumed to be about twice 20
hours. Thus, when you perform rebuilding without stopping recording, it takes about 40
hours.

z There is no problem if rebuilding only takes a long time. However, the other hard disks
may break down one after another during such rebuilding. If another hard disk breaks
down during rebuilding, all of the stored data will be lost. Therefore, it is preferable to
reduce rebuilding time as far as possible.
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● Configuration for Reducing Rebuilding Time

As described in the preceding section, it is important to shorten rebuilding time as far as
possible. You can reduce rebuilding time by configuring hard disks as follows:

For example, when you create two configurations including three 146GB hard disks and a
hot- spare, instead of creating one configuration (900GB) including three 300GB hard disks
and a hot-spare, rebuilding requires less time and risks are reduced.

● Measures to be Taken When Rebuilding

To reduce the load on the PC during rebuilding and to shorten the rebuilding time, it is also
advisable to implement the following measures:

z Stop the Storage Server program before rebuilding.

z Temporarily reduce the recording frame rate during rebuilding.

● Notes on Consistency Check of RAID Configuration Information

For stable operation of hard disks, you need to regularly perform consistency check of
RAID configuration information. This is especially effective for preventing data
inconsistency when rebuilding is performed. However, as with rebuilding, the consistency
check of RAID configuration information imposes a burden on the PC for a long period of
time.

In a consistency check of RAID configuration information, measures such as configuring
hard disks in the same way as in rebuilding and reducing the load on the PC, are also
important. Refer to “Measures to be Taken When Rebuilding”.
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Backup of VB Settings

Overview
To backup or restore the setting values of the network camera, use “VB-C50i Series
Setting Values Backup/Restore Tool” (hereafter referred to as “Tool”). Specify one network
camera, and backup or restore the setting values through interactive operations.

Operating Environment
The operating environment of the Tool is as follows:

OS:

z Windows 2000 Professional (with SP4)

z Windows XP Home Edition/Professional (with SP1a, SP2)

z Windows Server 2003 (with SP1)

Web Browser:

z Internet Explorer 6.0
(Build Number 6.0.2800.1106 and later)

Hardware:

z PC recommended for the above OS

Target Camera Server:

z VB-C50i, VB-C50iR, VB-C50Fi, VB-C50FSi

Installation
Download the necessary files from the following Web site:

URL: canon.com/webview

Double-click “VBC50BK.exe” or “VB50RS.exe” stored on your hard disk and then start it.
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Backup of VB Settings

● Notes

<Backup Tool/Restore Tool>

z Before using the Tool, close any other applications.

z Use the Tool in a secure network environment such as an intranet.

z Transmit or receive files via FTP (HTTP proxy is not supported).

<Restore Tool>

z You can restore backup files only when their model, the video signal (NTSC/PAL), and
whether they have audio input or not, correspond to the network camera to which you
want to restore the files.

z You cannot restore backup files created by a new version of firmware to a network
camera of which the firmware is of an older version.

z For backup files, specify the files created by Setting Values Backup Tool.

z You cannot restore backup files that have been edited or converted.

z Do not change the administrator password and network settings (address setting
method, IP address, subnet mask, default gateway) from the values specified in the
network camera.
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A

Add Camera Server...............................87
Add Camera Server dialog ........................87

Add Camera Server dialog ....................87
Add Schedule Item dialog ...................105

Additional Options ...................................110
Backlight Compensation..........................108
Continuously at Max................................107
External Outputs Setting .........................111
Night Mode..............................................109
On motion detection ................................107
On sensor event ......................................107
Preset Camera Angle ..............................108
Resolution ...............................................109

Audio Panel .........................................191

B

Backup ................................................213
Backup Device ........................................216
Backup for Archive ..........................215, 220
Backup for Data Protection .............215, 219
Backup Tool ............................................216
Configuration files....................................218
Event Data.......................................217, 221
Examples.................................................225
Files to Make a Backup ...........................217
Restore....................................................222
Temporary File ........................................217
VB Settings..............................................275
Video Data.......................................217, 221

Before Starting Operations....................11

C

Camera Control Panel.........................185
Exposure Mode .......................................186
Focus.......................................................187
Pan, Tilt and Zoom..................................187

Camera Server ................................22, 85
Changing Settings ...................................113
Delete ........................................................96
Edit ............................................................94
Register .....................................................85

Search .......................................................85
Cameras for Viewing ...........................176

Camera Thumbnails ................................176
Locations, Zone drop-down.....................177
Selecting Locations and their Zones .......177

Communication Mechanism..................20
Configuration and Preferences screen..75
Configuration Files ..............................218
Continuous Recording.........................117
Control of the Camera Server .............272

D

Daylight Savings..................................197
Disk Space Management ......................58

Calculation Example..................................61
Limit Level ...........................................58, 59
Low Disk Space Warning Level...........58, 60
Threshold Level...................................59, 60

E

Event .....................................................62
Event Notification ......................................64
Priority .......................................................63

Event Data...........................................218
Extracting Video to Save.....................198

F

Find Camera Servers ............................85
Firmware ...............................................22

Upgrade.....................................................22
Frame Sizes ..........................................31

G

Get Camera Control ............................184

H

Hard Disk.............................................273
Lifetime....................................................273
RAID Reconfiguration..............................273
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I

Installation .............................................37
Installation Procedures..............................39
Preparation and Precaution.......................41
Reinstalling..............................................232
Restoring Previous Version.....................233
Starting up the Installer .............................39
Upgrade.....................................................41

Introduction..............................................2

L

Launching the VK Viewer ..............71, 150
Connecting to the Localhost..............72, 151
Specify the IP address of Storage 
Server................................................73, 152
Start-up Option ........................................155
Viewer Only Mode ...................................153

Layout..................................................162
Optional Layout .......................................162
Personal Layouts.....................................162
Shared Layouts .......................................162

Layout Grids ........................................169
Custom Grid ............................................174
Grid..................................................169, 170

License..................................................18
List of Messages .................................244
Location and Zone.................................78

Add............................................................80
Delete ........................................................81
Edit ............................................................81

Logs.....................................................258
A List of Error Codes ...............................263
Storage Destination.................................263

M

Manual Recording ...............................196
Master Storage Server ..........................28
Motion Detection Recording ................118

Optimization ............................................211

N

Normal Schedule.................................103

Create......................................................104

O

Operating Environment .........................22
Notes .........................................................24
Storage Server ..........................................23
Supported Camera Servers.......................22
System Environment .................................23

Operation and Management................205
Operation Guideline ............................208

Event Recording......................................210
Live-View Frame Rate Adjustment..........208
Recording Frame Rate Adjustment .........209

P

Pan, Tilt and Zoom..............................184
Preparation Flow ...................................16
Preset Tour..........................................132

R

Recording Schedules ............................98
Batch-Setting...........................................116
Normal Schedule...............................98, 103
Overview of Setting ...................................98
Recording Schedules screen ............99, 100
Special Day Schedule .......................98, 136

Recording Setting Summary ...............142
Reinstalling..........................................232
Restore Procedure ..............................222

S

Schedule Type ....................................137
Add..........................................................137
Adding a Day...........................................139
Delete ......................................................138
Deleting a Day.........................................140
Edit ..........................................................138

Searching Events ................................201
Criteria for Searching ..............................202
Date and Time Range .............................202
Event Search...........................................201
View Event in Camera.............................203
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Viewing Found Events.............................203
Selecting a Preset Camera Angle .......187
Sensor Event Recording .....................125
Setting the Viewer ...............................156

Viewer Settings window ..........................156
Shade Correction ................................191
Snapshot .............................................196
Special Day Recording........................136
Storage and Camera Server Summary 
windows...........................................76, 82
Storage Server ................................43, 82

Add............................................................82
Delete ........................................................84
Edit ............................................................83
Health Check...........................................207
Performance..............................................33
Start-Up Method ........................................45
Storage Server Configuration dialog .........46

Storage Server Configuration dialog .....46
Event Notification Tab .........................48, 64
Events Tab ..........................................47, 62
Settings Tab ........................................46, 50
User Management Tab........................49, 66

Supported Camera Servers...................22
System Configuration ............................26
System Design ......................................26

Hard Disk Capacity....................................29
Master Storage Server ..............................28
Network Bandwidth ...................................35
Server Sizing .............................................29
System Configuration ................................26
Video Data Quantity ..................................29
Viewer Sizing.............................................34
When using multiple Storage Servers .......28
When using multiple Storage Servers and
Viewers......................................................27
When using Viewer alone..........................28

System Operation Overview..................18

T

Task Areas ..........................................175
Timeline...............................................192

Capture Still Frame .........................192, 196
Extract Video ...................................193, 198

Jump to Time...................................193, 195
Overview .................................................192
Playback controls ............................192, 194
Playhead region ..............................192, 194
Record Now.....................................192, 196
Return to Live ..................................193, 198
Zoom In or Out ................................193, 197

Troubleshooting...................................238

U

Updating ..............................................234
Camera Firmware....................................234

Upgrade...............................................231
Previous Versions ...................................231

User Management.................................66
Administrator .......................................66, 67
User Authentication ...................................68

V

Video Data...........................................217
Video Window .....................176, 178, 188

Arranging Video Windows.......................181
Audio Panel .............................................191
Camera Thumbnail..................................178
Change the Size......................................188
Control External Devices.........................190
Creating, scaling and moving ..................178
Enabling Backlight Compensation...........189
Night mode..............................................190
Selecting Multiple Video Windows ..........181
Shade Correction ....................................190
Video Window States ..............................182

Viewer ...........................................71, 148
Flow.........................................................148
Launching Procedure ........................71, 150

Viewer Settings window ......................156
Audio Transmission Settings...................159
Configure Focus Settings ........................159
Configure layout in the Viewing Screen ..158
Configure the proxy server ......................158
Edit Event Notifications ...........................160
Identify the Master Storage Server..........158
Saving Viewer Settings ...........................161
Use large captions for Video Windows....158
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Viewing and Searching Events............199
Live Events Log list .................................199
Searching Events ....................................201

VK Event Information ..........................268
VK Events............................................207
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